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Welcome to This Guide

This guide provides detailed instructions on how to install, configure, and 
administer the HP Real User Monitor data collector.

Note: If you are an HP Software-as-a-Service customer, you must contact an 
HP Software Support representative to receive connection information that 
enables you to work with HP Real User Monitor.

This chapter includes:

 ➤  How This Guide Is Organized on page 7

 ➤  Who Should Read This Guide on page 8

 ➤  Getting More Information on page 8

How This Guide Is Organized

The guide contains the following chapters:

 Part I HP Real User Monitor Introduction and System Requirements

Introduces HP Real User Monitor and the platform system requirements, 
and explains how HP Real User Monitor works.

 Part II Installing HP Real User Monitor

Explains how to install and uninstall the HP Real User Monitor engine. Also 
explains how to install one or more HP Real User Monitor probes.
7



Welcome to This Guide
 Part III Configuring and Administering HP Real User Monitor

Explains how to configure an HP Real User Monitor probe by changing the 
default settings as well as how to configure and administer the HP Real User 
Monitor engine and how to administer HP Real User Monitor’s MySQL 
database. Also provides guidelines for hardening HP Real User Monitor.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration and HP Business Availability Center data collectors.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.
8



Part I

HP Real User Monitor Introduction and
System Requirements
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1
Introducing HP Real User Monitor 
Administration

This chapter introduces HP Real User Monitor and explains how it works.

This chapter includes:

 ➤  Overview of HP Real User Monitor on page 11

 ➤  How the HP Real User Monitor Works on page 12

 ➤  Ports and Types of Communication Used by HP Real User Monitor 
on page 15

 ➤  Overview of HP Real User Monitor Performance Measurements on page 17

 ➤  Installing and Administering HP Real User Monitor on page 26

Overview of HP Real User Monitor

HP Real User Monitor monitors both user and system initiated network 
traffic between client machines and servers and between servers, collecting 
network and server performance and availability data in real time. This 
enables administrators to pinpoint the cause of delays and quantify the 
business impact of detected performance issues related to end users. When 
performance and availability exceed specified thresholds, HP Business 
Availability Center proactively alerts application managers who, using the 
HP Real User Monitor reports, analyze the collected data to isolate the root 
cause of detected problems.
11
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How the HP Real User Monitor Works

HP Real User Monitor consists of three major components: the probe, the 
engine, and the MySQL database.

➤ The probe is a non-intrusive, passive listening device that is subject to the 
same traffic the server receives. It is plugged into a network tap that is 
connected to a monitored server. As end-user traffic passes through the tap, 
the probe listens to requests and responses sent to and from the server. In 
this way, data is tracked all the way from the end-user’s IP address to the 
server handling the request. 

➤ The engine receives the data collected by the probe and assembles this data 
according to the configuration specifications it receives from HP Business 
Availability Center, that have been configured in End User Management 
Administration. The engine transmits the page, transaction, end-user, and 
server data samples it creates to the HP Business Availability Center Gateway 
Server. The HP Business Availability Center Gateway Server then distributes 
the data to the relevant HP Business Availability Center components, which 
create HP Real User Monitor alerts, reports, and Dashboard views.

Note: If the HP Real User Monitor engine fails or is temporarily unavailable, 
or is unable to copy data from the HP Real User Monitor probe, the HP Real 
User Monitor probe continues to collect data and saves the last two hours 
worth of data. This data is copied by the HP Real User Monitor engine when 
it becomes available again.

➤ The MySQL database acts as HP Real User Monitor’s repository for data that 
the HP Real User Monitor engine does not forward to HP Business 
Availability Center immediately, or at all. The MySQL database stores the 
HP Real User Monitor engine’s configuration settings, session click-streams 
(pages and snapshots included in a session), and the open sessions 
summary.
12
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The following diagram shows how HP Real User Monitor receives 
client/server and server/server traffic and passes it on to HP Business 
Availability Center.
13
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Use the HP Real User Monitor reports to analyze network and application 
performance and availability data for the servers, applications, pages, 
transactions, events, and end users that you configure for monitoring, as 
well as general statistics that are collected and sent by the probes to the 
engine. When notified by an alert that a certain performance or availability 
threshold has been exceeded, you can examine the issue in the appropriate 
reports and try to pinpoint the cause of the problem and the time at which 
the problem occurred. For detailed information on HP Real User Monitor 
reports, see “Real User Monitor Reports User Interface” in Using End User 
Management.

In addition, HP Real User Monitor data is included in Dashboard. For 
information on displaying HP Real User Monitor data in Dashboard, see 
“About Real User Monitor Views” in Using End User Management.
14
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Ports and Types of Communication Used by HP Real User 
Monitor

The following diagram shows the various ports and type of communications 
used by HP Real User Monitor, both internally and externally.
15



Chapter 1 • Introducing HP Real User Monitor Administration
Note: 

➤ The HP Business Availability Center Gateway Server initiates a 
connection to the Real User Monitor engine on port 8180 for retrieving 
various types of data.

➤ The Real User Monitor engine initiates a connection to the HP Business 
Availability Center Gateway Server on port 80 (default) for sending 
samples.

➤ The Real User Monitor engine initiates a connection to the Real User 
Monitor probe on port 2020 for https (which is the default type of 
communication in Real User Monitor version 7.0 and later) and http, and 
on port 22 for SSH.

➤ The Real User Monitor probe does not initiate a connection to any other 
server in the system.

➤ There is no direct connection from HP Business Availability Center to the 
Real User Monitor probe.

➤ By default, the Snapshot Replay applet retrieves data to a user’s machine 
via an HP Business Availability Center server. You can configure the 
applet to retrieve data directly from the Real User Monitor engine, in 
which case the connection is made on port 8180. For details on 
configuring from where the Snapshot Replay applet retrieves data, see 
“Customize Real User Monitor Reports” in Using End User Management.
16
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Overview of HP Real User Monitor Performance 
Measurements

This section describes the measurements provided by HP Real User Monitor 
for the data that it monitors.

This section includes the following topics:

➤ “Introduction to Performance Measurements” on page 17

➤ “TCP Request-Response Measurements” on page 19

➤ “HTTP Measurements” on page 19

➤ “End User Measurements” on page 25

Introduction to Performance Measurements
To understand HP Real User Monitor performance measurements, a basic 
knowledge of TCP/IP is beneficial. The following are some of the TCP/IP and 
HTTP terms used in describing performance measurements:

➤ SYN. A request for connection

➤ ACK. Acknowledgement response

➤ GET. A request for data
17
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Performance measurements are aimed at measuring real-user experience, 
that is, the end-to-end user experience. To measure both client-side and 
server-side measurements, the Parallel Technique is used, in which it is 
assumed that measuring the event on the server side is a close 
approximation of the event’s measurement on the client side. All HP Real 
User Monitor measurements are performed on the server side, but provide 
end-to-end data. The following diagram shows that since the lines are 
parallel, it is assumed that T1 (client-side measurement)=T2 (server-side 
measurement).
18
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TCP Request-Response Measurements

It is important to understand the following TCP Request-Response 
measurements, as they form an integral part of the TCP Request-Response 
data reported by HP Real User Monitor:

➤ Average Response Time. The time from the first packet of the request, until 
client acknowledgement of the last packet of the response. Average 
download time is the sum of average server time and average network time.

➤ Average Server Time. By understanding the TCP protocol, HP Real User 
Monitor determines which time intervals were spent on server processing 
(either server application processing time or server kernel processing time). 
These intervals are incorporated into the average server time. This 
measurement is better than server time to first buffer as it considers all of 
the response time. 

➤ Average Network Time. The time intervals that were spent by the server 
waiting for client acknowledgement to arrive are incorporated into the 
average network time.

HTTP Measurements

HTTP measurements are used by HP Real User Monitor to report page and 
transaction data to HP Business Availability Center.

This section includes the following topics:

➤ “Page Performance Measurements” on page 20

➤ “Component Measurements” on page 21

➤ “Page Measurements” on page 22

➤ “Transaction Measurements” on page 24
19
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Page Performance Measurements

The following table describes the performance measurements of pages that 
appear in HP Real User Monitor reports:

Measurement How it is Calculated Why it Matters

Page Time The end-to-end time it took to 
download the whole page.

Enables you to 
discover which pages 
are slow (exceed their 
threshold).

Page Server Time The time spent on the servers 
to create the response.

Enables you to track 
server performance 
issues.

Page Network Time The time spent on the network 
to send the response.

Enables you to isolate 
network delays.

Page Client Time The time spent on the client 
side.

Enables you to 
understand the client’s 
effect on performance.

Page Hits There are separate counters for 
available and unavailable hits. 
Unavailable hits are defined by 
events and errors configured in 
End User Management 
Administration.

N/A

Network Latency Network latency (round trip) 
per domain.

Enables you to 
determine whether 
there is a network 
problem.

Server Availability Server is up or down, and the 
service (application) is up or 
down, as a percentage of 
available HTTP requests.

Enables you to 
determine whether 
there is a server 
availability problem.
20
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Component Measurements

While component measurements are not reported to HP Business 
Availability Center, it is important to understand them as they form an 
integral part of page and transaction measurements.

An HTTP component is a single request response couple.

The following component measurements are used in HP Real User Monitor:

➤ Component Download Time. The time from the first packet of the request, 
until client acknowledgement of the last packet of the response. 
Component download time is the sum of component server time and 
component network time.

➤ Component Server Time. By understanding the TCP protocol, HP Real User 
Monitor determines which time intervals were spent on server processing 
(either server application processing time or server kernel processing time). 
These intervals are incorporated into the component server time. This 
measurement is better than server time to first buffer as it considers all of 
the response time. 

➤ Component Network Time. The time intervals that were spent by the server 
waiting for client acknowledgement to arrive are incorporated into the 
component Network time.
21
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The following diagram shows how component download time is calculated 
from the component server and network times:

Page Measurements

Each HTML page can contain sub-components (such as GIFs, JPGs, and so 
forth). HP Real User Monitor correlates the main component (the HTML) 
and the sub-components and calculates the download time for the whole 
page.

The following page measurements are used in HP Real User Monitor:

➤ Page time. The time from the first packet of the first component’s request to 
the client ack for the last packet of the last component’s response. Page time 
comprises page client/external time, page network time and page server 
time.

Because a single page might be downloaded over several connections, which 
means two or more components might be downloaded simultaneously, and 
since there might also be time gaps in the page time in which no 
component is being downloaded, the total page time might not necessarily 
equal the sum of all the components’ download time.
22
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The following diagram shows how several components server time or 
network time might overlap (Comp1 and Comp2). This makes it difficult to 
define what portion of the page time is server time and what portion is 
network time. To overcome this, HP Real User Monitor users relative 
measurements for page breakdown:

➤ Page client/external time. A collection of all the time intervals in the page 
time in which no component was downloaded. These gaps, which are 
shown in red in the above diagram, are usually caused by client application 
processing (such as JavaScript). 

➤ Page Server Time. The relative part of the Page Time that was spent on 
server processing. The formula used to calculate this is:
23
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➤ Page network time. The relative part of the page time that was spent on 
network transportation. The formula used to calculate this is:

Transaction Measurements

An HP Real User Monitor transaction consists of a series of pages. A 
transaction is matched when HP Real User Monitor has monitored all the 
pages in the series in the correct order.

The following transaction measurements are used in HP Real User Monitor:

➤ Transaction Total Time. The time from the beginning of the download of the 
first page until the end of the download of the last page.

➤ Transaction Net Time. The portion of the total time that was actually spent 
downloading the pages. This calculation excludes gaps between the pages, 
which are considered as user think time. Transaction net time comprises the 
following measurements:

➤ Transaction Server Time. The relative part of net time that was spent on 
server processing. This is calculated considering the server time of the 
pages. Server time is counted only once for pages that have overlapping 
sever time. Transaction server time = net transaction time * (total server 
time / total download time).

➤ Transaction Network Time. The relative part of net time that was spent 
on network transportation. This is calculated considering the network 
time of the pages. Network time is counted only once for pages that have 
overlapping network time. Transaction network time = net transaction 
time * (total network time / total download time).

➤ Transaction Client/External Time. The relative part of net time during 
which no server processing or network transportation took place (that is, 
the gaps between components), usually due to client processing. This is 
calculated considering the client time of the pages. Client time is 
counted only once for pages that have overlapping client time. 
Transaction client time = net transaction time * (total client time / total 
download time).
24
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The following example shows the applicable times for a transaction 
comprising two pages:

It is possible for a transaction’s server, network, or client time to be less than 
the individual server, network, or client time of one of its included pages. 
This can occur when the download time of the pages included in the 
transaction overlap, but register different measurements for the same time 
period. For example, two pages may be downloading at the same time, but 
one registers server time while the other registers network time.

End User Measurements
End User Latency is the average RTT (round trip time) for a packet between 
the server and the client. This calculation is made only for packets that were 
not delayed because of server or client processing, as server time and client 
time are not part of the latency measurement.

Start 
Time

End 
Time

Download 
Time

Server 
Time

Client 
Time

Network 
Time

Total 
Time

Page 1 0 10 10 4 4 2

Page 2 8 18 10 2 4 4

Net 
Transaction 
Time

18 5.4 7.2 5.4 18
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Installing and Administering HP Real User Monitor

To begin using HP Real User Monitor, you must perform the following steps 
(once you have installed HP Business Availability Center):

 1 Install the HP Real User Monitor engine.

For information on installing the HP Real User Monitor engine and setting 
up the engine to connect to the Gateway Server, see “Installing the HP Real 
User Monitor Engine” on page 39.

 2 Create and connect to the MySQL database.

You can create and connect to the MySQL database either as part of the 
HP Real User Monitor engine installation procedure or separately, at a later 
time. For details on creating the MySQL database as part of the HP Real User 
Monitor engine installation procedure, see “Installing the HP Real User 
Monitor Engine” on page 39. For details on creating the MySQL database at 
a later time, see “Overview of the MySQL Database” on page 205.

 3 Install one or more HP Real User Monitor probes.

For information on installing an HP Real User Monitor probe and setting it 
up to report real-user activity data to the engine, see “Installing the HP Real 
User Monitor Probe” on page 51.

 4 If necessary, reconfigure the connection between the HP Real User Monitor 
and HP Business Availability Center.

If connection parameters (such as SSL, proxy, and authentication) have 
changed since the installation of HP Business Availability Center, use the 
HP Real User Monitor engine’s Web console to reconfigure the connection 
between the HP Real User Monitor and HP Business Availability Center. For 
detailed information, see “Using the HP Real User Monitor Web Console” 
on page 78.
26
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 5 Configure HP Real User Monitor in HP Business Availability Center End User 
Management Administration.

In End User Management Administration, you add the HP Real User 
Monitor engine you installed to the monitor tree. You then add one or more 
probes to the engine and configure the probes to collect data from specific 
servers. In addition, you configure the specific pages, transactions, events, 
and end users you want to monitor. For more information, see “Real User 
Monitor Administration User Interface” in Using End User Management.

Note: You can create Real User Monitor alerts if you want to be notified of 
certain occurrences while monitoring real-user data. You can view reports of 
the data collected by HP Real User Monitor in the End User Management 
application. For information on configuring alerts, see “Event-Based Alerts” 
in Alerts. For information on viewing Real User Monitor reports, see “Real 
User Monitor Reports User Interface” in Using End User Management.
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2
Reviewing System Requirements

This section describes the recommended system requirements for running 
HP Real User Monitor.

This chapter includes:

 ➤  HP Real User Monitor Engine Requirements on page 30

 ➤  HP Real User Monitor Repository (MySQL Database) Requirements 
on page 30

 ➤  Requirements for Installing the HP Real User Monitor Engine and Repository 
(MySQL Database) on the Same Machine on page 31

 ➤  HP Real User Monitor Probe Requirements on page 32
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HP Real User Monitor Engine Requirements

HP Real User Monitor Repository (MySQL Database) 
Requirements

Minimum Recommended

Computer/Processor Dual-CPU Xeon 3.0 GHz 
Server

Dual-CPU Xeon 3.0 GHz 
Dual-Core Server

Operating System Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2) and 
64-bit versions

Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2) and 
64-bit versions

Memory 2 GB 4 GB

Hard Drive 70 GB 70 GB

Network Card Gigabit network adaptor 2 Gigabit network 
adaptors (one for 
database connectivity 
and one for probe 
connectivity)

Minimum Recommended

Computer/Processor Dual-CPU Xeon 3.0 GHz 
Server

Dual-CPU Xeon 3.0 GHz 
Dual-Core Server

Operating System Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)

Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)
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Requirements for Installing the HP Real User Monitor 
Engine and Repository (MySQL Database) on the Same 
Machine

Memory 2 GB 4 GB

Hard Drive 200 GB fast hard drive 400 GB SCSI disks RAID 
0 (RAID 0 + 1 for high 
availability)

Network Card Gigabit network adaptor Gigabit network adaptor

MySQL Version 5.1 (installed by the 
HP Real User Monitor 
installation program)

5.1 (installed by the 
HP Real User Monitor 
installation program)

Minimum Recommended

Computer/Processor Quad-CPU Xeon 3.0 
GHz Server

Quad-CPU Xeon 3.0 
GHz Server

Operating System Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)

Windows:

Windows 2000 
Server/Advanced Server, 
Service Pack 4

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)

Memory 4 GB 4 GB

Minimum Recommended
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HP Real User Monitor Probe Requirements

Hardware and Operating System Requirements

Hard Drive 2 Disks:

➤ 70 GB for the Real 
User Monitor engine 
installation

➤ 200 GB fast hard drive 
for the Real User 
Monitor repository

2 Disks:

➤ 70 GB for the Real 
User Monitor engine 
installation

➤ 400 GB SCSI disks 
RAID 0 (RAID 0 + 1 
for high availability) 
for the Real User 
Monitor repository.

Note: It is important not to install the Real User 
Monitor engine on the same disk as the Real User 
Monitor repository. You must select a different disk 
for the Real User Monitor repository during the 
installation.

Network Card Gigabit network adaptor Gigabit network adaptor

Minimum Recommended

Computer/Processor Dual-CPU Xeon 3.0 GHz 
Server

Dual-CPU Xeon 3.0 GHz 
Server

Note: For Windows installations, you can install an 
HP Real User Monitor probe on the same machine as 
an HP Real User Monitor engine if the environment 
is a very low traffic one.

Minimum Recommended
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Operating System Linux:

Red Hat Enterprise Linux

➤ Version 5.0 (RHEL5) – 
64 and 32 bit versions

➤ Version 4.0 (RHEL4) – 
32 bit versions

Windows:

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)

Linux:

Red Hat Enterprise Linux

➤ Version 5.0 (RHEL5) – 
64 and 32 bit versions

➤ Version 4.0 (RHEL4) – 
32 bit versions

Windows:

Windows 2003 Server 
standard/enterprise 
editions (SP1, SP2)

Memory 2 GB 4 GB

Hard Drive 70 GB IDE/SATA 150 GB SCSI

SCSI required for high 
traffic levels of more 
than 15 MB.

Large disk space required 
for more than one page 
back on Snapshot on 
Error (SSOE).

Note: For Linux installations, it is recommended to 
allocate most of the disk space to the 
/var/spool/beatbox directory, as this directory 
contains the majority of the probe data. It is 
sufficient to allocate 10 GB of space each to the 
/var/log/beatbox and /etc/beatbox directories. 

Minimum Recommended
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Network Card For connecting port 
mirrored cable:

1 Intel Pro/1000 
(10/100/1000 auto-
sensing)

For connecting to 
management port (used 
by RUM engine):

1 Intel Pro/100 (10/100 
auto-sensing) set for full 
duplex

For copper connections, 
MT type card required.

For fiber optic 
connections, MF type 
card required.

For connecting tap:

2 Intel Pro/1000 
(10/100/1000 auto-
sensing)

Note: Two network cards 
are required if the TAP to 
which the Real User 
Monitor probe is 
connected uses different 
ports for transmitting 
and receiving data. You 
can also use two network 
cards to monitor traffic 
from two separate 
sources, providing 
bandwidth restrictions 
are not exceeded.

For connecting to 
management port (used 
by RUM engine):

1 Intel Pro/100 (10/100 
auto-sensing) set for full 
duplex

For copper connections, 
MT type card required.

For fiber optic 
connections, MF type 
card required.

PCI Slot 1 free 133/100/66 MHz 
64 bit PCI slot

Minimum Recommended
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Environment and System Requirements

Requirement Description

Linux installations only:

Perl Perl must be installed with the following libraries:

➤ LWP::UserAgent

➤ URI::URL

ssh daemon ➤ Port 22 must be open

➤ xinetd daemon must be up and listening to SSH 
clients

beatbox user A user called beatbox is automatically created 
during installation, but you must manually 
configure a password for this user. When entering 
the HP Real User Monitor probe user and password 
in End User Management Administration, you 
must use either the root or beatbox user (for details, 
see “New/Edit Real User Monitor Engine Page” in 
Using End User Management). 

Permissions The following directories must have 2770 
permissions, be owned by beatbox and belong to 
the beatbox group:

➤ /var/spool/beatbox (and subdirectories)

➤ /etc/beatbox

➤ /var/log/beatbox

Linux and Windows installation:

Probe console port Port 2020 is the default port used for accessing the 
HP Real User Monitor probe console. If you want to 
use SSL for accessing the HP Real User Monitor 
probe console, you use Apache Web Server as a 
proxy, limit port 2020 to localhost connections 
only and open port 443 on the Apache Web Server. 
For details, see “Using SSL to Access the HP Real 
User Monitor Probe Web Console” on page 68.
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3
Installing the HP Real User Monitor 
Engine

To monitor real user activity, you must first install the HP Real User Monitor 
engine on a Windows platform.

You download the HP Real User Monitor engine installation file from the 
Downloads page, which you access from the Setup and Maintenance tab in 
Platform Administration.

The HP Real User Monitor installation procedure installs both the HP Real 
User Monitor engine and the MySQL database. You can install both the 
engine and the database on the same machine, or on different machines. To 
install the engine and database on different machines, install the MySQL 
database first and then install the engine and connect it to the database.

Note: For details on upgrading Real User Monitor, see “Component and 
Data Upgrade and Limitations” in the HP Business Availability Center 
Deployment Guide PDF.

This chapter includes:

 ➤  Installing the HP Real User Monitor Engine on page 40
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Installing the HP Real User Monitor Engine

For details on the system requirements for installing the HP Real User 
Monitor engine, see “HP Real User Monitor Engine Requirements” on 
page 30.

Tip: For better performance, it is recommended to install the HP Real User 
Monitor engine and the HP Real User Monitor probe on the same local area 
network (LAN).

To install the HP Real User Monitor engine on a Windows Platform:

 1 Click the HP Real User Monitor Engine for Windows link on the Downloads 
page to download the HPRUMSetup_win.exe file to the machine on which 
you want to install the engine.

Note: For the HP Real User Monitor engine setup file to be available on the 
Downloads page, it must first be installed to HP Business Availability Center. 
For details on installing HP Business Availability Center components setup 
files, see “Installing Component Setup Files” in the HP Business Availability 
Center Deployment Guide PDF. 

If you prefer, you can copy the HP Real User Monitor engine setup program 
directly from the Data Collectors and Components directory on the 
HP Business Availability Center DVD, for versions delivered on DVD.

 2 On this machine, navigate to the downloaded file and double click 
HPRUMSetup_win.exe. The HP Real User Monitor Engine Setup begins.

 3 When the Setup Welcome screen is displayed, click Next.

 4 Accept the terms of the license agreement and click Next.

 5 Select the path of the directory in which you want to install the HP Real 
User Monitor engine. Accept the default path, or click Browse to select a 
different directory. Click Next.
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 6 Select the type of installation you want to perform, Typical or Custom.

A typical installation installs both the HP Real User Monitor engine and the 
MySQL database.

In a custom installation, you can choose whether to install the HP Real User 
Monitor engine, the MySQL database, or both.

Click Next.

If you chose Typical installation, skip to step 8 on page 42 to continue.

 7 If you chose Custom installation, select the features you want to include by 
checking the box to the left of the required feature. You can select one, or 
both of the features.

Click Next.
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Note: 

If you choose HP Real User Monitor Database Engine only, the MySQL 
database is installed in the specified location, but no database schema is 
created.

If you choose HP Real User Monitor Core Engine only and do not connect to 
a database, you are unable to configure connection settings to HP Business 
Availability Center during the installation. You can configure connection 
settings to HP Business Availability Center later via the HP Real User 
Monitor Web console (for details, see “BAC Connection Settings” on 
page 120).

 8 Read the summary information. If it is correct, click Next to continue with 
the installation. If it is not correct, click Back to correct the information you 
previously provided.

 9 Select the drive on which to install the MySQL database data directory, or 
select the default drive. Click Next.

 10 Choose whether you want to import user data settings from a previous 
HP Real User Monitor installation. Click Next.

If you chose not to import data, continue with step 12 on page 43.
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 11 Enter the source directory from which to import the backup data, or select 
the default directory, and choose whether or not to include the MySQL 
schema.

Click Next.

Note: 

➤ If you are installing the HP Real User Monitor engine only (that is, 
without the MySQL database), you are not prompted to choose whether 
to include the MySQL schema.

➤ If you choose to include the MySQL schema, the directory you choose 
from which to import the backup data must be on the same partition on 
which HP Real User Monitor is being installed.

 12 If necessary, Setup prompts you to reboot the machine on which you are 
installing HP Real User Monitor. Select whether to reboot now, or at a later 
stage. Click Next.
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 13 Select whether you want to run the HP Real User Monitor Configuration 
tool. You can choose to run the Configuration tool at a later time, but you 
cannot work with HP Real User Monitor until you have configured the 
MySQL database settings and have connected the HP Real User Monitor 
engine to the database. For details of running the Configuration tool at a 
later time, see “Creating and Connecting to the MySQL Database” on 
page 206.
 

Click Next.

 14 Click Finish to exit the Setup wizard.

If you chose to run the Configuration tool, continue with the following 
steps, but note that to configure database and connection settings you must 
have both an HP Real User Monitor engine installed and access to an 
existing MySQL database.
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 15 When the Configuration tool Welcome screen is displayed, click Next.

If you chose Custom installation > HP Real User Monitor Core Engine only, 
skip to step 18 on page 46 to continue. Otherwise, continue with the next 
step.

 16 Select the parameters you want to configure. You can configure the MySQL 
database parameters (the user name and password for connecting to the 
database), the parameters used by the HP Real User Monitor engine to 
connect to the MySQL database and to HP Business Availability Center, or 
both.

Click Next.

If you chose to configure the parameters used by the HP Real User Monitor 
engine to connect to the MySQL database and to HP Business Availability 
Center only, skip to step 18 on page 46 to continue, otherwise proceed with 
the next step.
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 17 Enter the user name and password for accessing the MySQL database, or 
accept the defaults (rum_user and rum_password). If you change the default 
settings, note that blank fields are invalid and all fields must be completed 
for a change to take effect.

Click Next.

If you chose to configure the MySQL database parameters only, skip to 
step 23 on page 50, otherwise proceed with the next step.

 18 Select whether you want to create a new user schema for the MySQL 
database, or connect to an existing user schema. Click Next.

Note: If you are upgrading from an earlier version of Real User Monitor, 
select the option to connect to an existing database.
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 19 Configure the MySQL database settings. You can configure the host name of 
the machine where the MySQL database resides, as well as the port number 
for accessing this machine, or you can accept the default settings as they 
appear below. Enter the user name and password for connecting to the 
MySQL database machine (rum_user and rum_password by default, or the 
updated user and password configured in step 17 on page 46. In the Schema 
Name field, you specify the name for the MySQL database schema.

Click Next.

If you chose Custom installation > HP Real User Monitor Database Engine 
skip to step 23 on page 50, otherwise proceed with the next step.
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 20 In the HP Real User Monitor Connection Settings dialog box, select the 
protocol (HTTP or HTTPS) the HP Real User Monitor engine should use to 
connect to the HP Business Availability Center Gateway Server. (For details 
on configuring a reverse proxy or SSL, see “BAC Connection Settings” on 
page 120.) Enter the Gateway Server machine name and the port number 
through which you want the HP Real User Monitor engine to communicate 
with the Gateway Server. Note that by default, the port number is 80. Select 
the Show advanced options box to configure HTTP authentication or 
reverse proxy settings.

Click Next.

If you selected the Show advanced options box, continue with the next step 
for additional connection settings. Otherwise, skip to step 23 on page 50 to 
continue.
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 21 In the first advanced connection settings screen, enter the HTTP 
Authentication user name and password for connecting to the Gateway 
Server as well as the URL of the machine on which the Gateway Server is 
installed. For details on configuring basic authentication, see “BAC 
Connection Settings” on page 120.

Click Next.
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 22 In the second advanced connection settings screen, enter the proxy settings 
required for connecting to the Gateway Server. For details on configuring a 
reverse proxy or SSL, see “BAC Connection Settings” on page 120.

Click Next.

 23 After the HP Real User Monitor engine is installed, click Finish to exit the 
wizard.

After successfully installing the HP Real User Monitor engine and 
connecting the engine to the MySQL database, start HP Real User Monitor 
on the machine on which it is installed.

Start HP Real User Monitor by selecting Start > Programs > HP Real User 
Monitor > Administration > Enable HP Real User Monitor.

You can stop HP Real User Monitor by selecting Start > Programs > HP Real 
User Monitor > Administration > Disable HP Real User Monitor.

For additional information on starting and stopping HP Real User Monitor, 
see “Administering HP Real User Monitor” on page 76.
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Installing the HP Real User Monitor Probe

After installing the HP Real User Monitor engine, you must install at least 
one HP Real User Monitor probe. You must then set up the probe to collect 
real-user data and report this data to the engine.

This chapter includes:

 ➤  Physically Connecting the Probe on page 51

 ➤  Installing the Probe on page 53

 ➤  Stopping and Starting the Probe on page 56

 ➤  Installing an nCipher Card on the HP Real User Monitor Probe on page 57

Physically Connecting the Probe

This section describes how to physically connect the HP Real User Monitor 
probe to the network.

The HP Real User Monitor probe runs on a Linux or Windows machine and 
uses two network interfaces; one assigned to sniffing and the other assigned 
to management (which the HP Real User Monitor engine uses to connect to 
the probe machine). The interface used for sniffing should not have an IP 
address assigned to it. For details on the system requirements for the HP Real 
User Monitor probe, see “HP Real User Monitor Probe Requirements” on 
page 32.
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Using taps or port spanning, the sniffer interface listens to the traffic on the 
servers you are monitoring.
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Note: 

➤ If you are using a load balancer, it is recommended to place the network 
tap behind the load balancer

➤ Load balancers should be configured to use the x-forward-for header to 
preserve end-user IP addresses for use by HP Real User Monitor.

➤ For small installations with a low amount of network traffic, instead of 
using a network tap, an Ethernet port of the HP Real User Monitor probe 
can be connected to a switch that is configured for port mirroring for the 
monitored server.

Installing the Probe

This section describes how to install the Real User Monitor probe.

The HP Real User Monitor probe is installed on a machine running either 
the Linux or Windows operating system. For details on the system 
requirements for the HP Real User Monitor probe, see “HP Real User 
Monitor Probe Requirements” on page 32.

Tip: For better performance, it is recommended to install the HP Real User 
Monitor engine and the HP Real User Monitor probe on the same local area 
network (LAN).

This section includes the following topics:

➤ “Installing the Real User Monitor Probe on a Linux System” on page 54

➤ “Installing the Real User Monitor Probe on a Windows System” on page 55
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Installing the Real User Monitor Probe on a Linux System
Download the HP Real User Monitor probe installation file for Linux from 
the Downloads page, which you access from Admin > Platform > Setup and 
Maintenance.

Note: The HP Real User Monitor probe installation must be carried out as 
the root user.

To install the HP Real User Monitor probe:

 1 Click HP Real User Monitor probe on the Downloads page to download the 
HPRUMProbeSetup_linux.bin file to the /var/tmp directory on the machine 
on which you want to install the probe. Note that if you cannot download 
this file directly to the Linux machine on which you are installing the 
probe, make sure that you download the file to a machine from which you 
can later FTP (in binary mode) the file to the Linux machine.

Note: For the HP Real User Monitor probe setup file to be available on the 
Downloads page, it must first be installed to HP Business Availability Center. 
For details on installing HP Business Availability Center components setup 
files, see “Installing Component Setup Files” in the HP Business Availability 
Center Deployment Guide PDF. 

If you prefer, you can copy the HP Real User Monitor probe setup program 
directly from the Data Collectors and Components directory on the 
HP Business Availability Center DVD, for versions delivered on DVD.

 2 Run the installation script with the following commands:

➤ cd /var/tmp

➤ chmod 777 HPRUMProbeSetup_linux.bin

➤ HPRUMProbeSetup_linux.bin

 3 Change the sshd daemon to work with xinetd by running the script 
/etc/beatbox/configure_ssh.sh.
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 4 It is recommended to set the network configuration automatically by 
running the script /usr/bin/bb_netconfig.pl.

 5 Start the HP Real User Monitor probe with the command 
/etc/init.d/beatbox-capture start.

 6 Verify that the HP Real User Monitor probe has successfully started with the 
command /etc/init.d/beatbox-capture status. The following is displayed:

[root@beatboxrnd rum-pages]

# /etc/init.d/beatbox-capture status

BeatBox is responding properly.

[root@beatboxrnd rum-pages]#

Installing the Real User Monitor Probe on a Windows 
System

Note: The HP Real User Monitor probe installation must be carried out as an 
administrator.

To install the HP Real User Monitor probe:

 1 Download the HP Real User Monitor probe installation file for Windows 
(HPRUMProbeSetup_win.msi) from the Patch downloads area on the HP 
Software Support Web site (http://www.hp.com/go/hpsoftwaresupport) to the 
machine on which you want to install the probe.

Note: To access the Patch downloads area, you must log in with your HP 
Passport user name and password. 

 2 Run the HPRUMProbeSetup_win.msi setup file that you downloaded by 
double-clicking it.

 3 When prompted, accept the default installation path (recommended) or 
select a different path.
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 4 When the installation ends, if WinPcap is not already installed on the probe 
machine, the setup program automatically installs the recommended 
version of WinPcap.

Note: To avoid version conflicts, it is recommended to remove any prior 
installation of WinPcap from the probe machine and to let the probe setup 
program automatically install the recommended version.

 5 On the Real User Monitor engine machine, edit (or create if it does not exist) 
the probe.<IP address of the probe machine>.properties file in the 
HPRUM\conf\probes directory. Change (or add if it does not exist) the 
channelReader.type setting to http (the default value is remote). For 
example: channelReader.type=http.

 6 Start the HP Real User Monitor probe.

Stopping and Starting the Probe

The HP Real User Monitor probe is started automatically each time the 
machine on which it is installed is started. You can also manually start and 
stop the HP Real User Monitor probe.

To start the HP Real User Monitor probe manually on a Linux machine:

 1 Log in to the HP Real User Monitor probe machine as the root user.

 2 Start the HP Real User Monitor probe with the command 
/etc/init.d/beatbox-capture start.

To start the HP Real User Monitor probe manually on a Windows machine:

Select Start > Programs > HP Real User Monitor > Administration > Probe > 
Start RUMProbe.

To stop the HP Real User Monitor probe manually on a Linux machine:

 1 Log in to the HP Real User Monitor probe machine as the root user.

 2 Stop the HP Real User Monitor probe with the command 
/etc/init.d/beatbox-capture stop.
56



Chapter 4 • Installing the HP Real User Monitor Probe
To stop the HP Real User Monitor probe manually on a Windows machine:

Select Start > Programs > HP Real User Monitor > Administration > Probe > 
Stop RUMProbe.

Installing an nCipher Card on the HP Real User Monitor 
Probe

Note: This section applies to the HP Real User Monitor Probe only when it is 
installed on a Linux system. 

You can install an nCipher card on the HP Real User Monitor Probe to 
enable the probe to use high level security when monitoring SSL encrypted 
traffic. For details on installing and configuring the nCipher card, refer to 
the nCipher documentation.

This section describes:

➤ “Prerequisites for Installing an nCipher Card” on page 57

➤ “Verifying an nCipher Card with Apache Web Server” on page 58

➤ “Customizing the HP Real User Monitor Probe” on page 58

➤ “Troubleshooting” on page 60

Prerequisites for Installing an nCipher Card
Note the following before installing an nCipher card on the HP Real User 
Monitor Probe:

➤ nCipher currently supports JRE/JDK version 1.4.x.

➤ To work with nCipher’s KeySafe product, Sun Java runtime environment 
version 1.5, or the equivalent developer kit, must be installed on the 
HP Real User Monitor Probe machine.
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➤ It is recommended to install the Sun Java runtime environment on the 
HP Real User Monitor Probe machine prior to installing the nCipher 
components.

➤ The Java executable must be included in the environment path of the 
HP Real User Monitor Probe machine.

Verifying an nCipher Card with Apache Web Server
Once you have installed a nCipher card on the HP Real User Monitor Probe 
machine, it is recommended that you check that the card works with the 
Apache Web Server. For details on integrating the nCipher components with 
the Apache Web Server installation on the HP Real User Monitor Probe, refer 
to the instructions on the nCipher Web site 
(http://www.ncipher.com/en/Resources/~/media/Files/Integration%20Guides/Ap
ache22x.ashx).

Customizing the HP Real User Monitor Probe
To customize HP Real User Monitor to work with the nCipher card, you 
must configure the HP Real User Monitor Engine and Probe machines and 
send the updated HP Real User Monitor Engine configuration to the HP Real 
User Monitor Probe.

To configure the HP Real User Monitor Engine machine:

Edit the \<HP Real User Monitor root directory>\conf\
configurationmanager\Beatbox_Default_Const_Configuration.xml file and 
make the following additions:

➤ Under the global heading in the static_global_params section, add the line 
ssl_hardware chil. For example:

<static_global_params>
<![CDATA[
[global]
max_field_length 2048
collect_server_stats false
collect_website_stats false
ssl_hardware chil
]]>
</static_global_params>
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➤ Under the collector heading in the collector section, add the path and name 
of the PEM file created by nCipher. This file contains the name of a key that 
is protected by the nCipher security world. For example:

To configure the HP Real User Monitor Probe machine:

 1 Add the environment variable definition for LD_LIBRARY_PATH to the file 
/etc/bashrc:

LD_LIBRARY_PATH=/opt/nfast/toolkits/hwcrhk;export LD_LIBRARY_PATH

 2 Restart the probe with the following command:

/etc/init.d/beatbox-capture restart

To send the updated HP Real User Monitor Engine configuration to the 
HP Real User Monitor Probe:

Force an update of the HP Real User Monitor Probe configuration by 
accessing the HP Real User Monitor Web console and selecting Tools > 
Monitoring Configuration Information > Sync All Configuration. For details 
on working with the HP Real User Monitor Web console, see “Using the 
HP Real User Monitor Web Console” on page 78.

<collector>
<![CDATA[
[collector]
device              all
servers             0.0.0.0/0.0.0.0   80
ssl_servers 192.168.81.96 444 /root/nCipherpem_file.pem
]]>
</collector
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Troubleshooting
On a Linux installation, if the Apache Web Server is configured for SSL, but 
is unable to access pages after the nCipher card is installed, change the 
LD_ASSUME_KERNEL parameter to use Linux Kernel version 2.4.1. To 
change the LD_ASSUME_KERNEL parameter, use the following commands 
from the command line prompt on the HP Real User Monitor Probe 
machine’s console:

➤ $ echo LD_ASSUME_KERNEL=2.4.1 >> /etc/nfast.conf

➤ $ echo export LD_ASSUME_KERNEL >> /etc/nfast.conf

Restart the nCipher hardserver for the new setting to take effect.
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Uninstalling HP Real User Monitor

If you no longer want to use HP Real User Monitor, you can uninstall the 
engine.

Note: To uninstall the probe, you need only disconnect it from the network, 
or shut down the probe machine.

This chapter includes:

 ➤  Uninstalling HP Real User Monitor on a Windows Platform on page 61

Uninstalling HP Real User Monitor on a Windows Platform

To uninstall the HP Real User Monitor engine:

 1 If HP Real User Monitor is running, stop it by disabling it from the Start 
menu (Start > Programs > HP Real User Monitor > Administration > Disable 
HP Real User Monitor).

 2 On the machine from which you are uninstalling HP Real User Monitor:

 a Select Start > Settings > Control Panel.

 b Select Add/Remove Programs.

 c Select HP Real User Monitor.

 d Click Change/Remove.

 e Click Next.
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 3 When the Setup Welcome screen is displayed, click Next.

 4 Choose whether you want to export user data settings, to save your HP Real 
User Monitor configuration for later use. Click Next.

If you chose not to export the data, continue with step 6.

Note: You can only export user data settings for installations that include a 
MySQL database. When uninstalling a Real User Monitor engine only 
installation, select the Do not export option for this step.

 5 Enter the target directory in which to save the backup data, or select the 
default directory, and choose whether or not to include the MySQL schema.

Click Next.
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Note: 

➤ If you are uninstalling the HP Real User Monitor engine only (that is, the 
MySQL database is installed on a different machine), you are not 
prompted to choose whether to include the MySQL schema.

➤ If you are uninstalling HP Real User Monitor engine version 7.00 or later, 
you are not prompted to choose whether to include the MySQL schema.

➤ The directory you choose in which to save the backup data must not 
already exist.

➤ If you choose to include the MySQL schema, the directory you choose in 
which to save the backup data must be on the same partition on which 
HP Real User Monitor is installed.

 6 Read the summary information. If it is correct, click Next to continue with 
the uninstallation. If it is not correct, click Back to correct the information 
you previously provided.

 7 If prompted, choose whether you want the uninstall process to reboot the 
machine for you automatically when the uninstall process is complete, or to 
restart it yourself manually at a later time. Click Next.

 8 Once the HP Real User Monitor engine has been uninstalled, click Finish to 
exit the uninstall process.

Note: If you delete the MySQL database only, the HP Real User Monitor 
engine does not work without the MySQL database.
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6
Configuring the HP Real User Monitor 
Probe

You can configure the HP Real User Monitor probe by changing the default 
settings and adding additional configuration settings.

This chapter includes:

 ➤  Using SSL to Access the HP Real User Monitor Probe Web Console on page 68

 ➤  Limiting WebConsole Resources on page 70

 ➤  Configuring the HP Real User Monitor Probe for I18N on page 71

 ➤  Changing the Header in Which to Locate Client IP Addresses on page 73
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Using SSL to Access the HP Real User Monitor Probe Web 
Console

By default, the connection to the Real User Monitor probe Web console is 
made using the SSL protocol. To enable the browser on a client machine to 
communicate with the probe machine using SSL, you must install a client 
certificate in the browser. You can manually configure the probe to use the 
HTTP protocol instead of SSL.

Note: Default access to the probe Web console is via HTTP communications 
if:

➤ You are using a version of HP Real User Monitor or HP Business 
Availability Center that is earlier than version 8.00.

➤ You upgrade to HP Real User Monitor version 8.04 from a version that is 
earlier than version 8.00.

This section includes the following topics:

➤ “Installing the Client Certificate” on page 68

➤ “Accessing the HP Real User Monitor Web Console” on page 69

Installing the Client Certificate
To enable the browser on a client machine to communicate with the probe 
machine using SSL, you must install the rum-probe-c.p12 certificate from 
the /etc/beatbox directory on the probe machine into the browser on the 
client machine. (On Windows installations of the probe, the /etc/beatbox 
directory is located in the HP Real User Monitor probe root directory.)

To install a certificate in Internet Explorer:

 1 Select Tools > Options.

 2 In the Content tab, click Certificates.
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 3 Click Import and use the wizard to enter the certificate location and file 
name and import the certificate. When prompted for a password, use the 
default password mercurypw.

To install a certificate in FireFox:

 1 Select Tools > Options > Advanced.

 2 In the Certificates section, click Manage Certificates.

 3 Click Import and select the certificate file.

 4 Continue as prompted to import the certificate. When prompted for a 
password, use the default password mercurypw.

Accessing the HP Real User Monitor Web Console
After installing the rum-probe-c.p12 certificate in the browser on a client 
machine, you access the HP Real User Monitor Web console by entering the 
following URL in the browser:

https://<probe machine IP>:2020/stats.xml

Note: If using the HTTP protocol to access the probe Web console, in the 
URL use http instead of https.

You can manually configure the protocol used to access the probe Web 
console.

To manually configure the protocol:

 1 In the <HP Real User Monitor root directory>\conf\probes\
probe.default.properties file on the HP Real User Monitor engine, in the 
RUM Engine Probe HTTP Connection Parameters section, set the 
connection.http.ssl parameter to true for SSL or false for HTTP. For example:

#           RUM Engine Probe HTTP Connection Parameters #
######################################################
connection.http.port=2020
connection.http.ssl=false
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 2 In the /etc/beatbox/bbsecurity.conf file on the probe machine, uncomment 
the use_ssl parameter and change its value to true for SSL (which is the 
default setting) or false for HTTP.

Note: On Windows installations of the probe, the /etc/beatbox directory is 
located in the HP Real User Monitor probe root directory.

 3 Restart the Real User Monitor engine.

Limiting WebConsole Resources

For security reasons, the WebConsole resources of the HP Real User Monitor 
probe are limited by default, so that only configuration updates and general 
statistics are available. You can remove this limitation for troubleshooting so 
that all resources are available.

Note: It is recommended to reset the limitation after you have finished 
troubleshooting.

To change the availability of WebConsole resources:

 1 Edit the /etc/beatbox/bbsecurity.conf file on the probe machine.

Note: On Windows installations of the probe, the /etc/beatbox directory is 
located in the HP Real User Monitor probe root directory.

 2 In the webconsole section of the file, change the setting of the 
restrict_webconsole parameter to true (to impose the limitation) or false (to 
remove the limitation).
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 3 Save the file.

 4 Restart the HP Real User Monitor probe.

Configuring the HP Real User Monitor Probe for I18N

By default, HP Real User Monitor uses the UTF-8 character set when 
monitoring data. To enable HP Real User Monitor to support non Unicode 
encodings, you can configure the HP Real User Monitor probe to use a 
different character set.

To change the character set used by the HP Real User Monitor probe when 
monitoring data:

In the <HP Real User Monitor root directory>\conf\
configurationmanager\Beatbox_Default_Const_Configuration.xml file on 
the HP Real User Monitor engine, under the [global] section, add the 
following lines:

enable_i18n <false/true>
contant_charset_search_len <length>
charset <name>

where:

➤ <false/true>. Set to true to enable HP Real User Monitor to support I18N by 
using character sets other than UTF-8. The default setting is false.

➤ <length>. The number of bytes in the page content in which HP Real User 
Monitor searches for a character set. By default, HP Real User Monitor does 
not search the page content for a character set and only searches the page 
header. The maximum permissible length is 1024 characters.

➤ <name>. The default character set to use, if HP Real User Monitor does not 
locate a character set in either the page header or content. Valid character 
sets are those that are by default supported by the ICU library.
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The following example shows the additional lines added to the [global] 
section in the <HP Real User Monitor root directory>\conf\
configurationmanager\Beatbox_Default_Const_Configuration.xml file on 
the HP Real User Monitor engine:

<static_global_params>
<![CDATA[
[global]
max_field_length 2048
collect_server_stats false
collect_website_stats false
enable_i18n true
contant_charset_search_len 1024
]]>
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Changing the Header in Which to Locate Client IP 
Addresses 

By default, HP Real User Monitor tries to locate client IP addresses using the 
X-Foward-For header. If client IP addresses are located in a different header 
(for example, in a custom header) you can configure HP Real User Monitor 
to use that header when trying to locate client IP addresses.

To change the header used by the HP Real User Monitor probe when 
locating client IP addresses:

 1 In the <HP Real User Monitor root directory>\conf\
configurationmanager\Beatbox_Default_Const_Configuration.xml file on 
the HP Real User Monitor engine, under the [global] section, add the 
following line:

forwarded_for_header <HEADER_NAME>

where <HEADER_NAME> is the name of the new header to use for locating 
client IP addresses.

 2 In the Real User Monitor engine Web console, synchronize configuration 
data by selecting Tools > Monitoring Configuration Data > Sync All 
Configuration. For details, see “Monitoring Configuration Information” on 
page 142.
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7
Configuring and Administering the 
HP Real User Monitor Engine

You configure and administer the HP Real User Monitor engine via the Web 
and JMX consoles, which allow you to configure the engine, monitor 
system health, and use a number of diagnostic tools.

This chapter includes:

 ➤  Administering HP Real User Monitor on page 76

 ➤  Using the HP Real User Monitor Web Console on page 78

 ➤  Using the HP Real User Monitor JMX Console on page 162

 ➤  URL Correlation Parameters on page 170

 ➤  Configuring Meaningful Page Names on page 174

 ➤  Unifying Frames on page 201

 ➤  HP Real User Monitor Logs on page 204
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Administering HP Real User Monitor

You administer HP Real User Monitor by using the Start menu and task bar 
icon that are installed during a Windows installation of HP Real User 
Monitor.

HP Real User Monitor Windows Start Menu
To access the HP Real User Monitor Start menu that is added to the 
Windows machine on which the HP Real User Monitor engine is installed, 
select Start > Programs > HP Real User Monitor. The menu includes the 
following options:

Administration

The Administration menu option includes the following options:

Open HP Real User Monitor Web Console

Selecting this option opens the HP Real User Monitor Web console used for 
administering HP Real User Monitor. For details, see “Using the HP Real 
User Monitor Web Console” on page 78.

Option Description

RUM Configuration Tool Runs the HP Real User Monitor Configuration Tool, 
which enables you to create a MySQL database 
schema, and to connect HP Real User Monitor to a 
MySQL database. For details, see “Creating and 
Connecting to the MySQL Database” on page 206.

Database (only if the 
MySQL database has been 
installed)

Opens a submenu with options for starting and 
stopping the MySQL database on the machine on 
which it is installed.

Disable HP Real User 
Monitor

Stops HP Real User Monitor on the specific 
machine, and disables it from being run 
automatically whenever the machine is started.

Enable HP Real User 
Monitor

Starts HP Real User Monitor on the specific 
machine, and sets it to run automatically whenever 
the machine is started.
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HP Real User Monitor Windows Task Bar Icon
The task bar icon installed with HP Real User Monitor provides a menu with 
options for the HP Real User Monitor Agent service. The HP Real User 
Monitor Agent service is responsible for launching HP Real User Monitor 
and managing the processes used by it. The supervisor process manages and 
monitors the other processes used by HP Real User Monitor.

When HP Real User Monitor is first enabled, the icon appears with two 
yellow stars only. When the HP Real User Monitor application server has 
successfully started, the stars change to grey and a green tick appears above 
them. If there is an error during startup, or an error with the jboss process 
after startup, the green tick in the above icon changes to a red X until the 
problem is rectified.

The menu, which you access by right-clicking the icon, includes the 
following options:

Option Description

About Displays informational data about the HP Real User 
Monitor Agent service.

View Log Displays the supervisor log, which includes 
information about the various processes being used 
by HP Real User Monitor.

Settings Displays the processes in use by HP Real User 
Monitor, and their current settings.

Close Stops HP Real User Monitor and closes the HP Real 
User Monitor Agent service.
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Note: 

Changing any of the process settings can cause HP Real User Monitor to 
malfunction and should not be done without consulting HP Software 
Support.

Do not use Close to stop HP Real User Monitor. Stop HP Real User Monitor 
by using the Disable HP Real User Monitor option from the Administration 
menu in the HP Real User Monitor Start menu only.

Using the HP Real User Monitor Web Console

Once the HP Real User Monitor engine has been installed and started, you 
can use the HP Real User Monitor Engine Web console to view and 
configure the connection between HP Real User Monitor and HP Business 
Availability Center, view other HP Real User Monitor engine settings, 
monitor the health of HP Real User Monitor components, and use HP Real 
User Monitor diagnostic tools.

This section includes the following topics:

➤ “Accessing the HP Real User Monitor Engine Web Console” on page 79

➤ “Monitoring the Health of HP Real User Monitor Components” on page 84

➤ “HP Real User Monitor Configuration and Settings” on page 119

➤ “HP Real User Monitor Diagnostic Tools” on page 132
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Accessing the HP Real User Monitor Engine Web Console

Use the HP Real User Monitor Engine Web console to monitor the health of 
HP Real User Monitor components. You can also use a number of 
configuration tools to configure the HP Real User Monitor engine, as well as 
view and configure the connection parameters between HP Real User 
Monitor and HP Business Availability Center. In addition, the HP Real User 
Monitor Web console includes diagnostic tools that you can use in resolving 
HP Real User Monitor problems.

When you start the HP Real User Monitor engine after installation, you can 
access the HP Real User Monitor Engine Web console by launching a Web 
browser and entering the following URL:

http://<HP Real User Monitor engine machine name or IP>:8180

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

Note: On a Windows machine on which the HP Real User Monitor engine is 
installed, you can also access the HP Real User Monitor Engine Web console 
by selecting Start > Programs > HP Real User Monitor > Open Real User 
Monitor Web Console. 

This section includes the following topics:

➤ “Logging In” on page 80

➤ “Logging Out” on page 80

➤ “Changing Login Parameters” on page 80

➤ “Changing the Language of the Real User Monitor Web Console User 
Interface” on page 82
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Logging In

When you access the HP Real User Monitor Engine Web console, the login 
page opens.

Enter the login parameters (login name and password) of a user defined in 
HP Real User Monitor, and click Log In. After logging in, the user name 
appears at the top right, in the title bar.

Initial access can be gained using the default superuser login parameters: 
Login Name=admin, Password=admin. It is recommended that the system 
superuser change this password immediately to prevent unauthorized entry. 
For details on changing the password, see “Changing Login Parameters” on 
page 80. 

The HP Real User Monitor Engine Web console opens, displaying the top 
menu bar that enables navigation to the configuration, health, tools, and 
help pages, as well as the Logout button.

Logging Out

When you complete your session, it is recommended that you log out of the 
Web site to prevent unauthorized entry, by clicking Logout at the top of the 
page.

Note: You are automatically logged out of the HP Real User Monitor Web 
console after twenty minutes of inactivity.

Changing Login Parameters

You can add, change, and delete HP Real User Monitor users by editing the 
<HP Real User Monitor root directory>\conf\rumwebconsole\users.xml 
file. In this file, there is a line for each user in the following format:

<user name="Administrator" login="admin" password="admin" 
"encryptedPassword="" />
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Note: It is recommended that the system superuser limit access to the 
<HP Real User Monitor root directory>\conf\rumwebconsole\users.xml 
file.

To add an HP Real User Monitor user:

 1 Open the <HP Real User Monitor root directory>\conf\rumwebconsole\
users.xml file in a text editor.

 2 Duplicate the entry for one of the existing users.

 3 In the duplicate line, enter the user name, login, and password parameters 
for the new user. Ensure that the encryptedPassword parameter is blank.

 4 Save the file.

To change an HP Real User Monitor user:

 1 Open the <HP Real User Monitor root directory>\conf\rumwebconsole\
users.xml file in a text editor.

 2 In the appropriate line, change the user name and login parameters as 
required.

 3 To change a user’s password, enter the new password in the password 
parameter and ensure that the encryptedPassword parameter is blank.

 4 Save the file.

To delete an HP Real User Monitor user:

 1 Open the HPRUM\conf\rumwebconsole\users.xml file in a text editor.

 2 Delete the appropriate line.

 3 Save the file.
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Note: 

➤ When deleting users, ensure that there is at least one user configured in 
the users file, or you are unable to access the HP Real User Monitor Web 
console.

➤ Changes to the HPRUM\conf\rumwebconsole\users.xml file only take 
effect when the HP Real User Monitor engine is restarted. When the 
HP Real User Monitor engine is started, user passwords in the password 
parameter are encrypted and removed, and the encrypted passwords are 
stored in the encryptedPassword parameter.

Changing the Language of the Real User Monitor Web Console 
User Interface

In Real User Monitor 8.00 and later, the Real User Monitor Web console user 
interface can be viewed in the following languages in your Web browser: 

Use the language preference option in your browser to select how to view 
the Real User Monitor Web console. The language preference chosen affects 
only the user’s local machine and not the Real User Monitor machines or 
any other user accessing the same Real User Monitor Web console. The 
language is determined when you log in to the Real User Monitor Web 
console; changing the language preference in your browser once you have 
logged in has no affect until you log out and log back in.

Language Language Preference in Web Browser

Chinese Chinese (China) [zh-cn]

English English (United States) [en-us]

French French (France) [fr]

Japanese Japanese [ja]

Korean Korean [ko]
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To view the Real User Monitor Web console in a specific language using 
Internet Explorer: 

 1 Select Tools > Internet Options and click Languages. The Language 
Preference dialog box opens. 

 2 Highlight the language in which you want to view the Real User Monitor 
Web console.

If the language you want is not listed in the dialog box, click Add to display 
the list of languages. Select the language you want to add and click OK.

 3 Click Move Up to move the selected language to the first row.

 4 Click OK to save the settings. 

 5 Refresh the page: the Real User Monitor Web console user interface is 
displayed in the selected language.

Note: 

➤ Starting from Real User Monitor version 7.0, there is no language pack 
installation. All translated languages are integrated into the Real User 
Monitor Multilingual User Interface.

➤ Data stays in the language it was entered in, even if the language of the 
Web browser changes. Changing the language of the Web browser on 
your local machine does not change the language of Real User Monitor 
definitions and configurations.

➤ If a user selects a language not supported by the Real User Monitor 
Multilingual User Interface, the Real User Monitor Web console user 
interface appears in English.
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Monitoring the Health of HP Real User Monitor 
Components
The Health drop-down menu on the HP Real User Monitor Engine Web 
console menu bar includes the following options:

➤ System Status on page 84. Used to display the status of the main HP Real 
User Monitor components.

➤ Capture Log Files on page 119. Used to create a zip file of the HP Real User 
Monitor resource and log files for use by HP Software Support.

System Status

You use the System Status option to display the status of the main HP Real 
User Monitor components. When you select this option, the System Health 
page opens. You can refresh the data displayed on the System Health page 
by clicking the Refresh button at the top, right hand side of the page.

For each component displayed on the System Health page, there are four 
possible statuses:

You can drill down to see the status of the entities that comprise the HP Real 
User Monitor component by clicking the component name.

OK

Minor

Critical

No status
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For each entity displayed, apart from the columns included in the tables 
below, there is a column called Value (Value Since Startup). If an entity is 
configured to display a value, it is displayed in this column either as an 
absolute value (for example, the number of pages handled), or as a ratio 
showing a value for a given time period (for example, the number of session 
events per second). An additional absolute value might be displayed in 
brackets, which is the accumulated value of the entity since the HP Real 
User Monitor engine was last started.

Note: Entities using ratios have no status until the System Health page has 
been automatically updated twice by the HP Real User Monitor engine. This 
can take several moments (by default, up to six minutes).
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The following table lists the components and their entities and describes the 
meaning of the different statuses:

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)

Configuration 
Retrieval from 
BAC server

Connection to 
Business 
Availability 
Center server

Status of the 
connection to 
the 
HP Business 
Availability 
Center 
Gateway 
Server for 
retrieving the 
HP Real User 
Monitor 
engine and 
probe 
configurations

Connection 
to BAC 
server is 
operational

N/A Connection to 
BAC server is 
not 
operational

Data type 
<type name> 
retrieval

Status of the 
last attempt to 
retrieve data 
type <type 
name> 
configuration 
from the 
HP Business 
Availability 
Center 
Gateway 
Server

Configur-
ation of 
data type 
<type 
name> 
successfully 
retrieved 
from BAC 
server

N/A Errors while 
trying to 
retrieve 
configuration 
data type 
<type name> 
from BAC 
server
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Database Database 
connectivity

Status of the 
connectivity 
between the 
HP Real User 
Monitor 
engine and 
the MySQL 
database

Connection 
to database 
OK

N/A Connection to 
database not 
working

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Database Database free 
space

Percentage of 
free space 
(including free 
space in the 
tablespace) on 
the disk on 
which the 
MySQL 
database is 
installed

More than 
4% is free.

3–4% is free. Less than 3% is 
free.

Database 
Response Time

Status of the 
response time 
between the 
HP Real User 
Monitor 
engine and 
the MySQL 
database

Database 
response 
time is 
normal

Database 
response 
time is 
below 
normal

Database 
response time 
is slow

Database 
Session 
Purging Time

The length of 
time taken to 
purge old 
sessions from 
the database

Purging 
time is 
normal

Purging 
time is slow

N/A

Number of 
stale queries

The number of 
database 
queries that 
were aborted 
because they 
were stale 
(running for 
too long a 
period)

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

100 Continue 
Hits

Opens a page 
that displays 
for each 
monitored 
Web 
application, 
the number of 
100 Continue 
Hit messages 
received by 
the Web 
servers from 
clients

N/A N/A N/A

Active 
Connections

The number of 
active TCP 
connections 
currently 
monitored by 
the HP Real 
User Monitor 
probe

The number 
of active 
TCP 
connections 
is below the 
internal 
permitted 
number

The number 
of active 
TCP 
connections 
is close to 
the internal 
permitted 
number

The number of 
active TCP 
connections 
has exceeded 
the internal 
permitted 
number

Active Sessions The number of 
sessions 
currently 
monitored by 
the HP Real 
User Monitor 
probe

The number 
of active 
sessions is 
below the 
internal 
permitted 
number

The number 
of active 
sessions is 
close to the 
internal 
permitted 
number

The number of 
active sessions 
has exceeded 
the internal 
permitted 
number

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Channel 
"connections" 
Status

Status of the 
last attempt to 
connect to the 
channel

The HP Real 
User 
Monitor 
engine has 
successfully 
connected 
to this 
probe 
channel

The HP Real 
User 
Monitor 
engine 
experienced 
problems 
while 
connecting 
to this 
probe 
channel

The HP Real 
User Monitor 
engine has 
failed to 
connect to this 
probe channel 
more than 
three 
consecutive 
times

Channel 
"missing 
components" 
Status

Status of the 
last attempt to 
connect to the 
channel

The HP Real 
User 
Monitor 
engine has 
successfully 
connected 
to this 
probe 
channel

The HP Real 
User 
Monitor 
engine 
experienced 
problems 
while 
connecting 
to this 
probe 
channel

The HP Real 
User Monitor 
engine has 
failed to 
connect to this 
probe channel 
more than 
three 
consecutive 
times

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Channel 
"pages" Status

Status of the 
last attempt to 
connect to the 
channel

The engine 
has 
successfully 
connected 
to this 
probe 
channel

The engine 
experienced 
problems 
while 
connecting 
to this 
probe 
channel

The engine has 
failed to 
connect to this 
probe channel 
more than 
three 
consecutive 
times

Channel 
"poorRequests" 
Status

Status of the 
last attempt to 
connect to the 
channel

The HP Real 
User 
Monitor 
engine has 
successfully 
connected 
to this 
probe 
channel

The HP Real 
User 
Monitor 
engine 
experienced 
problems 
while 
connecting 
to this 
probe 
channel

The HP Real 
User Monitor 
engine has 
failed to 
connect to this 
probe channel 
more than 
three 
consecutive 
times

Channel 
"sessions" 
Status

Status of the 
last attempt to 
connect to the 
channel

The HP Real 
User 
Monitor 
engine has 
successfully 
connected 
to this 
probe 
channel

The HP Real 
User 
Monitor 
engine 
experienced 
problems 
while 
connecting 
to this 
probe 
channel

The HP Real 
User Monitor 
engine has 
failed to 
connect to this 
probe channel 
more than 
three 
consecutive 
times

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Configuration 
to Probe

Status of the 
last attempt to 
send the 
configuration 
to the HP Real 
User Monitor 
probe

Probe was 
configured 
successfully

N/A Errors during 
probe 
configuration 
process

Connection to 
Probe

Status of the 
HTTP 
connection 
from the 
HP Real User 
Monitor 
engine to the 
HP Real User 
Monitor probe

The 
connection 
is successful

N/A There is no 
connection

Disk 
Utilization for

The HP Real 
User Monitor 
probe disk 
utilization on 
a specific 
partition

Free disk 
space is 
sufficient

Free disk 
space is 
nearing its 
limit

Free disk space 
is insufficient

HTTP Bytes 
Received

The total 
number of 
HTTP bytes 
received by 
the Web 
servers from 
clients

The current 
load of 
HTTP 
received 
traffic is 
normal

N/A The current 
load of HTTP 
received traffic 
is too high for 
a single 
HP Real User 
Monitor probe

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

HTTP Bytes 
Sent

The total 
number of 
HTTP bytes 
sent by the 
Web servers to 
clients

The current 
load of 
HTTP sent 
traffic is 
normal

N/A The current 
load of HTTP 
sent traffic is 
too high for a 
single HP Real 
User Monitor 
probe

HTTP Packets The total 
number of 
HTTP packets 
processed by 
the HP Real 
User Monitor 
probe

The HTTP 
packet rate 
is normal

N/A The HTTP 
packet rate is 
too high for a 
single HP Real 
User Monitor 
probe

HTTPS Bytes 
Received

The total 
number of 
HTTPS bytes 
received by 
the Web 
servers from 
clients

The current 
load of 
HTTPS 
received 
traffic is 
normal

N/A The current 
load of HTTPS 
received traffic 
is too high for 
a single 
HP Real User 
Monitor probe

HTTPS Bytes 
Sent

The total 
number of 
HTTPS bytes 
sent by the 
Web servers to 
clients

The current 
load of 
HTTPS sent 
traffic is 
normal

N/A The current 
load of HTTPS 
sent traffic is 
too high for a 
single HP Real 
User Monitor 
probe

HTTPS Packets The total 
number of 
HTTPS packets 
processed by 
the HP Real 
User Monitor 
probe

The HTTPS 
packet rate 
is normal

N/A The HTTPS 
packet rate is 
too high for a 
single HP Real 
User Monitor 
probe

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Incomplete 
Transactions

The 
percentage of 
incomplete 
packets (that 
is, requests 
without 
responses). A 
high number 
can indicate a 
problem with 
a switch, or 
with a probe’s 
network 
configuration.

N/A N/A N/A

Lost SSL 
Requests

The 
percentage of 
SSL requests 
for which the 
decryption 
failed.

N/A N/A N/A

Missing 
Mirrored Data

Click Missing Mirrored Data to see the entities that comprise 
the Missing Mirrored Data component. For details, see the 
Missing Mirrored Data component in this table.

Network 
Captures 
Retriever 
Queue Size 

The queue size 
of the probe’s 
network 
capture files.

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Orphan 
Application 
Hits

Opens a page 
that displays 
for each 
monitored 
application, 
the percentage 
of page 
components 
that could not 
be correlated 
to a specific 
page

N/A N/A N/A

Packet Queue 
Work

The current 
number of 
packets 
collected from 
the network 
devices, but 
not yet 
processed

The packet 
rate is 
normal

The packet 
rate is 
nearing the 
limit for 
normal 
processing

The packet rate 
is too high

Packets Lost The total 
number of 
packets that 
the HP Real 
User Monitor 
probe has 
recognized as 
missing

The 
network is 
stable and 
packets are 
being 
processed 
normally

Possible 
network 
problems 
which could 
lead to data 
loss

The network is 
bad and the 
HP Real User 
Monitor probe 
might loose 
some data

Pages Cached The number of 
page views 
currently 
being cached 
to the HP Real 
User Monitor 
probe’s 
memory

The page 
rate is stable

The page 
rate is 
nearing the 
limit for 
normal 
caching

The page rate 
is too high

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Pages Channel 
Processing 
Delay 

Displays the 
difference 
between the 
time a page hit 
was received 
by the probe 
to when it was 
reported to the 
HP Real User 
Monitor 
engine

N/A N/A N/A

Probe and 
Engine Time 
Difference

Displays the 
status of the 
time 
synchron-
ization 
between the 
HP Real User 
Monitor 
engine and 
probe

The HP Real 
User 
Monitor 
engine and 
probe are in 
sync

The HP Real 
User 
Monitor 
engine and 
probe are 
slightly out 
of sync

The HP Real 
User Monitor 
engine and 
probe are 
grossly out of 
sync

Probe Channel 
rum-
components 
Guarantee 
Delivery Files 
Total Size

The total size 
of component 
channel files 
on the HP Real 
User Monitor 
probe

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Channel 
rum-
components 
Total 
Guarantee 
Delivery Files

The number of 
guaranteed 
delivery files 
for the 
components 
channel 
waiting to be 
read by the 
Real User 
Monitor 
engine

The number 
of 
component 
channel 
files is 
normal

The number 
of 
component 
channel 
files is high, 
indicating 
that the 
Real User 
Monitor 
engine 
might be 
processing 
less data 
than the 
Real User 
Monitor 
probe is 
producing

N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Channel 
rum-
connections 
Guarantee 
Delivery Files 
Total Size

The total size 
of connection 
channel files 
on the HP Real 
User Monitor 
probe

N/A N/A N/A

Probe Channel 
rum-
connections 
Total 
Guarantee 
Delivery Files

The number of 
guaranteed 
delivery files 
for the 
connections 
channel 
waiting to be 
read by the 
Real User 
Monitor 
engine

The number 
of 
connection 
channel 
files is 
normal

The number 
of 
connection 
channel 
files is high, 
indicating 
that the 
Real User 
Monitor 
engine 
might be 
processing 
less data 
than the 
Real User 
Monitor 
probe is 
producing

N/A

Probe Channel 
rum-pages 
Guarantee 
Delivery Files 
Total Size

The total size 
of page 
channel files 
on the HP Real 
User Monitor 
probe

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Channel 
rum-pages 
Total 
Guarantee 
Delivery Files

The number of 
guaranteed 
delivery files 
for the pages 
channel 
waiting to be 
read by the 
Real User 
Monitor 
engine

The number 
of page 
channel 
files is 
normal

The number 
of page 
channel 
files is high, 
indicating 
that the 
Real User 
Monitor 
engine 
might be 
processing 
less data 
than the 
Real User 
Monitor 
probe is 
producing

N/A

Probe Channel 
rum-poor-
requests 
Guarantee 
Delivery Files 
Total Size

The total size 
of poor-
request 
channel files 
on the HP Real 
User Monitor 
probe

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Channel 
rum-poor-
requests Total 
Guarantee 
Delivery Files

The number of 
guaranteed 
delivery files 
for the poor-
requests 
channel 
waiting to be 
read by the 
Real User 
Monitor 
engine

The number 
of poor-
request 
channel 
files is 
normal

The number 
of poor-
request 
channel 
files is high, 
indicating 
that the 
Real User 
Monitor 
engine 
might be 
processing 
less data 
than the 
Real User 
Monitor 
probe is 
producing

N/A

Probe Channel 
rum-sessions 
Guarantee 
Delivery Files 
Total Size

The total size 
of session 
channel files 
on the HP Real 
User Monitor 
probe

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Channel 
rum-sessions 
Total 
Guarantee 
Delivery Files

The number of 
guaranteed 
delivery files 
for the 
sessions 
channel 
waiting to be 
read by the 
Real User 
Monitor 
engine

The number 
of session 
channel 
files is 
normal

The number 
of session 
channel 
files is high, 
indicating 
that the 
Real User 
Monitor 
engine 
might be 
processing 
less data 
than the 
Real User 
Monitor 
probe is 
producing

N/A

Probe 
Channels Data 
Flow

Status of 
retrieving data 
from the 
HP Real User 
Monitor probe

Data from 
the probe 
successfully 
retrieved

Probe has 
not 
produced 
new data for 
some time

N/A

Probe 
Connections 
Published

The number of 
connections 
recorded by 
the HP Real 
User Monitor 
probe

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe 
Connections 
Processed by 
Engine

The number of 
connections 
that the 
HP Real User 
Monitor 
engine has 
started to 
process

N/A N/A N/A

Probe Page 
Hits

The number of 
page hits 
recorded by 
the HP Real 
User Monitor 
probe

N/A N/A N/A

Probe Page 
Hits Processed 
by Engine

The number of 
page hits that 
the HP Real 
User Monitor 
engine has 
started to 
process

N/A N/A N/A

Probe Process 
CPU 
Utilization

The current 
percentage of 
probe 
utilization of 
the probe 
process

Probe 
utilization is 
normal

Probe 
utilization is 
nearing the 
limit for a 
single 
HP Real 
User 
Monitor 
probe

N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Process 
Memory

The total 
amount of 
non-swapped, 
physical 
memory used 
by the HP Real 
User Monitor 
probe, in 
kilobytes

Always N/A N/A

Probe Process 
Memory 
Utilization

The total 
amount of 
non-swapped 
physical 
memory used 
by the probe 
process, out of 
the total 
amount of 
physical 
system 
memory, in 
kilobytes

Memory 
utilization is 
normal

Memory 
utilization is 
high

Memory 
utilization is 
nearing the 
maximum 
permissible 
value

Probe Storage 
ccomps 
Number of 
Errors

The number of 
non critical 
errors for 
components 
that occurred 
when working 
with the 
database 

N/A N/A N/A

Probe Storage 
ccomps 
Number of 
Total Records

The total 
number of 
records for 
components 
in the 
database

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Storage 
ccomps Status

The current 
status of the 
database for 
components

Database 
status is 
normal

N/A Database 
status is bad

Probe Storage 
mainpagedb 
Number of 
Errors

The number of 
non critical 
errors for main 
pages that 
occurred when 
working with 
the database 

N/A N/A N/A

Probe Storage 
mainpagedb 
Number of 
Total Records

The total 
number of 
records for 
main pages in 
the database

N/A N/A N/A

Probe Storage 
mainpagedb 
Status

The current 
status of the 
database for 
main pages

Database 
status is 
normal

N/A Database 
status is bad

Probe Storage 
pcapnetwork 
Number of 
Errors

The number of 
non critical 
errors for 
network 
captures that 
occurred when 
working with 
the database 

N/A N/A N/A

Probe Storage 
pcapnetwork 
Number of 
Total Records

The total 
number of 
records for 
network 
captures in the 
database

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

Probe Storage 
pcapnetwork 
Status

The current 
status of the 
database for 
network 
captures

Database 
status is 
normal

N/A Database 
status is bad

Received Bytes 
on Network 
Device

The total 
number of 
bytes received 
per specific 
NIC, in bits 
per second

Network 
device load 
is normal

Network 
device load 
is nearing 
the probe’s 
limit

N/A

Total Memory The total 
amount of 
physical 
system 
memory, in 
kilobytes

Always N/A N/A

SSL 
Transactions 
Dropped 

The 
percentage of 
SSL 
transactions 
that could be 
decrypted

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Real User 
Monitor 
Probe

XFF over NAT Value can be 0 
or 1. If 1, the 
value of 
“x-forwarder-
for” HTTP 
header has 
different 
values within 
the same 
connection. 
Can indicate 
differences 
between HTTP 
and TCP 
reports on the 
same 
application.

N/A N/A N/A

RUM Engine Aggregation 
Manager

Click Aggregation Manager to see the entities that comprise 
the Aggregation Manager component. For details, see the 
Aggregation Manager component in this table.

Application 
Session Count

The total 
number of 
open 
application 
sessions

Always N/A N/A

Application 
Transaction 
Count

The total 
number of 
open 
application 
transactions

Always N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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RUM Engine BBRetriever 
hold time due 
to load on 
Entry Topic

The time (in 
milliseconds) 
that the 
BBRetriever 
was stopped 
due to JMS 
load on the 
Entry topic

N/A N/A N/A

BBRetriever 
hold time due 
load on 
RawEntry 
Topic

The time (in 
milliseconds) 
that the 
BBRetriever 
was stopped 
due to JMS 
load on the 
RawEntry 
topic

N/A N/A N/A

BBRetriever 
hold time due 
to load on TCP 
Entry Topic

The time (in 
milliseconds) 
that the 
BBRetriever 
was stopped 
due to JMS 
load on the 
TCP Entry 
topic

N/A N/A N/A

BBRetriever 
hold time due 
load on TCP 
RawEntry 
Topic

The time (in 
milliseconds) 
that the 
BBRetriever 
was stopped 
due to JMS 
load on the 
TCP RawEntry 
topic

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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RUM Engine BBRetriever 
Thrown 
Objects

The total 
number of 
objects 
thrown by the 
BBRetriever

N/A N/A N/A

BBRetriever 
Total 
Connections 
Handled

The number of 
connections 
being handled 
by the 
BBRetriever in 
the HP Real 
User Monitor 
engine

The number 
of 
connections 
being 
handled is 
normal

The number 
of 
connections 
being 
handled is 
above 
average

The number of 
connections 
being handled 
is high

BBRetriever 
Total Pages 
Handled

The number of 
pages being 
handled by 
the 
BBRetriever in 
the HP Real 
User Monitor 
engine

The number 
of pages 
being 
handled is 
normal

The number 
of pages 
being 
handled is 
above 
average

The number of 
pages being 
handled is 
high

BBRetriever 
Total Poor 
Requests 
Handled

The number of 
Poor requests 
handled by 
the 
BBRetriever in 
the HP Real 
User Monitor 
engine

N/A N/A N/A

Data Access 
Layer

Click Data Access Layer to see the entities that comprise the 
Data Access Layer component.

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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RUM Engine Free Memory The free 
memory 
available for 
the HP Real 
User Monitor 
engine

The free 
memory is 
sufficient 
for the 
HP Real 
User 
Monitor 
engine to 
run under 
the current 
load

The free 
memory is 
nearing the 
limit for the 
HP Real 
User 
Monitor 
engine to 
run under 
the current 
load

The free 
memory is not 
sufficient for 
the HP Real 
User Monitor 
engine to run 
under the 
current load

JMS Entry 
topic size

The number of 
messages in 
the <entity> 
queue

The number 
of messages 
in the 
queue is 
normal

The number 
of messages 
in the 
queue is 
above 
normal

The number of 
messages in 
the queue is 
abnormalJMS 

Integration 
Entry topic 
size

JMS Publisher 
topic size

JMS Raw Entry 
topic size

JMS Samples 
topic size

JMS TCP Entry 
topic size

JMS TCP Raw 
Entry topic 
size

Login Maps 
Size per Name

The total 
number of 
login names 
mapped to 
sessions

Always N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
109



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
RUM Engine Login Maps 
Size per 
Session

The total 
number of 
sessions 
mapped to 
login names

Always N/A N/A

Partition 
Manager

Click Partition Manager to see the entities that comprise the 
Partition Manager component. For details, see the Partition 
Manager component in this table.

Poor Request 
Network 
Captures 
Retrieved 

The number of 
Poor request 
capture files 
retrieved by 
the HP Real 
User Monitor 
engine

N/A N/A N/A

Poor Request 
Network 
Captures 
Thrown

The number of 
Poor request 
capture files 
thrown by the 
HP Real User 
Monitor 
engine

N/A N/A N/A

Poor Requests 
with Network 
Captures

The number of 
Poor requests 
that have a 
network 
capture file

N/A N/A N/A

Publisher 
Chunks in 
Memory

The number of 
sample chunks 
(not yet sent 
to Business 
Availability 
Center) stored 
in memory

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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RUM Engine Publisher 
Chunks in 
Queue

The total 
number of 
sample chunks 
waiting to be 
sent to 
Business 
Availability 
Center

N/A N/A N/A

Resolver End 
User DNS 
Cache size

The size of the 
end user DNS 
cache

N/A N/A N/A

Resolver 
Ignored 
Sessions Cache 
Size

The size of the 
ignored 
sessions cache

Cache size is 
normal

N/A Cache size has 
exceeded the 
permissible 
limit

Resolver Server 
DNS Cache 
size

The size of the 
server DNS 
cache

N/A N/A N/A

Snapshot Jobs 
Alive Count

The total 
number of 
open snapshot 
jobs waiting to 
be processed

HP Real 
User 
Monitor can 
process all 
the open 
snapshots

The number 
of open 
snapshots 
waiting to 
be processed 
is nearing 
the limit for 
HP Real 
User 
Monitor 
under the 
current load

HP Real User 
Monitor might 
not be able to 
process all the 
snapshots 

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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RUM Engine Snapshot Jobs 
Submit 
Denials

The total 
number of 
submit 
requests for 
snapshot 
failures

Always N/A N/A

Snapshot 
Relevant 
Events

The total 
number of 
events that 
should trigger 
snapshot 
creation

Always N/A N/A

Snapshot 
Sessions Map 
Size

The total 
number of 
open sessions 
for which at 
least one 
snapshot was 
created

The number 
of current 
sessions is 
normal

The number 
of current 
sessions is 
nearing the 
permissible 
limit

The number of 
current 
sessions has 
exceeded the 
permissible 
limit

Statistics Total 
Aggregation 
Size

The number of 
aggregation 
buckets in 
memory

The number 
of 
aggregation 
buckets is 
normal

The number 
of 
aggregation 
buckets is 
nearing the 
permissible 
limit

The number of 
aggregation 
buckets has 
exceeded the 
permissible 
limit

Statistics Total 
Messages 
Ignored

The number of 
entities 
filtered out by 
the statistics 
manager

Always N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Samples to 
BAC server

Connection to 
BAC server

Status of the 
connection 
between the 
HP Real User 
Monitor 
engine and 
the 
HP Business 
Availability 
Center 
Gateway 
Server for 
publishing 
samples

HP Real 
User 
Monitor is 
successfully 
sending 
samples to 
HP Business 
Availability 
Center

N/A HP Real User 
Monitor has 
failed in 
sending data 
to HP Business 
Availability 
Center

Publisher burst 
state

Indication if 
any samples 
were delayed 
during the last 
attempt to 
publish data 
to HP Business 
Availability 
Center 

All HP Real 
User 
Monitor 
samples are 
being sent 
to 
HP Business 
Availability 
Center. No 
samples are 
delayed

N/A HP Real User 
Monitor is 
delaying 
samples so as 
not to 
overload 
HP Business 
Availability 
Center

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Samples to 
BAC server

Publisher 
Samples 
Created for 
<entity>

The number of 
<entity> 
samples 
created since 
the last Real 
User Monitor 
engine restart

N/A N/A N/A

Publisher 
Samples 
Thrown

The total 
number of 
samples 
thrown

Always N/A N/A

Publisher Total 
Samples 
Created

The total 
number of 
samples 
created (for all 
<entities>) 
since the last 
Real User 
Monitor 
engine restart

N/A N/A N/A

Publisher Total 
Samples Sent

The total 
number of 
samples sent 
from the 
Publisher 
module of the 
Real User 
Monitor 
engine to 
HP Business 
Availability 
Center since 
the last Real 
User Monitor 
engine restart

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Aggregation 
Manager

To Access: 
Click 
Aggregation 
Manager in 
RUM Engine 
monitors

Average
Duration for 
aggregation

The average 
execution 
time for each 
task

N/A N/A N/A

AvgAffected
Rows for 
aggregation

The average 
number of 
affected rows 
for 
aggregations 
done since the 
last Real User 
Monitor 
engine restart

N/A N/A N/A

LastDuration 
for aggregation

The last 
execution 
time for each 
task

N/A N/A N/A

MaxAffected
Rows for 
aggregation

The maximum 
number of 
affected rows 
for 
aggregations 
done since the 
last Real User 
Monitor 
engine restart

N/A N/A N/A

MaxDuration 
for aggregation

The maximum 
execution 
time for each 
task

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Data Access 
Layer

To Access: 
Click Data 
Access Layer 
in RUM 
Engine 
monitors

Average 
response time 
for <entity>

The amount of 
time taken to 
write the 
<entity> 
objects to the 
database

Response 
time of 
database is 
normal

Response 
time of 
database is 
high, which 
might 
indicate a 
database 
problem

Response time 
of database is 
very high, 
which might 
indicate a 
database 
problem

DAL Active Whether the 
Data Access 
Layer is active 
or not. In 
some 
instances, 
when free disk 
space on the 
database 
server is 
running low, 
the Data 
Access Layer 
stops sending 
data to the 
database.

The Data 
Access Layer 
is active

N/AS The Data 
Access Layer is 
not active

Number of 
cache misses 
in <entity> 
lookup table 
cache

The number of 
queries to the 
<entity>’s 
cache for 
which data 
was not 
available, but 
should have 
been

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Data Access 
Layer

To Access: 
Click Data 
Access Layer 
in RUM 
Engine 
monitors

Number of 
files in 
<entity> cache

The size of the 
cache for each 
<entity> type

There is no 
backlog

A backlog of 
objects to be 
sent to the 
database 
exists, 
which could 
indicate a 
database 
problem or 
a temporary 
load peak

A large backlog 
of objects to be 
sent to the 
database 
exists, which 
could indicate 
a database 
problem or a 
temporary 
load peak

Number of 
futile queries 
to <entity> 
lookup table 
cache

The number of 
queries to the 
<entity>’s 
cache for 
which data 
was not 
available

N/A N/A N/A

Number of 
<entity> 
objects sent

The number of 
<entity> 
objects sent to 
the database 
since startup

N/A N/A N/A

Number of 
queries to 
<entity> 
lookup table 
cache

The total 
number of 
queries to the 
<entity>’s 
cache

N/A N/A N/A

Size of 
<entity> 
lookup table 
cache

The size of the 
<entity> 
lookup table 
in the 
memory cache

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Partition 
Manager

To Access: 
Click 
Partition 
Manager in 
RUM Engine 
monitors

Average Task 
Execution 
Time

The average 
execution 
time of the 
scheduled task

Partition 
Manager 
average 
performanc
e is normal

Partition 
Manager 
average task 
performanc
e has 
exceeded 
the warning 
threshold

Partition 
Manager 
average 
performance 
has exceeded 
the error 
threshold and 
might cause 
locks in the 
database 
during 
execution

Last Task 
Execution 
Status

The status of 
the last 
executed task

Partition 
Manager is 
running 
normally

N/A Partition 
Manager task 
failed during 
last execution 

Max Task 
Execution 
Time

The maximum 
execution 
time of the 
scheduled task

Partition 
Manager 
task 
performanc
e is normal

Partition 
Manager 
task 
performanc
e has 
exceeded 
the warning 
threshold

Partition 
Manager task 
performance 
has exceeded 
the error 
threshold and 
might cause 
locks in the 
database 
during 
execution

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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Capture Log Files

You use this option to create a .ZIP file of the current status of the HP Real 
User Monitor for support purposes.

Click Capture and specify the name and location of the file.

HP Real User Monitor Configuration and Settings
The Configuration drop-down menu on the HP Real User Monitor Engine 
Web console menu bar includes the following options:

➤ BAC Connection Settings on page 120. Used to view and configure the 
connection parameters between HP Real User Monitor and HP Business 
Availability Center.

➤ Probe Management on page 122. Used to configure communication 
settings with the HP Real User Monitor probe.

➤ Set Engine IP on page 131. Used to set the IP address of the HP Real User 
Monitor engine machine.

➤ Advanced Settings on page 131. Provides links to specific areas of the 
HP Real User Monitor JMX console for configuring parameters and settings 
for individual HP Real User Monitor modules.

Missing 
Mirrored 
Data

To Access: 
Click Missing 
Mirrored 
Data in RUM 
Probe 
monitors

<Application> 
Lost Requests

The number of 
lost requests to 
Web servers 
per monitored 
application

N/A N/A N/A

<Application> 
Lost Responses

The number of 
lost responses 
from Web 
servers per 
monitored 
application

N/A N/A N/A

Component Entity Description OK Status 
(Green)

Minor 
Status 
(Yellow)

Critical Status 
(Red)
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➤ System Info on page 132. Provides general system information about the 
HP Real User Monitor.

BAC Connection Settings

This page displays the current connection settings for the communication 
channel between HP Real User Monitor and HP Business Availability Center, 
which you can update. The page contains the following panes:

➤ “General” on page 120

➤ “Authentication” on page 120

➤ “Proxy” on page 121

➤ “SSL” on page 121

General

The General pane includes a field that contains the hostname of the 
HP Business Availability Center Gateway Server, a field for the port number 
used in communicating with the Gateway Server (80 by default), and a field 
for the communication protocol used (HTTP by default, or HTTPS if SSL is 
used for communicating with the Gateway Server).

Note: If you are an HP Software-as-a-Service user, contact an HP Software 
Support representative to receive the hostname or URL to enter.

Authentication

To instruct HP Real User Monitor to use basic authentication in 
communicating with HP Business Availability Center, select the Use 
authentication check box. Enter the user name, password, and domain 
name of a user recognized by the Gateway Server in the relevant fields.

For more information on using basic authentication in HP Business 
Availability Center, see “Using Basic Authentication in HP Business 
Availability Center”in the HP Business Availability Center Hardening Guide 
PDF.
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Proxy

To instruct HP Real User Monitor to access the Gateway Server through a 
reverse proxy server, select the Use proxy check box. Enter the user name, 
password, domain name, and URL for the reverse proxy server. For 
information on using a reverse proxy server with HP Business Availability 
Center, see “Using a Reverse Proxy in HP Business Availability Center” in 
the HP Business Availability Center Hardening Guide PDF.

SSL

If HP Real User Monitor has been configured to use the SSL channel in 
communicating with the Gateway Server, you configure the following 
parameters in this pane:

➤ Keystore path. The path to the Keystore file, which is a file on the HP Real 
User Monitor engine machine that contains the private key and client-side 
certificate used for client authentication in SSL

➤ Private Key password. The password used for accessing the Private Key file

➤ Keystore password. The password used for accessing the Keystore file

In addition, you can select the following options by checking the box to the 
left of the required option:

➤ Validate host names on server certificates

➤ Validate that the server certificates are trusted

➤ Validate that the server certificates are not expired

For information on configuring the HP Real User Monitor and HP Business 
Availability Center to work with SSL, see “Using SSL in HP Business 
Availability Center” in the HP Business Availability Center Hardening Guide 
PDF.

Note: If you change the configuration, click the Save Configuration button 
to save the configuration and update the HP Real User Monitor engine.
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Probe Management

The Probe Management page displays a list of the HP Real User Monitor 
probes that are connected to the engine, and also allows you to set probe 
configuration parameters for the following:

➤ “SSL Keystore Management” on page 123

➤ “Interface Configurations” on page 125

➤ “Server Filters” on page 127

➤ “SSH Console” on page 129

➤ “Probe Traffic Capture” on page 130

When the Probe Management page is accessed, the following information is 
displayed for each probe:

➤ Probe Name. The name of the HP Real User Monitor probe as configured in 
End User Management Administration. For information on configuring the 
probe in End User Management Administration, see “New/Edit Real User 
Monitor Engine Page” in Using End User Management.

➤ Probe IP. The IP address of the HP Real User Monitor probe as configured in 
End User Management Administration.

➤ Enabled. This value denotes whether the probe is enabled in End User 
Management Administration or not.

➤ Configurable. This value denotes whether the HP Real User Monitor engine 
can internally configure the HP Real User Monitor probe. If the probe is not 
configurable, the engine does not attempt to retrieve the probe’s version 
and the Probe Version field is empty. 

➤ Probe Version. The version of the HP Real User Monitor probe that is 
installed.

Note: If the HP Real User Monitor probe is either disabled or not 
configurable, the SSL Keystore Management, Interface Configurations, and 
Collector Editor pages are disabled.
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SSL Keystore Management

You use the SSL Keystore Management page to manage the keys used by 
HP Real User Monitor probes to monitor SSL encrypted traffic. To access the 
SSL Keystore Management page, click the SSL Keystore Management button 
on the Probe Management page. The Keystore Management page contains 
three panes – SSL Keystore Administration, SSL Application Decryption 
Statistics, and SSL Server Decryption Statistics. To refresh the information 
on this page, click the Refresh button.

Note: The Real User Monitor Web console keystore import tool supports 
PEM, DER, PKCS8, and PKCS12 private key types, as well as Java Keystore. 
Other key types can be imported if they are converted to one of the 
supported types.

➤ SSL Keystore Administration Pane

The SSL Keystore Administration pane displays a list of all the configured 
keys, and for each one shows the number of servers on which the key was 
used to decipher traffic.

To add a key:

 1 Click Add Key. A new page opens for adding a key to the probe.

 2 Enter a logical name for the key you are adding.

 3 Select the type of file from which to import the key you are adding (a key 
file or a keystore) and configure the applicable settings:

➤ Import from Key File:

➤ File. The path and name of the file containing the private key. You can 
click Browse to navigate to the relevant file.

➤ Password. The password (of up to 20 characters) with which the key is 
encrypted, or null if the key is not encrypted.
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➤ Import from Keystore:

➤ Keystore file. The path and name of the keystore file. You can click 
Browse to navigate to the relevant file.

➤ Keystore password. The keystore password, of up to 20 characters.

➤ Private key alias. The alias of the specific key in the keystore. If no alias 
is configured, the first key in the keystore is used.

➤ Private key password. The password of the specific key in the keystore.

 4 Click Submit to save the key and exit, or Cancel to exit without saving.

To delete a key:

 1 Select the check box to the left of the keys you want to delete.

 2 Click the Delete button at the bottom of the pane, or at the end of the row 
of the selected key.

Note: You can select all, clear all, or invert your selection using the Select 
buttons.

➤ SSL Application Decryption Statistics Pane

The SSL Application Decryption Statistics pane displays the following 
information for each application for which encrypted traffic was monitored:

➤ The percentage of successfully decrypted traffic.

➤ The percentage of unsuccessfully decrypted traffic for the application due 
to a failure in parsing, possibly due to packet loss. If you determine that 
packet loss is occurring, check your network settings and consider using a 
tap instead of port spanning for the Real User Monitor probe.

➤ The percentage of unsuccessfully decrypted traffic for the application due 
to an SSL handshake not being found. Possible causes are a non SSL 
connection, or the Real User Monitor probe being stopped/started during 
an SSL handshake.
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➤ The percentage of unsuccessfully decrypted traffic for the application due 
to an unsupported algorithm. The SSL handshake algorithm used 
unsupported, temporary private keys (such as DH, or RSA with Export 
restrictions on the key length). If you use an SSL accelerator, a possible 
solution is to move the Real User Monitor probe behind it.

➤ The percentage of unsuccessfully decrypted traffic for the application due 
to no suitable key being found for the decryption, possibly as a result of 
the Web server key being replaces. Check the keys and if necessary, 
obtain and configure a new key for use.

➤ The percentage of unsuccessfully decrypted traffic for the application due 
to any of the above errors in connections from the same user, when 
decryption failed in the first connection in the session.

➤ SSL Server Decryption Statistics Pane

The SSL Server Decryption Statistics pane displays the amount of encrypted 
traffic as a percentage of the entire traffic monitored from each server.

Interface Configurations

Use the Interfaces Configuration page to list and select a probe’s Ethernet 
devices used to monitor server traffic. To access the Interfaces Configuration 
page, click the Interfaces Configuration button on the Probe Management 
page. For each Ethernet device, the following information is displayed:

➤ Sniff. Check box to select the device to monitor server traffic.

➤ Name. The logical name of the Ethernet device.

➤ Up. Whether the device is running or not.

➤ Sniffable. Whether the device can be used to listen to Ethernet traffic.

➤ Hardware. The hardware details of the device.

➤ Driver. The name of the driver used for the device.

➤ IP. The IP address assigned to the device, if any.

Click Interface Details for a device to display link, driver, other settings, and 
statistics information.
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To select a device to be used by the probe for monitoring server traffic, use 
one of the following options:

➤ Select the Sniff check box to the left of the device you want to use.

➤ Select the Probe Auto Select check box to configure the HP Real User 
Monitor probe to listen to all available devices automatically.

Note: This differs from selecting all the devices manually, as the HP Real 
User Monitor probe only listens to available devices and not to all devices.

➤ Click Restore to Current to select the devices currently configured for 
monitoring.

➤ Click Recommended Selection to have the HP Real User Monitor engine 
select the devices it considers to be the most suitable to use.

When you have made your selection, click Save and Upload Configuration 
to save the configuration and send it to the HP Real User Monitor probe.

Note: You can select all, clear all, or invert your selection using the Select 
buttons.
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Server Filters

Note: Data Collection Settings has been renamed as Server Filters and as of 
Real User Monitor version 7.50, its functionality has been changed.

Use server filters only to manage probe clustering. That is, when two or 
more probes receive the same traffic and you want to assign different parts 
of the traffic for each probe to analyze.

For traffic filtering, configure application location settings in End User 
Management Administration. For details, see “New/Edit Web or SOAP 
Application Page” in Using End User Management.

If you have existing server filter settings that are used for regular server 
filtering, it is recommended to delete them and to configure application 
location settings in End User Management Administration instead.

The HP Real User Monitor probe filters the traffic that it monitors. By 
default, the filter is set to monitor all traffic from port 80. You can override 
the default filter by setting filters for specific IP addresses or ranges, and for 
specific ports.

You use the Server Filters page to list and configure the filters to be used for 
monitoring server traffic. To access the Server Filters page, click the Server 
Filters button on the Probe Management page. For each server range, the 
following information is displayed:

➤ Servers. The range or mask of servers to be monitored.

➤ Ports. The ports of the servers included in the range to be monitored.

➤ Clients. By default, a filter applies for all clients accessing the servers.

To display the current data server filters, click Reload Current Configuration 
at the bottom of the page.

You can add new filters, and delete or edit existing filters. After adding, 
deleting, or changing a filter, click Save and Upload Configuration to save 
the configuration and send it to the HP Real User Monitor probe.
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To add a new filter:

 1 Click New Definition. The Edit Server Filters page opens.

 2 In the Edit Server Filters page, enter the following:

➤ Servers. Select the type of server filter you are adding and enter the 
required data:

➤ Single IP. Enter a single IP address.

➤ IP Range. Enter the starting and ending IP addresses of the range.

➤ IP Mask. Enter the network address and applicable IP mask.

➤ Ports. Select the type of port filter you are adding and enter the required 
data:

➤ Single Port. Enter a single port number.

➤ Port Range. Enter the starting and ending port numbers of the range.

 3 Click Submit to save the filter and exit, or Cancel to exit without saving.

To delete a filter:

Click the Delete button in the row of the filter you want to delete.

To edit a filter:

 1 Click the Edit button in the row of the filter you want to edit. The Edit 
Server Filters page opens.

 2 In the Edit Server Filters page, edit the information displayed. See "To add a 
new filter" on page 128 for an explanation of the filter’s fields.

 3 Click Save to save the filter and exit, or Cancel to exit without saving.
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SSH Console

Note: This section applies to Linux installations of the Real User Monitor 
probe only.

You use SSH Console to connect to the HP Real User Monitor probe’s 
console using Secure Shell, which provides strong authentication and secure 
communications over insecure channels. To access SSH Console, click the 
SSH Console button on the Probe Management page.

The first time you access SSH Console, a wizard installs some required files 
on your machine. Accept the default settings, or change them as required. 
Each time you access SSH Console, accept the certificate displayed, and in 
the console window, enter the user and password for the HP Real User 
Monitor probe, as configured in End User Management Administration. You 
are now connected to the HP Real User Monitor probe’s console. (For 
information on configuring the probe in End User Management 
Administration, see “New/Edit Real User Monitor Engine Page” in Using End 
User Management.)

In the HP Real User Monitor probe console, you use regular Linux 
commands on the command line. There is also a menu providing assorted 
utilities for working in SSH Console. To access the menu, right-click the 
mouse while holding down the CTRL key. One of the utilities is a convenient 
graphical user interface for SFTP, which you use to transfer files to and from 
the HP Real User Monitor probe machine via secured FTP. To access the SFTP 
tool from the menu, select Plugins > SFTP File Transfer.
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Probe Traffic Capture

Note: This section applies to Linux installations of the Real User Monitor 
probe only.

You use the Probe Traffic Capture feature to instruct a Real User Monitor 
probe to save the traffic it monitors to a file. This is useful for analysis and 
troubleshooting. To configure and start probe traffic capturing, click the 
Probe Traffic Capture button on the Probe Management page. The Probe 
Traffic Capture page opens.

To configure and start capturing:

 1 Enter the maximum file size in megabytes. Capturing is automatically 
stopped once the configured file size is reached. You can configure a file size 
of up to 100 MB.

 2 Enter the maximum time (in seconds) for capturing to run. Capturing is 
automatically stopped once the configured time has passed. You can 
configure a time of up to 3600 seconds.

Note: Capturing is automatically stopped when either the configured file 
size or the configured time is reached.

 3 If you want to capture traffic for a specific range of clients, select the Use 
client IP filter check box and enter the required IP range.

 4 The default location and name of the capture file is displayed. You cannot 
change this data.

 5 Click the Start Capture button to start the probe traffic capture. The 
following information is displayed and is automatically refreshed every 10 
seconds (you can click the Refresh button to refresh the data manually):

➤ Time left. The amount of remaining time that capturing will run.

➤ Current file size. The current size of the capture file.
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➤ Capture file location and name.

To stop probe traffic capture when it is running, click the Stop Capture 
button.

Set Engine IP

The first time that the HP Real User Monitor engine is started, it saves the IP 
address of the machine on which it is running. This option allows you to 
change the stored IP address in the event that the machine’s actual IP 
address has changed (for example, if it connected to a different network and 
was allocated a different IP address). The stored IP address is displayed, 
followed by a list of all the current IP addresses of the network cards 
installed in the HP Real User Monitor engine machine. You can select on of 
the IP addresses from the list, or enter a different address of your choice in 
the Other field. Click Submit to accept the change.

Advanced Settings

This option displays HP Real User Monitor modules and provides direct 
links to specific pages in the HP Real User Monitor JMX console for viewing 
and configuring the module settings. Each module listed can have any of 
the following links associated with it:

➤ Main Module Page. Links to general settings for the module name and 
status.

➤ Configuration Page. Links to settings for the configuration of the HP Real 
User Monitor module retrieved from HP Business Availability Center.

➤ Settings Page. Links to settings for the configuration of the HP Real User 
Monitor module in the HP Real User Monitor engine.

For details on working with the JMX console, see “Using the HP Real User 
Monitor JMX Console” on page 162.
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System Info

This option shows general system information about the HP Real User 
Monitor, which is displayed in the following panes:

➤ Real User Monitor Server - General. Includes the host name, host IP address, 
total memory, and the number of available processors for the HP Real User 
Monitor server.

➤ Real User Monitor Server - OS. Includes the name and version of the 
operating system of the HP Real User Monitor server.

➤ Real User Monitor Database - General. Includes the host name and port 
number of the HP Real User Monitor database, as well as the name of the 
database schema.

HP Real User Monitor Diagnostic Tools
The Tools drop-down menu on the HP Real User Monitor Engine Web 
console menu bar includes the following tools:

➤ Traffic Discovery on page 133. Used to enable the HP Real User Monitor 
probe to automatically discover the servers and domains being accessed by 
the traffic to which it is listening.

➤ Session ID Detection on page 138. Used to automatically discover 
application session IDs in monitored traffic. Helps to configure applications 
in End User Management Administration. (For information on configuring 
applications in End User Management Administration, see “New/Edit Web 
or SOAP Application Page” in Using End User Management.)

➤ Monitoring Configuration Information on page 142. Displays general 
configuration data of the applications, end users, pages, probes, 
transactions, and engine that have been configured for monitoring by 
HP Real User Monitor in End User Management Administration.
132



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
➤ JMX Console on page 151. Provides a link to the HP Real User Monitor JMX 
console for configuring HP Real User Monitor parameters, such as URL 
correlation parameters. (For details on URL correlation, see “Correlating 
Collected Data with Configured Pages” in Using End User Management.)

➤ IP Translator on page 151. Used to convert the internal number used by the 
engine to represent an IP address, to the actual IP address it represents, and 
vice versa.

➤ Time Converter on page 151. Used to convert a date and time to an internal 
number used by the engine machine to represent this value. You can also 
convert the number used by the engine machine to the date and time it 
represents.

➤ Current Captured Sessions on page 152. Displays the Open Sessions report 
that can be used by advanced users to study open session raw data.

➤ Page Name Cache on page 159. Used to manage the Page Name cache of 
meaningful page names and to delete such names that are no longer 
relevant.

➤ Page Statistics on page 161. Displays page and server time statistics for the 
pages you have configured in End User Management Administration, as well 
as for pages to which HP Real User Monitor has assigned a meaningful 
name.

Traffic Discovery

You use the Traffic Discovery tool to instruct the HP Real User Monitor 
probe to automatically detect and report the domains and servers that are 
accessed by the traffic to which it is listening. You can use the information 
obtained from the Traffic Discovery tool to help you configure servers and 
applications to be monitored by HP Real User Monitor, in End User 
Management Administration. For information on configuring HP Real User 
Monitor in End User Management Administration, see “Real User Monitor 
Administration User Interface” in Using End User Management.
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When the Traffic Discovery option is selected from the Tools menu, the 
Traffic Discovery page opens. On the Traffic Discovery page, the following 
information is displayed for each HP Real User Monitor probe that is 
connected to the HP Real User Monitor engine:

➤ Probe Name. The name of the HP Real User Monitor probe as configured in 
End User Management Administration. For information on configuring the 
probe in End User Management Administration, see “New/Edit Real User 
Monitor Engine Page” in Using End User Management.

➤ Probe IP. The IP address of the HP Real User Monitor probe as configured in 
End User Management Administration.

➤ Enabled. This value denotes whether the probe is enabled in End User 
Management Administration or not.

➤ Configurable. This value denotes whether the HP Real User Monitor engine 
can internally configure the HP Real User Monitor probe. 

➤ Start Time. The time that Traffic Discovery was started for the probe.

➤ Start Discovery. Click the Start Discovery button to start Traffic Discovery 
for the probe.

➤ Stop Discovery. Click the Stop Discovery button to stop Traffic Discovery for 
the probe.

➤ View Current Results. Click View Current Results to view the current Traffic 
Discovery results for the probe. The button is enabled only when Traffic 
Discovery has been started and is running.

➤ View Saved Results. Click View Saved Results to view previously saved 
Traffic Discovery results for the probe. The button is enabled only if there 
are saved results to display.

You can refresh the data displayed on the Traffic Discovery page by clicking 
the Refresh button at the bottom of the page.
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Note: 

➤ The Start Discovery and Stop Discovery buttons are not enabled 
simultaneously. When one is enabled, the other is disabled.

➤ When an HP Real User Monitor probe runs in Traffic Discovery mode, it 
is dedicated to Traffic Discovery and does not collect regular data for 
reporting to the HP Real User Monitor engine and HP Business 
Availability Center.

Viewing Traffic Discovery Results

To view Traffic Discovery results, click View Current Results or View Saved 
Results for the relevant HP Real User Monitor probe. The Traffic Discovery 
Statistics page opens. Traffic Discovery statistics are displayed in the 
following tabs:

➤ Summary View. Displays a pie chart in which each slice represents a 
different, discovered protocol and the slice size is determined by the 
percentage of the total protocol traffic out of the total traffic for all the 
protocols. Click the slice representing the HTTP protocol to display the 
Domain view. Click on any other slice to display the Server view.

➤ Domain View. For each discovered protocol, the statistics are grouped by 
domain names or IP addresses. For each port in the domain, the IP address 
of each server that connected to the domain is listed, further grouped by the 
port through which they connected to the domain.

➤ Server View. For each discovered protocol, the statistics are grouped by 
server IP addresses. For each server, the IP addresses of all the domains to 
which the server connected are listed, further grouped by the port through 
which the domain connected to the server.
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Filters at the top of the page enable you to filter the data displayed by:

➤ filtering the data by the type of servers to be displayed. Select Servers on 
Private IPs, Servers on Non Private IPs, or both from the drop-down list in 
the Server Type filter.

➤ searching for domains and servers that match a specific pattern or IP 
address. Enter the search pattern in the Search filter located at the top left of 
the page, and click Search Domain or Search Filter.

Note: 

➤ When using the search feature in the Domain View tab, you can enter 
alpha-numeric characters, the asterisk (*) wild card character, and use 
partial strings for matching. The search filters domain names that 
include the search string.

➤ In the Server View tab, you can only enter valid IP addresses in the 
search field. The search filters server IP addresses that exactly match the 
search string.

The data is redisplayed according to the records matching the search criteria.

In the Domain and Server tabs, the following information is displayed for 
all the domains or servers included in the page:

➤ Peak Total Traffic. The peak number of megabytes transmitted to and from 
all the domains or servers included in the page, for all the discovered 
protocols.

➤ Peak Pages/sec. The peak number of pages per second for all the domains or 
servers included in the page, for all the discovered protocols.

➤ Sampled from. The date and time that the displayed statistics were retrieved 
are displayed. From this, you can determine whether the statistics are 
current, or whether they were loaded from a saved file.
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For each domain or server in the page, the following information is 
displayed:

➤ % Avg. Traffic. The percentage of average traffic for a specific protocol out of 
the average traffic for all protocols.

➤ Avg. Traffic (Mb/s). The average number of megabytes transmitted to and 
from the domain or server, for a specific protocol.

➤ % Peak Traffic. The percentage of peak traffic for a specific protocol out of 
the peak traffic for all protocols.

➤ Peak Traffic (Mb/s). The peak number of megabytes transmitted to and from 
the domain or server, for a specific protocol.

➤ Peak Pages/sec. The peak number of pages per second for the domain or 
server, for a specific protocol.

➤ Compressed. Ticked if any of the traffic sent and received by the domain or 
server was compressed.

➤ Encrypted. Ticked if any of the traffic sent and received by the domain or 
server was compressed.

➤ Server Info. The name of the server, if available.

➤ More Details. Reserved for future use.

If the statistics data is displayed on more than one page, you can move to 
different pages using the page buttons located at the upper left part of the 
screen.

At the top right of the Auto Discovery Statistics page, are buttons that you 
click to:

➤ Refresh the display with the most up to date statistics.

➤ Save the current statistics to a file on the HP Real User Monitor probe 
machine.

Note: Only one file can be saved per probe. Saving statistics data to a file, 
overwrites any previously saved data.
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➤ Reset the current statistics data. Resetting data initializes Traffic Discovery 
statistics.

You can start and stop Traffic Discovery by clicking Start Discovery and Stop 
Discovery at the bottom of the Traffic Discovery page. When you click Stop 
Discovery, you are prompted to save the current results.

Session ID Detection

Use the Session ID Detection tool instruct the HP Real User Monitor probe 
to detect Session IDs in the traffic it monitors, for applications configured in 
End User Management Administration. For information on configuring 
applications in End User Management Administration, see “New/Edit Web 
or SOAP Application Page” in Using End User Management.

To configure applications in End User Management Administration, you use 
the Traffic Discovery and Session ID Detection tools in the following 
sequence:

 1 Run the Traffic Discovery tool to identify applications on monitored servers.

 2 Configure the discovered applications in End User Management 
Administration, without session ID parameters.

 3 Run the Session ID Detection tool to identify the relevant session IDs for the 
applications.

 4 Configure the session ID parameters for the applications in End User 
Management Administration.

When the Session ID Detection option is selected from the Tools menu, the 
Session ID Detection page opens. On the Session ID Detection page, the 
following information is displayed for each configurable and enabled 
HP Real User Monitor probe that is connected to the HP Real User Monitor 
engine:

➤ Probe IP. The IP address of the HP Real User Monitor probe as configured in 
End User Management Administration. For information on configuring the 
probe in End User Management Administration, see “New/Edit Real User 
Monitor Engine Page” in Using End User Management.

➤ Last Completed Collection Time. The last time that the Session ID Detection 
tool finished collecting data for session ID analysis.
138



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
➤ Remaining Collection Time. Shows the amount of remaining time for 
collecting data for session ID analysis.

Refresh the data displayed on the Session ID Detection page by clicking the 
Refresh button at the top right of the page.

For each HP Real User Monitor probe listed, there are buttons that enable 
you to do one of the following:

➤ Start data collection. 

➤ Stop data collection. 

➤ Abort the data collection process. 

When you start data collection, a dialog box opens in which you specify the 
amount of time for data collection to run, and whether you want to collect 
raw data for a specific end-user IP address, in addition to the data collected 
for all end-user IP addresses.

The View Report link displays the Session ID Detection report for the probe. 
The link is only enabled once the data collection process has been run and 
has completed.

Note: You can only run the data collection process for one HP Real User 
Monitor probe at a time.

Session ID Detection Report

For each application configured for the probe in End User Management 
Administration, the Session ID Analysis report shows the following 
information:

➤ Application Name. The application name, as defined in End User 
Management Administration. For applications not been defined in End User 
Management Administration, the application name is Default Website. For 
information on configuring applications in End User Management 
Administration, see “New/Edit Web or SOAP Application Page” in Using End 
User Management.

➤ Application Components. The total number of hits in the application.
139



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
➤ Application Pages. The total number of pages in the application.

➤ Application Clients. The total number of clients that accessed the 
application.

➤ Application Connections. The total number of connections to the 
application.

➤ All Session IDs Coverage. The percentage of hits in the application that 
contain a discovered session ID key.

➤ Session ID Key. The session ID key name of the session ID discovered for the 
application.

➤ Type. Where the session ID key is located – cookie, query, or cookie and 
query.

➤ Regular Expression. The regular expression that uniquely defines the session 
ID key. The same regular expression should be used in the Scan for field in 
session identification advanced criteria, when configuring an application in 
End User Management Administration. For information on configuring 
applications in End User Management Administration, see “New/Edit Web 
or SOAP Application Page” in Using End User Management.

➤ Specific Session ID Coverage. The percentage of traffic collected for the 
application by the data collection process, containing the specific session ID 
key.

➤ Specific Session ID Correctness. The probability that HP Real User Monitor 
gives the located key of being a real session ID key.

You can display data for a specific application only, display detailed 
information for a specific session ID key, and view raw data for a single 
end-user IP address.

To display data for a specific application only:

Select the application in the Filter By Application Name filter, located at the 
top-left of the report.
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To display detailed information for a specific session ID key:

Click a specific key in the Session ID Key column. The Session ID Detection 
Detailed report is displayed, and shows the following information for the 
session ID key:

➤ Session ID Properties:

➤ Application Name. The application name, as defined in End User 
Management Administration.

➤ Session ID Key. The session ID key name.

➤ Type. Where the session ID key is located – cookie, query, or cookie and 
query.

➤ Regular Expression. The regular expression that uniquely defines the 
session ID key. The same regular expression should be used in the Scan 
for field in session identification advanced criteria, when configuring an 
application in End User Management Administration.

➤ Object Retrieve Phrase. The phrase representing the specific objects to be 
retrieved from the regular expression. The same phrase should be used in 
the retrieve field in session identification advanced criteria, when 
configuring an application in End User Management Administration.

➤ Specific Session ID Coverage. The percentage of traffic collected for the 
application by the data collection process, containing the specific session 
ID key.

➤ Specific Session ID Correctness. The probability that HP Real User 
Monitor gives the located key of being a real session ID key.

➤ First Page Number. The page in which the session ID first appeared.

Note: The first page number is shown only if you chose to collect raw 
data for a specific end-user IP address when starting session ID capturing.

➤ Examples. Displays a few examples of the session ID key and the value 
located in the key.

➤ Set Cookie Params. If the session ID key is located in a cookie, or in a cookie 
and query, the path and domain, which are optional parameters sent from 
the server when setting a cookie for the client, are displayed.
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➤ Reasons For Not Locating Session ID Keys in Collected Data. Displays the 
percentage of traffic collected by the data collection process, not containing 
the specific session ID key, and for which a reason can be given.

➤ Reasons For Incomplete Session ID Correctness. The reasons why HP Real 
User Monitor gives the located key a probability of less than 100 percent of 
being a real session ID key.

To display raw data for a single end-user IP address:

Note: The View Raw Data button is only enabled if raw data was collected 
for a single end-user IP address.

Click View Raw Data. The Session ID Detection Raw Data report is 
displayed, and shows the following information for the end-user IP address:

➤ #. A sequential number indicating the row number in the report.

➤ URI. The URI of the page or component.

➤ Page/Component. Indicates whether the data displayed in the row refers to 
a page or a component.

➤ Referrer. For a page, the referrer is the calling page; for a component, the 
referrer is the page in which the component is included.

➤ Client Port. The port number of the client’s machine on which the data was 
collected.

➤ Set Cookie. The cookie sent from the server to the client, containing the 
session ID key.

➤ Cookies. The content of the cookie included in the URL POST parameters.

➤ Query. The content of the query.

Monitoring Configuration Information

The Engine Configuration page displays general configuration data of the 
applications, end-users, events, pages, probes, transactions, and engine that 
have been configured for monitoring by HP Real User Monitor in End User 
Management Administration.
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At the top of the Engine Configuration page is the Sync All Configuration 
button, which you click to force the HP Real User Monitor engine to reload 
the HP Real User Monitor configuration from HP Business Availability 
Center.

You display the data type you wish to see by selecting it from the drop-down 
menu located at the top left corner of the page and clicking Generate.

Applications

When you select applications as the data type to be displayed, the following 
information about the configured applications is displayed:

You can filter the data displayed on the Name column. The filter is case 
sensitive.

For information on configuring applications for monitoring, see “New/Edit 
Web or SOAP Application Page” and “New/Edit TCP Application Page” in 
Using End User Management.

Column Description

ID An internal ID number allocated by HP Business 
Availability Center.

Is Application enabled True or False – as configured in End User 
Management Administration.

Name The name of the application as configured in End 
User Management Administration.

Type The application type as configured in End User 
Management Administration.

Probes which monitor the 
application

The IP addresses and names of the probes 
configured in End User Management 
Administration to monitor the application.
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End Users

When you select end users as the data type to be displayed, the following 
information about the configured end users is displayed:

You can filter the data displayed on the Name column. The filter is case 
sensitive.

For information on configuring end-user groups for monitoring, see 
“New/Edit End-User Group Page” in Using End User Management.

Events

When you select events as the data type to be displayed, the following 
information about the configured events is displayed:

Column Description

ID An internal ID number allocated by HP Business 
Availability Center.

Is End User enabled True or False – as configured in End User 
Management Administration.

Name The name of the end-user group as configured in 
End User Management Administration.

Description The description of the end-user group as configured 
in End User Management Administration.

Is Monitored (for 
collection)

True or False – use host name resolution as 
configured in End User Management 
Administration.

Column Description

ID An internal ID number allocated by HP Business 
Availability Center.

Is Event enabled True or False – as configured in End User 
Management Administration.

Name The name of the event as configured in End User 
Management Administration.
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You can filter the data displayed on the Name column. The filter is case 
sensitive.

For information on configuring events for monitoring, see “Real User 
Monitor Administration User Interface” in Using End User Management.

Pages

When you select pages as the data type to be displayed, the following 
information about the configured pages is displayed:

Event type The event type as configured in End User 
Management Administration.

Report As Error True or False – as configured in End User 
Management Administration.

Create Snapshot True or False – as configured in End User 
Management Administration.

Collection Session 
Snapshot

True or False – as configured in End User 
Management Administration.

Column Description

Page ID An internal ID number allocated by HP Business 
Availability Center.

Is Page Enabled True or False – as configured in End User 
Management Administration.

Page Name The name of the page as configured in End User 
Management Administration.

Application The name of the application in which the page is 
included.

Description The description of the page as configured in End 
User Management Administration.

Column Description
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You can filter the data displayed on the Page Name column. The filter is 
case sensitive.

For information on configuring pages for monitoring, see “New/Edit Page” 
in Using End User Management.

Monitored Type The monitoring condition as configured in End 
User Management Administration. The possible 
conditions are:

1 = Always

2 = Never

3 = Only as part of a transaction

Page Type Currently not used

Page Time Threshold The page time threshold, in milliseconds, as 
configured for the page in End User Management 
Administration.

Server Time Threshold The server time threshold, in milliseconds, as 
configured for the page in End User Management 
Administration.

Availability Threshold The availability threshold, in percent, configured 
for the page in End User Management 
Administration.

Timeout The amount of time, in milliseconds, after which 
the page is considered to have timed out, as 
configured for the page in End User Management 
Administration.

Page URL The URL of the page as configured in End User 
Management Administration.

Column Description
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Probes

When you select probes as the data type to be displayed, the following 
information about the configured probes is displayed:

You can filter the data displayed on the Name column. The filter is case 
sensitive.

For information on configuring probes for monitoring, see “New/Edit Probe 
Page” in Using End User Management.

Transactions

When you select transactions as the data type to be displayed, the following 
information about the configured transactions is displayed:

Column Description

ID An internal ID number allocated by HP Business 
Availability Center.

Is probe enabled True or False – as configured in End User 
Management Administration.

IP The IP address of the probe as configured in End 
User Management Administration.

Login username The user name for logging in to the probe as 
configured in End User Management 
Administration.

Name The name of the probe as configured in End User 
Management Administration.

Description The description of the probe as configured in End 
User Management Administration.

Column Description

Trx ID An internal ID number allocated by HP Business 
Availability Center.

Is Trx Enabled True or False – as configured in End User 
Management Administration.
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Trx Name The name of the transaction as configured in End 
User Management Administration.

Application The name of the application in which the 
transaction is included.

Description The description of the transaction as configured in 
End User Management Administration.

Transaction report page The name of the page which, if reached, causes the 
transaction to be reported as unavailable, in the 
event of a transaction error or timeout within a 
session.

Refresh behavior The page instance that is measured in case of a 
refresh, as configured in End User Management 
Administration. The possible instances are:

0 = First page

1 = Last page

Timeout The amount of time, in milliseconds, of inactivity 
since the last page download in a transaction, that 
causes the transaction to time out, as configured for 
the transaction in End User Management 
Administration.

Gross Time Threshold The total transaction time threshold (download 
time + think time), in milliseconds, as configured 
for the transaction in End User Management 
Administration.

Net Time Threshold The net transaction time threshold, in milliseconds, 
for the pages included in the transaction, as 
configured in End User Management 
Administration.

Server Time Threshold The server time threshold, in milliseconds, as 
configured for the transaction in End User 
Management Administration.

Column Description
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You can filter the data displayed on the Trx Name column. The filter is case 
sensitive.

For information on configuring transactions for monitoring, see “New/Edit 
Transaction Page” in Using End User Management.

Engine Settings

When you select engine settings as the data type to be displayed, the 
following information about the configured engine is displayed:

Availability Threshold The availability threshold, in percent, as configured 
for the transaction in End User Management 
Administration.

Trx pages The names of the pages included in the transaction, 
as configured in End User Management 
Administration.

Column Description

Engine Name Name of the engine as configured in End User 
Management Administration.

Profile ID Internal HP Business Availability Center profile ID.

Profile Name Internal HP Business Availability Center profile 
name.

Engine ID Internal HP Business Availability Center engine ID.

Customer Name Always default client.

Snapshot on Error Enabled True or False – as configured in End User 
Management Administration.

Snapshot page number Number of pages for which to collect snapshot on 
error, as configured in End User Management 
Administration.

Column Description
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For information on configuring engine settings, see “New/Edit Real User 
Monitor Engine Page” in Using End User Management.

Transaction Snapshot Mode

When you select transaction snapshot mode as the data type to be 
displayed, the following information about the transaction snapshot mode 
is displayed:

For information on configuring transaction snapshot settings, see “Snapshot 
Settings” in Using End User Management.

Is monitoring default 
application

The applications that are monitored by the engine, 
as configured in End User Management 
Administration.

0 = configured applications only

1 = all applications

Default Application Name Name of default application (for all applications not 
configured in End User Management 
Administration).

Default HTTP Port Default HTTP port of engine machine.

Default HTTPS Port Default HTTPS port of engine machine.

Default Application ID Internal HP Business Availability Center application 
ID.

Column Description

Name The application name.

ID Internal HP Business Availability Center application 
ID.

Snapshot mode on True or False – as configured in End User 
Management Administration.

Column Description
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JMX Console

This option provides a link to the HP Real User Monitor JMX console, which 
you use to view and configure HP Real User Monitor parameters, for 
example, URL correlation parameters. For details on configuring URL 
correlation parameters, see “Correlating Collected Data with Configured 
Pages” in Using End User Management. For details on working with the JMX 
console, see “Using the HP Real User Monitor JMX Console” on page 162.

IP Translator

You use the IP Translator tool to convert an IP address into different formats. 
The formats to which the IP data is translated are:

➤ Host name. The name of the machine to which the IP address is assigned.

➤ Signed integer. An internal, signed number used in HP Real User Monitor 
data samples.

➤ Unsigned integer. An internal, unsigned number used in HP Real User 
Monitor data samples.

➤ Dotted-format IP address. The standard, dotted-decimal notation for the IP 
address.

You select one of the formats and enter the source data you want to convert 
to the other formats, or you select the Resolve Engine host option to use the 
IP address of the current HP Real User Monitor engine machine as the source 
data.

Click Submit to translate the source data to all the other formats.

Time Converter

You use the Time Converter tool to convert a time into different formats. 
The formats to which the time is converted are:

➤ the number of milliseconds since January 1, 1970 – an internal number used 
by the HP Real User Monitor engine.

➤ time in Greenwich Mean Time.

➤ time in the time zone set for the HP Real User Monitor engine machine.
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You select one of the formats and enter the source data you want to convert 
to the other formats, or you select the Current time option to use the 
current time as the source data for conversion.

Click Submit to convert the source data to all the other formats.

Current Captured Sessions

The Current Captured Sessions option displays the Current Captured 
Sessions report that includes raw data of the open sessions that are still 
stored in the HP Real User Monitor database. This report is useful when 
troubleshooting problems of session definitions in applications, and can 
help you understand why configured applications might not be reported as 
defined.

The Current Captured Sessions report comprises three main panes, as well as 
a line that indicates whether all selected sessions are currently being 
displayed, or which individual session is currently being displayed. Click a 
link in this indicator line to redisplay the relevant information (for example, 
if an individual session is currently displayed, click Current Captured 
Sessions to redisplay all the sessions that were originally selected for the 
report).

The main panes in the Current Captured Sessions report are:

➤ Current Captured Sessions. Used to filter the data displayed.

➤ Summary. Shows a summary line of information of all the data displayed in 
the Breakdown pane.

➤ Sessions. Shows information for individual items that are selected according 
to the filter settings.

Current Captured Sessions (filter) Pane

In the filter pane, you can set a filter for selecting the open sessions 
displayed according to the following criteria:

➤ End User IP. The IP address of an end user.

➤ User Name. The login name of an end user. You can also enter part of a 
name and HP Real User Monitor searches for all records with login names 
that include the entered text.
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➤ Probe GUID. A unique identifier number allocated to each new session by 
the HP Real User Monitor probe.

➤ By Time. For details on specifying a time range, see “Time Range and 
Granularity Bar” in Reports.

When you have set the filter, click Generate to generate the report.

Summary Pane

The Summary pane displays one line of summary information for all the 
lines displayed in the Breakdown pane. When viewing all physical sessions, 
the summary is of all the sessions selected by the filters and when viewing a 
specific physical session, the summary is of all the application sessions 
within the physical session. The summary line includes the following fields:

➤ Total Sessions. The total number of application sessions, as configured in 
End User Management Administration, that were included in all the HP Real 
User Monitor probe sessions displayed in the Breakdown pane. (For details 
on configuring sessions for applications, see “New/Edit Web or SOAP 
Application Page” in Using End User Management.) 

➤ Total Bytes. The total size (in bytes) of all the sessions displayed in the 
Breakdown pane.

➤ Total Hits. The total number of page hits for all the sessions displayed in the 
Breakdown pane.

➤ Available Pages Time. The average time (in seconds) for which pages were 
available in all the sessions displayed in the Breakdown pane.

➤ Unavailable Pages Time. The average time (in seconds) for which pages were 
unavailable in all the sessions displayed in the Breakdown pane.

➤ HTTP Errors. The total number of HTTP errors that occurred in all the 
sessions displayed in the Breakdown pane.

➤ Application Errors. The total number of application events reported as 
errors, as configured in End User Management Administration, that 
occurred in all the sessions displayed in the Breakdown pane. (For details on 
configuring events for applications in End User Management 
Administration, see “Real User Monitor Administration User Interface” in 
Using End User Management.)
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➤ Info Events. The total number of application events, as configured in End 
User Management Administration, that occurred in all the sessions 
displayed in the Breakdown pane. (For details on configuring applications in 
End User Management Administration, see “Real User Monitor 
Administration User Interface” in Using End User Management.)

➤ Performance Events. The total number of times that a sample exceeded its 
threshold, as configured in End User Management Administration, in all the 
sessions displayed in the Breakdown pane. (For details on configuring 
thresholds in End User Management Administration, see “New/Edit Real 
User Monitor Engine Page” in Using End User Management.)

Sessions Pane

The Sessions pane displays individual data for each session selected. The 
data is displayed in two tabs – General and Advanced.

The General tab displays the following information for each session listed:

➤ Probe GUID. A unique identifier number allocated to the session by the 
HP Real User Monitor probe.

➤ Total Sessions. The total number of application sessions, as configured in 
End User Management Administration, that were included in the HP Real 
User Monitor probe session displayed. (For details on configuring sessions 
for applications in End User Management Administration, see “New/Edit 
Web or SOAP Application Page” in Using End User Management.) 

➤ User IP. The IP address of the user who initiated the session.

➤ User Name. The login name of the user who initiated the session.

➤ User Host. The name of the host machine on which the user initiated the 
session.

➤ Start Time. The time that the session was started.

➤ End Time. The time that the session ended.

➤ Total Bytes. The total size (in bytes) of the session.

➤ Total Hits. The total number of pages hit in the session.
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The Advanced tab displays the following information for each session listed:

➤ Probe GUID. A unique identifier number allocated to the session by the 
HP Real User Monitor probe.

➤ Total Sessions. The total number of application sessions, as configured in 
End User Management Administration, that were included in the HP Real 
User Monitor probe session displayed. (For details on configuring sessions 
for applications in End User Management Administration, see “New/Edit 
Web or SOAP Application Page” in Using End User Management.) 

➤ User IP. The IP address of the user who initiated the session.

➤ User Name. The login name of the user who initiated the session.

➤ Start Time. The time that the session was started.

➤ Last Hit Time. The time that the last page in the session was hit.

➤ Available Pages Time. The average time (in seconds) for which pages were 
available in the session.

➤ Unavailable Pages Time. The average time (in seconds) for which pages were 
unavailable in the session.

➤ HTTP Errors. The total number of HTTP errors that occurred in the session.

➤ Application Errors. The total number of application events reported as 
errors, as configured in End User Management Administration, that 
occurred in the session. (For details on configuring events for applications in 
End User Management Administration, see “Real User Monitor 
Administration User Interface” in Using End User Management.)

➤ Info Events. The total number of application events, as configured in End 
User Management Administration, that occurred in the session. (For details 
on configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.)

➤ Performance Events. The total number of times that a sample exceeded its 
threshold, as configured in End User Management Administration, in all the 
sessions displayed in the Breakdown pane. (For details on configuring 
thresholds in End User Management Administration, see “New/Edit Real 
User Monitor Engine Page” in Using End User Management.)

Within either tab, click an individual Probe GUID to display information for 
that session, in two tabs – General and Advanced.
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The General tab displays the following information

➤ Probe GUID. A unique identifier number allocated to the session by the 
HP Real User Monitor probe.

➤ App ID. The HP Real User Monitor internal ID number for the application 
configured in End User Management Administration. (For details on 
configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.)

➤ User IP. The IP address of the user who initiated the session.

➤ User Host. The name of the host machine on which the user initiated the 
session.

➤ User Name. The login name of the user who initiated the session.

➤ Start Time. The time that the session was started.

➤ End Time. The time that the session ended.

➤ Session ID. The HP Real User Monitor internal ID number for the 
application session configured in End User Management Administration. 
(For details on configuring sessions for applications in End User 
Management Administration, see “New/Edit Web or SOAP Application 
Page” in Using End User Management.)

➤ Probe IP. The IP address of the HP Real User Monitor probe that monitored 
the session.

➤ Protocol. The protocol used by the session (HTTP or HTTPS).

➤ User Legacy Name. The name of the end-user group, as configured in End 
User Management Administration, to which the user who initiated the 
session belongs, and the range of IP addressees included in the end-user 
group. (For details on configuring end-user groups in End User Management 
Administration, see “New/Edit End-User Group Page” in Using End User 
Management.)
156



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
The Advanced tab displays the following information

➤ Probe GUID. A unique identifier number allocated to the session by the 
HP Real User Monitor probe.

➤ App ID. The HP Real User Monitor internal ID number for the application 
configured in End User Management Administration. (For details on 
configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.)

➤ User IP. The IP address of the user who initiated the session.

➤ User Name. The login name of the user who initiated the session.

➤ Start Time. The time that the session was started.

➤ Last Hit Time. The time that the last page in the session was hit.

➤ Page Hits. The total number of pages hit in the session.

➤ Total Bytes. The total size (in bytes) of the session.

➤ Available Pages Time. The average time (in seconds) for which pages were 
available in the session.

➤ Unavailable Pages Time. The average time (in seconds) for which pages were 
unavailable in the session.

➤ HTTP Errors. The total number of HTTP errors that occurred in the session.

➤ Application Errors. The total number of application events reported as 
errors, as configured in End User Management Administration, that 
occurred in the session. (For details on configuring events for applications in 
End User Management Administration, see “Real User Monitor 
Administration User Interface” in Using End User Management.)

➤ Info Events. The total number of application events, as configured in End 
User Management Administration, that occurred in the session. (For details 
on configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.)

➤ Performance Events. The total number of times that a sample exceeded its 
threshold, as configured in End User Management Administration, in all the 
sessions displayed in the Breakdown pane. (For details on configuring 
thresholds in End User Management Administration, see “New/Edit Real 
User Monitor Engine Page” in Using End User Management.)
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When an individual session is displayed, click the Probe GUID to display the 
click-stream for the session (that is, the pages included in the session). The 
click-stream displays two panes of information. The first pane includes the 
details for the session as displayed in the General and Advanced tabs of the 
Sessions pane of the report, and the second pane comprises two tabs that 
display the following information for each page included in the session:

The General tab includes:

➤ Hit ID. The sequence number of the page in the session.

➤ URL. The URL of the page, including the GET/POST data. If a URL is too long 
to be displayed in full, it is partially displayed and includes three dots (...). 
Click the URL to open a window displaying the entire URL.

➤ Page Name (ID). The name of the page, as configured in End User 
Management Administration, and HP Real User Monitor’s internal ID 
number for the page. (For details on configuring pages for applications in 
End User Management Administration, see “New/Edit Page” in Using End 
User Management.)

➤ Application Name (ID). The name of the application, as configured in End 
User Management Administration, in which the page is included, and 
HP Real User Monitor’s internal ID number for the application. (For details 
on configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.)

➤ Timestamp. The date and time that the page was hit.

➤ Server Name. The name of the server on which the page was located.

➤ Server IP. The IP address of the server on which the page was located.

➤ Page Time. The total time (in milliseconds) that the page was active.

The Advanced tab includes:

➤ Hit ID. The sequence number of the page in the session.

➤ URL. The URL of the page, including the GET/POST data. If a URL is too long 
to be displayed in full, it is partially displayed and includes three dots (...). 
Click the URL to open a window displaying the entire URL.
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➤ Page Name (ID). The name of the page, as configured in End User 
Management Administration, and HP Real User Monitor’s internal ID 
number for the page. (For details on configuring pages for applications in 
End User Management Administration, see “New/Edit Page” in Using End 
User Management.)

➤ Timestamp. The date and time that the page was hit.

➤ Session ID. The HP Real User Monitor internal ID number for the 
application session configured in End User Management Administration. 
(For details on configuring sessions for applications in End User 
Management Administration, see “New/Edit Web or SOAP Application 
Page” in Using End User Management.)

➤ HTTP Method. The HTTP method used to access the page.

➤ # of Components. The number of components included in the page.

➤ Is Stopped. Whether the page was stopped.

➤ HTTP Response Code. The response code received for the page request.

➤ Client Port. The port number of the client machine that initiated the 
request.

➤ Page Time. The total time (in milliseconds) that the page was active.

Note: You can refresh the click-stream data displayed by clicking the Refresh 
button at the top, right hand side of the page.

Page Name Cache

You use the Page Name Cache tool to display applications and the 
meaningful page names that have been created for pages included in the 
application. You can delete meaningful page names that are no longer 
relevant (for example, if you have changed the meaningful page name rules 
for an application so that new and different meaningful page names are 
created) and thereby reduce the amount of data stored in the Real User 
Monitor database. For details on configuring meaningful names, see 
“Configuring Meaningful Page Names” on page 174.
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When you select the Page Name Cache tool, the Application Selection page 
opens, listing all the applications that you configured for the HP Real User 
Monitor engine in End User Management Administration. For information 
on configuring applications in End User Management Administration, see 
“New/Edit Web or SOAP Application Page” in Using End User Management.

For each application, you can perform the following actions:

➤ Click the Delete button to delete all the meaningful page names for the 
application.

➤ Click the Drilldown button to display the Application Cached Page Names 
page (for details, see below) on which you can see all the meaningful page 
names for the application and delete them selectively.

Note: The buttons are disabled for applications that do not have any 
meaningful page names assigned to them.

Application Cached Page Names Page

The Application Cached Page Names page lists all the meaningful page 
names that have been created for an application. To delete pages, select the 
check box next to the pages you want to delete and click the Delete button.

Note: You can select all page names, clear all page names, or invert your 
selection using the Select buttons.

Click the Back link at the top of the page to return to the Application 
Selection page.

From either the Application Selection page or the Application Cached Page 
Names page, click the Refresh button to redisplay the pages.
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Page Statistics

The Page Statistics option displays page and server time statistics for the 
pages that you have configured in End User Management Administration, as 
well as for the pages that have been assigned a meaningful name by HP Real 
User Monitor. For information on configuring pages for monitoring, see 
“New/Edit Page” in Using End User Management. For details on configuring 
meaningful names, see “Configuring Meaningful Page Names” on page 174.

The Page Statistics page includes the following filters at the top of the page, 
by which you can filter the data that is displayed:

➤ Time range. Select a custom view from the drop-down list in the View field, 
or set the start and end dates as required. For further details on selecting a 
time range, see “Common Report Elements” in Reports.

➤ Page Name. Enter a page name to select all pages that match the entered 
name. You can use the asterisk (*) wild card to represent any string of 
characters. If left blank, all the pages that you configured in End User 
Management Administration are displayed.

The data is displayed according to the records matching the filter criteria. 
For each page, the following information is displayed:

➤ Page Name. The page name you configured in End User Management 
Administration, or the meaningful name assigned to the page.

➤ Configured. Denotes whether or not the page is configured in Real User 
Monitor Administration. For details on configuring pages, see “New/Edit 
Page” in Using End User Management.

➤ Total Hits. The total number of requests that the page received.

➤ Average Page Time. The average amount of time, in seconds, it took for the 
page to download.

➤ Page Time Standard Deviation. The standard deviation of the page 
download time.

➤ Minimum Page Time. The minimum amount of time, in seconds, it took for 
the page to download.

➤ Maximum Page Time. The maximum amount of time, in seconds, it took for 
the page to download.
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➤ Average Server Time. The average amount of time, in seconds, that it took 
the server to process the requests for the page.

➤ Server Time Standard Deviation. The standard deviation of the server time.

➤ Minimum Server Time. The minimum amount of time, in seconds, that it 
took the server to process a request for the page.

➤ Maximum Server Time. The maximum amount of time, in seconds, that it 
took the server to process a request for the page.

Using the HP Real User Monitor JMX Console

You use the HP Real User Monitor Engine JMX Console to view and 
configure HP Real User Monitor settings.

This section includes the following topics:

➤ “Accessing the JMX Console” on page 162

➤ “Setting URL Correlation Parameters” on page 163

➤ “Configuring HP Real User Monitor Aggregation” on page 164

➤ “Configuring HP Real User Monitor Reporting” on page 166

➤ “Configuring the Samples Rate” on page 168

➤ “Configuring the Amount of Unsent Sample Data to Store in Real User 
Monitor” on page 169

Accessing the JMX Console

Via the JMX console, you can view and configure HP Real User Monitor 
parameters, view statistics for HP Real User Monitor modules and services, 
and view and configure jboss components.

Once you start the HP Real User Monitor engine after installation, you can 
access the HP Real User Monitor Engine JMX Console by launching the 
HP Real User Monitor Engine Web console and choosing JMX Console from 
the Configuration drop-down menu. To access a specific area of the JMX 
Console for an individual HP Real User Monitor module, select Advanced 
Settings from the Configuration drop-down menu in the HP Real User 
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Monitor Engine Web console and then click the links for the module you 
wish to view. For details on the HP Real User Monitor Engine Web console, 
see “Using the HP Real User Monitor Web Console” on page 78.

When you access the JMX console, you are prompted for a user name and 
password. Enter the JMX Console authentication credentials (if you do not 
have these credentials, contact your system administrator).

Note: You can access the HP Real User Monitor Engine JMX Console from a 
different machine by launching a Web browser and typing the following:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

Important: Changing any of the JMX configuration settings can cause 
HP Real User Monitor to malfunction. It is recommended not to change any 
of these settings.

Setting URL Correlation Parameters
You can configure a number of parameters used by HP Real User Monitor 
when correlating recorded URLs with URLs you have configured for 
monitoring. For details on URL correlation, see “Correlating Collected Data 
with Configured Pages” in Using End User Management. For details on 
configuring URLs for monitoring, see “Real User Monitor Administration 
User Interface” in Using End User Management.

Some of the URL correlation parameters are set using the HP Real User 
Monitor JMX console. For details on changing URL correlation parameters 
via the HP Real User Monitor JMX console, see “Setting URL Correlation 
Parameters Via the JMX Console” on page 170.
163



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
Configuring HP Real User Monitor Aggregation

HP Real User Monitor pre-aggregates a number of the data samples it sends 
to HP Business Availability Center. For details on HP Business Availability 
Center aggregation, see “Data Aggregation” in Reference Information. For 
details on HP Real User Monitor pre-aggregation, see “Aggregating Real User 
Monitor Data” in Using End User Management.

You can change the HP Real User Monitor default aggregation periods via 
the JMX console. The following table shows the data sample types that are 
pre-aggregated by HP Real User Monitor, the JMX service in which they are 
configured, their attribute and parameter names, and the default 
aggregation time period:

Data Sample 
Type

JMX Console 
Rum.modules 
Service Name

Attribute in 
JMX Service

Parameter Name Default 
Aggregation 
Period

Page StatisticsMgr
Conf

Properties aggregator.DefinedPages.
interval

300,000 
milliseconds

Slow 
Domain

aggregator.domains.
interval

300,000 
milliseconds

Missing 
Component

aggregator.Missing
Components.interval

300,000 
milliseconds

Server aggregator.Servers.
interval

300,000 
milliseconds

Slow Page aggregator.SlowPages.
interval

300,000 
milliseconds

Page with 
Most Errors

aggregator.pageerroreven
t.
interval

300,000 
milliseconds

Top Domain aggregator.TopDomains.
interval

3,600,000 
milliseconds

Top Page aggregator.TopPages.
interval

3,600,000 
milliseconds
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To change the HP Real User Monitor default aggregation periods via the 
JMX console:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
the applicable service (service=StatisticsMgrConf or service=
SessionMgrStatisticsSettings).

 3 Change the aggregation period as required.

➤ In the StatisticsMgrConf service, to change parameter values in the 
Properties attribute, enter the parameter name and the aggregation 
period (in milliseconds) you want to change under the commented lines 
(the lines beginning with #) in the format:

attribute name=aggregation period

For example, to change the aggregation period of the Server sample type 
to 10 minutes, enter:

aggregator.Servers.interval=600000

Domain SessionMgr
Statistics
Settings

EndUsers
Aggregation
Interval

N/A 300 seconds

Sessions Application
Aggregation
Interval

N/A 300 seconds

Data Sample 
Type

JMX Console 
Rum.modules 
Service Name

Attribute in 
JMX Service

Parameter Name Default 
Aggregation 
Period
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➤ In the SessionMgrStatisticsSettings service, enter the aggregation period 
(in seconds) for the attribute you want to change. For example, to change 
the aggregation period of the Session sample type to 10 minutes, enter 
600 as the attribute value for the ApplicationAggregationInterval 
attribute.

 4 Click the Apply Changes button to save the change.

 5 Activate the change.

➤ In the StatisticsMgrConf service, click the Invoke button for the 
deployConfiguration operation.

➤ In the SessionMgrStatisticsSettings service, click the Invoke button for 
the deploySettingsChanges operation.

Note: Changing the default aggregation periods can significantly affect the 
amount of data sent by HP Real User Monitor to HP Business Availability 
Center. It is recommended not to change the default aggregation periods.

Configuring HP Real User Monitor Reporting

By default, HP Real User Monitor reports data to HP Business Availability 
Center for all end users, both those configured in end-user groups in End 
User Management Administration and those who are not configured. (For 
details on configuring end users in End User Management Administration, 
see “New/Edit End-User Group Page” in Using End User Management.) You 
can configure HP Real User Monitor to report data only for configured end 
users.
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Note: HP Business Availability Center includes a list of predefined end-user 
names and domains to give meaningful names to end users in HP Real User 
Monitor reports. If you configure HP Real User Monitor to report data only 
for configured end users, data for end users in the predefined list are not 
reported to HP Business Availability Center. For details of HP Real User 
Monitor reports, see “Real User Monitor Reports User Interface” in Using End 
User Management.

To configure HP Real User Monitor to report data for configured end users 
only:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=StatisticsMgrConf.

 3 In the ShouldReportUndefinedDomains parameter, change the value to 
false.

 4 Click the Apply Changes button to save the change.

 5 Click the Invoke button for the deployConfiguration operation to activate 
the change.
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Configuring the Samples Rate
The maximum burst rate controls the number of samples per second that 
the HP Real User Monitor engine can send to HP Business Availability 
Center. The default setting is 150. You can increase the maximum burst rate 
to allow more samples to be sent per second, provided that HP Business 
Availability Center is capable of handling the increased number. You can see 
the state of the flow of samples between HP Real User Monitor and 
HP Business Availability Center by looking at the Publisher burst state in 
Real User Monitor system health. For details on Real User Monitor system 
health, see “Monitoring the Health of HP Real User Monitor Components” 
on page 84.

To configure the maximum burst rate:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=PublisherSettings.

 3 In the BurstControlMaxSamples parameter, change the value to the 
maximum number of samples required.

 4 Click the Apply Changes button to save the change.

 5 Click the Invoke button for the applyAttributeChanges operation to activate 
the change.
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Configuring the Amount of Unsent Sample Data to Store 
in Real User Monitor
By default, 1000 chunks of samples data are stored in HP Real User Monitor 
for sending to HP Business Availability Center. You can increase the number 
of chunks of data stored (providing you have sufficient disk space) to avoid 
data loss when HP Business Availability Center cannot receive data from 
HP Real User Monitor. For example, you might want to increase the amount 
of data stored by HP Real User Monitor during a planned downtime in 
HP Business Availability Center. Bear in mind that when a lot of data has 
been stored in HP Real User Monitor, it can take a long time for all of it to be 
sent to HP Business Availability Center, which might cause a delay in seeing 
real time data. If you increase the number of data chunks to store, you 
should reset it to the original number once HP Business Availability Center 
is running and all the stored data has been transmitted to it.

To increase the maximum number of data chunks stored:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=PublisherSettings.

 3 In the MaxChunksInQueue parameter, change the value to the maximum 
number of chunks required.

 4 Click the Apply Changes button to save the change.

 5 Click the Invoke button for the applyAttributeChanges operation to activate 
the change.
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URL Correlation Parameters

After the HP Real User Monitor engine has been installed and started, you 
can configure a number of parameters to determine how the HP Real User 
Monitor correlates recorded URLs with Web pages you have configured for 
monitoring in End User Management Administration.

This section includes the following topics:

➤ “Setting URL Correlation Parameters Via the JMX Console” on page 170

➤ “Correlating Session ID Parameters” on page 172

Setting URL Correlation Parameters Via the JMX Console
You can change the default setting of a number of parameters used by 
HP Real User Monitor when correlating recorded URLs with URLs you have 
configured for monitoring. For details on URL correlation, see “Correlating 
Collected Data with Configured Pages” in Using End User Management. For 
details on configuring URLs for monitoring, see “Real User Monitor 
Administration User Interface” in Using End User Management.

You can configure the following parameters for URL correlation in the JMX 
console:

➤ adaptIndexurl. By default, HP Real User Monitor considers URLs with a 
suffix of index.html (and other suffixes that are configured in the 
urlIndexStrings parameter) to be same as the root URL. For example, 
http://www.hp.com/index.html is considered to be the same as 
http://www.hp.com/. To instruct HP Real User Monitor to consider all 
suffixes as being different from the root URL, change this parameter to False.

➤ urlIndexStrings. URL suffixes configured in this parameter are considered to 
be the same as the root URL, if the adaptIndexurl parameter is set to True. 
For example, if the suffix index.html is configured, then 
http://www.hp.com/index.html is considered to be the same as 
http://www.hp.com/. By default, the suffix index.html is configured in this 
parameter. To add additional suffixes, add them to the string separated by a 
semicolon (;). The last suffix in the string must also be followed by a 
semicolon. For example, /;/index.html;/index.aspx;.
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Note: 

➤ For the urlIndexStrings parameter to be active, the adaptIndexurl 
parameter must be set to true.

➤ The index strings in the urlIndexStrings parameter are considered as 
being identical for all URLs. For example, if /;/index.html; is configured 
in the urlIndexStrings parameter then http://www.hp.com/ and 
http://www.hp.com/index.html are considered as being identical, 
http://www.hp-int.com/ and http://www.hp-int.com/
index.html are considered as being identical, and so forth.

➤ Changing the urlIndexStrings parameter requires the HP Real User 
Monitor Engine Resolver to be restarted. For details, see “To restart the 
HP Real User Monitor Engine Resolver:” on page 172.

➤ adaptCaseSensitive. By default, HP Real User Monitor URL correlation is 
case-insensitive, so that a recorded URL such as http://www.hp.com/
rumEnginePage.html is correlated with the configured URL 
http://www.hp.com/rumenginepage.html. To instruct HP Real User 
Monitor to use case-sensitive URL correlation (for all but the host and 
protocol parts of a URL), you set this parameter to False.

➤ basicAuthentication. By default, HP Real User Monitor ignores basic 
authentication when performing URL correlation. For example, the 
recorded URL http://bob:my_password@www.hp.com is correlated with the 
configured URL http://www.hp.com. To instruct the HP Real User Monitor 
to consider basic authentication when performing URL correlation, you set 
this parameter to False.
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To change the default setting of a URL correlation parameter in the JMX 
console:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=ResolverURLMConfig.

 3 In the relevant parameter, change the setting to the required value.

 4 Click the Apply Changes button.

To restart the HP Real User Monitor Engine Resolver:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=Resolver.

 3 Scroll down to the restart operation and click Invoke.

Correlating Session ID Parameters
You can configure specific parameters in recorded URLs to be ignored by 
HP Real User Monitor when correlating recorded URLs with URLs you have 
configured for monitoring in End User Management Administration. For 
details on URL correlation, see “Correlating Collected Data with Configured 
Pages” in Using End User Management. For details on configuring URLs for 
monitoring, see “Real User Monitor Administration User Interface” in Using 
End User Management.
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If you set a parameter to be ignored by HP Real User Monitor, and the 
parameter is included in a recorded URL, the HP Real User Monitor replaces 
the contents of that parameter with an asterisk (*). For example, if you set 
HP Real User Monitor to ignore the BV_SessionID and BV_EngineID 
parameters in the following URL:

http://www.hp.com/~anand/Ticket_Confirm.jsp?BV_SessionID=@@@@181205
7630.1043567934@@@@&BV_EngineID=cccdadchgidfmlmcefecehidfhfdffk.0
&value=0000144976

The URL is translated as follows:

http://www.hp.com/~anand/Ticket_Confirm.jsp?BV_SessionID=*&BV_EngineID
=*&value=0000144976

The parameters to be ignored are defined per application server.

To configure session ID parameters to be ignored:

 1 Open the <HP Real User Monitor root directory>\conf\
configurationmanager\Application_Server_Types_configuration.xml file in 
a text editor.

 2 Locate the application server type for which you are configuring the 
parameters to be ignored. This appears in the format <AppServer 
name="app_server_name">, where app_server_name is the name of the 
application server type. For example, for a Broadvision application server, 
the entry is:

<AppServer name="BroadVision">

 3 Under the application server name, in the section beginning with the 
<DiscardParameters> tag, is a list of the most common session ID 
parameters for that application server. You can add and delete parameters to 
create a list of all the parameters you want HP Real User Monitor to ignore 
during correlation. Parameters are entered in the format 
<parameter>parameter_name</parameter>, where parameter_name is the 
name of the parameter. For example, for a parameter called BV_EngineID, 
the entry is.

  <parameter>BV_EngineID</parameter> 
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 4 If you want HP Real User Monitor to consider the parameters you enter as a 
regular expression instead of a string (which is the default), you add 
type="regEx" to the <DiscardParameters> tag. For example, 
<DiscardParameters type="regEx">

 5 Under the application server name, in the line: 

<attribute name="enabled">false</attribute> 

change false to true.

 6 Save the file and exit the editor.

Configuring Meaningful Page Names

You can configure HP Real User Monitor to change the URLs of recorded 
pages that are not configured in End User Management Administration to 
more meaningful names for use in HP Real User Monitor reports. For 
information on configuring pages for monitoring, see “New/Edit Page” in 
Using End User Management. For information on HP Real User Monitor 
reports, see “Real User Monitor Reports User Interface” in Using End User 
Management.

This section includes the following topics:

➤ “About Meaningful Page Names” on page 175

➤ “Formatting Tags” on page 176

➤ “Rules Tags” on page 186

➤ “Sample XML File” on page 190

➤ “Validating Meaningful Name XML Files” on page 197

➤ “Adding and Deleting Meaningful Name XML Files” on page 198

➤ “Changing Meaningful Name XML Files” on page 199

➤ “Viewing Meaningful Page Statistics” on page 200
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About Meaningful Page Names
For each application configured in End User Management Administration, 
you can create an XML file to be used to give meaningful names to pages 
that are recorded as part of the application, but that are not configured as 
pages in End User Management Administration. For information on 
configuring applications for monitoring, see “New/Edit Web or SOAP 
Application Page” in Using End User Management. For information on 
configuring pages for monitoring, see “New/Edit Page” in Using End User 
Management.

If an XML file has been created and an application linked to it, when a page 
that is not configured in End User Management Administration is recorded 
as part of the application, the page’s URL is compared to the rules in the 
XML file. If matches are found, the page is given a new name for use in 
HP Real User Monitor reports. If no matches are found, or if no XML file has 
been created and linked to the application, the page’s URL as recorded is 
used in HP Real User Monitor reports. For information on HP Real User 
Monitor reports, see “Real User Monitor Reports User Interface” in Using End 
User Management.

The XML file must be created in the \<HP Real User Monitor root 
directory>\conf\resolver\meaningful_pages directory on the HP Real User 
Monitor engine machine. For convenience, it is recommended that the file 
name is the same as the application name. For example, an XML file created 
for an application called myapplication is:

\<HP Real User Monitor root directory>\conf\resolver\meaningful_pages\
myapplication.xml

Note: HP Real User Monitor includes two default XML files for the 
PeopleSoft 8.1 and Siebel 7.5 applications.
175



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
The XML file contains the following main sections:

➤ Formatting. Contains the formatting commands for changing a URL into a 
meaningful name.

➤ Rules. Contains the rules that determine whether or not a page’s URL is 
changed to a meaningful name.

Tip: It is recommended to create the rules before the formats.

Formatting Tags
The first main section in the XML file is the formatting section, which 
contains the XML tags that are used to format parts of a page’s URL, which 
are then used to create a meaningful name for the page.

Note: All parts of a page’s URL are converted by HP Real User Monitor to 
lower case for matching and formatting.

The following formatting tags can be used. For the XML schema to be 
validated (for details, see “Validating Meaningful Name XML Files” on 
page 197), the tags must appear in the XML file in the order in which they 
are listed below:

URLDecoder

The URLDecoder tag is used to decode a source string using a specified 
decoder.

Syntax <URLDecoder Name="Command_Name" 
EncodingScheme="Scheme"/>

Explanation Command_Name. The name of the Substring 
formatting tag that can be used in Rule tags.

Scheme. The decoding scheme to be used.
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Rename

The Rename tag is used to replace the entire contents of a source string.

Example <URLDecoder Name="DecodeUTF-8" 
EncodingScheme="UTF-8"/>

When the DecodeUTF-8 formatting command is 
referenced in a rule, the string is decoded using the 
UTF-8 decoding scheme.

Note If the URLDeocder tag is used, but no encoding scheme 
is specified, the UTF-8 scheme is used by default.

Syntax <Rename Name="Command_Name" 
NewName="Rename_String"/>

Explanation Command_Name. The name of the Rename formatting 
tag that can be used in Rule tags.

Rename_String. The string to be substituted for the 
source string.

Example <Rename Name="RenameToABC123" String="HP"

When the RenameToABC123 formatting command is 
referenced in a rule, the entire source string is renamed 
to HP.
177



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
Substring

The Substring tag is used to extract a sub string from the source string.

ExtractStrToStr

The ExtractStrToStr tag is used to extract a string between two given strings 
from the source string.

Syntax <SubString Name="Command_Name" 
BeginIndex="Start_Char_Index" Count="Length"/>

Explanation Command_Name. The name of the Substring 
formatting tag that can be used in Rule tags.

Start_Char_Index. The position in the source string of 
the starting character of the substring to be extracted. 
The first position in the source string is the zero index.

Length. The number of characters from the Start_Char 
to be extracted. If the number used is greater than the 
number of characters from the Start_Char to the end of 
the source string, the entire string from the Start_Char 
to the end of the source string is extracted.

Example <Substring Name="ExtractTenToTwelve" 
BeginIndex="10" Count="3"/>

When the ExtractTenToTwelve formatting command is 
referenced in a rule, the tenth, eleventh, and twelfth 
characters of the source string are extracted.

Syntax <ExtractStrToStr Name="Command_Name" 
fromString="Start_String" 
fromInclude="Include_Start_String" 
fromOccurrences="Occurrences_Start_String" 
toString="End_String"
toInclude="Include_End_String" 
toOccurrences="Occurrences_End_String"/>
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Explanation Command_Name. The name of the ExtractStrToStr 
formatting tag that can be used in Rule tags.

Start_String. The starting string from which the 
required string is to be extracted.

Include_Start_String. Whether to include the starting 
string as part of the extracted string. Valid options are:

➤ True. Include the starting string as part of the 
extracted string. This is the default used if nothing is 
specified.

➤ False. Do not include the starting string as part of 
the extracted string.

Occurrences_Start_String. The occurrence number of 
the starting string at which to start the extraction of 
the required string. Valid options are 1-100 or last.

End_String. The ending string up to which the required 
string is to be extracted.

Include_End_String. Whether to include the ending 
string as part of the extracted string. Valid options are:

➤ True. Include the ending string as part of the 
extracted string. This is the default used if nothing is 
specified.

➤ False. Do not include the ending string as part of the 
extracted string.

Occurrences_End_String. The occurrence number of 
the ending string at which to end the extraction of the 
required string. Valid options are 1-100 or last.

Example <ExtractStrToStr Name="ExtractBetweenABCandXYZ" 
fromString="ABC" fromInclude="true" 
fromOccurrences="2" toString="XYZ" toInclude="false" 
toOccurrences="1"/>

When the ExtractBetweenABCandXYZ formatting 
command is referenced in a rule, the string between 
the second occurrence of ABC and the first occurrence 
of XYZ in the source string is extracted. The starting 
string of ABC is also included at the beginning of the 
extracted string.
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ExtractIndexToStr

The ExtractIndexToStr tag is used to extract a string between a given starting 
position and a given ending string in the source string.

Syntax <ExtractIndexToStr Name="Command_Name" 
fromIndex="Start_Char_Index" toString="End_String" 
toInclude="Include_End_String" 
toOccurrences="Occurrences_End_String"/>

Explanation Command_Name. The name of the ExtractIndexToStr 
formatting tag that can be used in Rule tags.

Start_Char_Index. The character number from which 
to start extracting the required string. The first position 
in the source string is the zero index.

End_String. The ending string up to which the required 
string is to be extracted.

Include_End_String. Whether to include the ending 
string as part of the extracted string. Valid options are:

➤ True. Include the ending string as part of the 
extracted string. This is the default used if nothing is 
specified.

➤ False. Do not include the ending string as part of the 
extracted string.

Occurrences_End_String. The occurrence number of 
the ending string at which to end the extraction of the 
required string. Valid options are 1-100 or last.

Example <ExtractIndexToStr Name="ExtractBetween3andXYZ" 
fromIndex="3" toString="XYZ" toInclude="false" 
toOccurrences="1"/>

When the ExtractBetween3andXYZ formatting 
command is referenced in a rule, the string between 
the third index of the source string and the first 
occurrence of XYZ in the source string is extracted.
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ExtractStrIToCount

The ExtractStrToCount tag is used to extract a string of a specified number of 
characters starting at a given string in the source string.

Syntax <ExtractStrToCount Name="Command_Name" 
fromString="Start_String" 
fromInclude="Include_Start_String" 
fromOccurrences="Occurrences_Start_String" 
count="Length" />

Explanation Command_Name. The name of the ExtractStrToCount 
formatting tag that can be used in Rule tags.

Start_String. The starting string from which the 
required string is to be extracted.

Include_Start_String. Whether to include the starting 
string as part of the extracted string. Valid options are:

➤ True. Include the starting string as part of the 
extracted string. This is the default used if nothing is 
specified.

➤ False. Do not include the starting string as part of 
the extracted string.

Occurrences_Start_String. The occurrence number of 
the starting string at which to start the extraction of 
the required string. Valid options are 1-100 or last.

Length. The number of characters from the Start_String 
to be extracted. If the number used is greater than the 
number of characters from the Start_String to the end 
of the source string, the entire string from the 
Start_String to the end of the source string is extracted.

Example <ExtractStrToCount Name="ExtractBetweenABCfor5" 
fromString="ABC" fromInclude="false" 
fromOccurrences="1" count="5"/>

When the ExtractBetweenABCfor5 formatting 
command is referenced in a rule, a string comprising 
the five characters after the first occurrence of the 
string ABC in the source string is extracted.
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Insert

The Insert tag is used to insert a string into a source string at a specified 
position.

Syntax <Insert Name="Command_Name" 
String="Insert_String" ToIndex="Start_Char_Index" 
CountFromBeginning="Direction"/>

Explanation Command_Name. The name of the Insert formatting 
tag that can be used in Rule tags.

Insert_String. The string to be inserted in the source 
string.

Start_Char_Index. The character number at which to 
insert the Insert_String in the source string. The first 
position in the source string is the zero index.

Direction. Whether to start counting the Start_Char 
index position from the start of the source string (that 
is, from left to right) or from the end of the source 
string (that is, from right to left). The valid options are:

➤ True. Start counting the Start_Char index position 
from the start of the source string (that is, from left 
to right). This is the default used if no direction is 
specified.

➤ False. Start counting the Start_Char index position 
from the end of the source string (that is, from right 
to left).

Example <Insert Name="InsertABCAfterOrder" String="ABC" 
ToIndex="5"/>

When the InsertABCAfterOrder formatting command 
is referenced in a rule, the string ABC is inserted in the 
source string, starting at the fifth index (that is, the 
letter A becomes the fifth character in the source 
string).
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ChangeCase

The ChangeCase tag is used to change the case of a string.

Syntax <ChangeCase Name="Command_Name" 
Type="Case_Type" BeginIndex="Start_Char_Index" 
Count="Length"/>

Explanation Command_Name. The name of the ChangeCase 
formatting tag that can be used in Rule tags.

Case_Type. The type of conversion to be carried out. 
The valid options are:

➤ UpperCase. Lower case to upper case. This is the 
default if no type is specified.

➤ LowerCase. Upper case to lower case.

➤ OpposisteCase. Switches the case of characters.

Start_Char_Index. The position in the source string of 
the starting character to be converted The first position 
in the source string is the zero index.

Length. The number of characters from the Start_Char 
to be converted.

Example <ChangeCase Name="UpperCaseFirstChar" 
Type="UpperCase" BeginIndex="0" Count="1"/>

When the UpperCaseFirstChar formatting command is 
referenced in a rule, the first character of the source 
string is converted to upper case.

Note If Length is not specified, the ChangeCase conversion 
is carried out from the Start_Char to the end of the 
source string.
183



Chapter 7 • Configuring and Administering the HP Real User Monitor Engine
Remove

The Remove tag is used to remove all occurrences of a specified string from a 
source string.

RemoveNonAlpha

The RemoveNonAlpha tag is used to remove all non-alpha characters from a 
source string.

Syntax <Remove Name="Command_Name" 
String="Remove_String"/>

Explanation Command_Name. The name of the Remove formatting 
tag that can be used in Rule tags.

Remove_String. The string to be removed from the 
source string.

Example <Remove Name="Removeabc" String="abc"/>

When the Removeabc formatting command is 
referenced in a rule, the string abc is removed from the 
source string.

Syntax <RemoveNonAlpha Name="Command_Name">

Explanation Command_Name. The name of the RemoveNonAlpha 
formatting tag that can be used in Rule tags.

Example <Remove Name="RemoveAllNonAlpha"/>

When the RemoveAllNonAlpha formatting command 
is referenced in a rule, all non-alpha characters are 
removed from the source string.
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Replace

The Replace tag is used to replace all occurrences of a sub string within a 
source string.

Syntax <Replace Name="Command_Name" Old="Old_String" 
New="New_String"/>

Explanation Command_Name. The name of the Replace formatting 
tag that can be used in Rule tags.

Old_String. The sub string within the source string to 
be replaced.

New_String. The string that replaces Old_String.

Example <Replace Name="ReplaceabcWithXYZ" Old="abc" 
New="XYZ"/>

When the ReplaceabcWithXYZ formatting command is 
referenced in a rule, all occurrences of abc in the source 
string are replaced with XYZ.
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Alias

The Alias tag is used to replace all occurrences of an alphanumeric sub string 
within a string with an assigned alias.

Rules Tags
The second main section in the XML file is the rules section, which contains 
the logic for assigning a meaningful name to a page. The rules section is 
responsible for matching a page to a single rule and then using the 
formatting tags included in the rule to assign a meaningful name to the 
page. Matching is carried out on the different parts of the URL – URL 
protocol, URL path, URL host, and parameters (both the GET and POST 
parameters of a page).

Rules are prioritized, so that if a page’s URL matches more than one rule, the 
rule that has the highest priority is the single rule that is applied to the page.

Syntax <Alias Name="Command_Name">

<Pair Name="Source_String" Alias="Assigned_Alias"/>

</Alias>

Explanation Command_Name. The name of the Alias formatting 
tag that can be used in Rule tags.

Source_String. The alphanumeric string to which you 
are assigning an alias.

Assigned_Alias. The alias you are assigning to replace 
the Source_String.

Example <Alias Name="RelateLettersToCategory">

<Pair Name="fi" Alias="Fish"/>

</Alias>

When the RelateLettersToCategory formatting 
command is referenced in a rule, all occurrences of the 
string fi are replaced with the alias Fish.

Note You can include multiple Pair tags within the same 
Alias tag. Each Alias replacement is carried out on the 
output string from the previous Alias replacement – 
that is, there is only one output string at the end.
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The rules section uses a default string delimiter of a space (" "), but you can 
specify a different delimiter by including it in the Rules tag that begins the 
rules section. For example, to set a default delimiter of a right, square 
bracket:

<Rules DefaultDelimiter="]">

Individual rules can use a different delimiter than the general default, if 
specified within the specific rule.

Rules are written in the following format:

<Rule Priority="Priority" Name="Rule_Name">
<Path Name="URL_Path">
<Host Name="URL_Host">
<Protocol Type="URL_Protocol">
<Parameters>

<Param Key="Param_Name" Value="Param_Value">
<Formatter Index="Index_Number">Format_Name1</Formatter>
<Formatter Index="Index_Number">Format_Name2 

Format_Name3</Formatter>
<Formatter Index="Index_Number"></Formatter>

</Param>
</Parameters>

</Rule>

where:

➤ Priority. The priority in which the rule should be applied. If more than one 
rule matches the source string, the rule with the highest priority is the one 
that is applied. 0 is the highest priority, 1 is the second, and so forth.

If more than one rule has the same priority, the last one that appears in the 
XML file is the rule that is applied.

Tip: When assigning priorities to rules, you can use increments greater 
than 1. For example, you can assign priorities of 10, 20, 30, and so forth. 
This allows flexibility for inserting new rules at a later time.
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➤ Rule_Name. The name of the rule.

➤ URL_Path. The URL path that is required for the rule to be applied.

➤ URL_Host. The URL host that is required for the rule to be applied. This 
option does not support the use of a wildcard.

➤ URL_Protocol. The URL protocol that is required for the rule to be applied. 
This option does not support the use of a wildcard.

➤ Param_Name. The key (name) of a parameter in the URL that is required for 
the rule to be applied.

➤ Param_Value. The value in the Param_Name parameter that is required for 
the rule to be applied. Use "" to denote an empty parameter value.

➤ Index_Number. The position that the formatted string occupies in the 
meaningful name to be created.

➤ Format_Name. The name of the format to be used on the selected string to 
format it into a string that is used as part of the created meaningful name 
for a page. The format name must be one of the formats defined in the 
formatting section of the XML file (for details, see “Formatting Tags” on 
page 176). If no format name is specified, no formatting is applied to the 
input string, resulting in an identical output string that is used as part of the 
created meaningful name for a page.

Note: URL_Path, URL_Host, URL_Protocol, Param_Name, and Param_Value 
are always in lower case.

The following points apply to rules:

➤ Not all parts of a rule need to exist, but at least one rule should be defined 
and it should contain a Formatter tag.

➤ If a Formatter tag is placed directly under a Param tag, the formatting is 
carried out on the parameter value. If a Formatter tag is placed directly 
under a Path tag, the formatting is carried out on the URL path.
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➤ If an asterisk (*) or question mark (?) character is included in a URL path, 
parameter name, or parameter value, you can specify whether to treat the 
character as a literal (that is, purely as an asterisk or question mark), or to 
treat it as a wildcard character. By default, the character is treated as a literal. 
To treat the character as a wildcard character, you add the setting 
CompareMethod="WildCard" at the end of the rule tag in which the 
character appears. For example:

<Param Key="myparam" Value="*" CompareMethod="WildCard">

To use an asterisk or question mark character as a literal within a wildcard 
value, precede the character with a backslash (\). For example, the wildcard 
value my\*str* matches the value my*str123, but does not match the value 
my123str123.

Note: 

➤ The asterisk wildcard represents any combination of characters, whereas 
the question mark wildcard represents a single character only.

➤ Using the wildcard comparison on page parameters creates significant 
overhead on the HP Real User Monitor engine and should be used only 
when absolutely necessary.

➤ You can apply multiple format names to a Path or Param tag. If the format 
names are placed in individual Formatter tags one under the other, each 
format name is applied to the original path or parameter value and each 
format name produces its own output for inclusion in the meaningful 
name. If the format names are included in the same Formatter tag, each 
format name is applied to the resulting value from the previous format 
name and only one result is created for inclusion in the meaningful name. 

Example of multiple formatting commands in separate Formatter tags:

<Path Name="/mypath/home">
<Formatter Index="1">Format_Name1</Formatter>
<Formatter Index="2">Format_Name2</Formatter>
<Formatter Index="3">Format_Name3</Formatter>

</Path>

Each of the format names is applied to the path /mypath/home.

Example of multiple formatting commands in the same Formatter tag:
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<Path Name="/mypath/home">
<Formatter Index="1">Format_Name1 Format_Name2</Formatter>

</Path>

Format_Name1 is applied to the path /mypath/home; Format_Name2 is 
applied to the output from Format_Name1.

Sample XML File
The following examples show an XML file with formatting and rule tags 
defined, and various examples of URLs and the meaningful names created 
for them based on the formatting and rule tags in the sample XML file.

XML File

<?xml version="1.0"?>
<Meaningful_Pages xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="./meaningfulpages.xsd">
    <Formating>
        <Rename Name="RenameToWelcome" NewName="Welcome"/>
        <Rename Name="RenameToSignIn" NewName="Sign In"/>
        <Rename Name="RenameToStoreEntrance" NewName="Store Entrance"/>
        <Rename Name="RenameToEditAccount" NewName="Edit Account"/>
        <Rename Name="RenameToProduct" NewName="Product"/>
        <Rename Name="RenameToCheckOut" NewName="Check Out"/>

<Rename Name="RenameToOrderSubmitted" NewName="Order 
Submitted"/>
        <Rename Name="RenameToSignOut" NewName="Signed Out"/>
        <SubString Name="ExtractTwoFirstLetters" BeginIndex="0" Count="2"/>
        <SubString Name="ExtractItem" BeginIndex="20" Count="4"/>
        <SubString Name="ExtractUpdate" BeginIndex="16" Count="6"/>
        <SubString Name="ExtractCart" BeginIndex="22" Count="4"/>
        <SubString Name="ExtractQuantities" BeginIndex="26" Count="10"/>
        <Insert Name="AppendCategory" String="Category " ToIndex="0"/>
        <Insert Name="AppendAddItemPrefix" String="Add Item " ToIndex="0"/>
        <Insert Name="AppendToCartSuffix" String=" to Cart" ToIndex="0" 
CountFromBeginning="false"/>
        <Insert Name="AppendRemoveItemPrefix" String="Remove Item " 
ToIndex="0"/>
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        <Insert Name="AppendFromCartSuffix" String=" from Cart" ToIndex="0" 
CountFromBeginning="false"/>
        <Insert Name="InsertSpaceAfterOrder" String=" " ToIndex="5"/>
        <Insert Name="InsertSpaceAfterConfirm" String=" " ToIndex="7"/>
        <Insert Name="InsertNotAfterOrder" String="Not " ToIndex="6"/>
        <ChangeCase Name="UpperCaseFirstChar" Type="UpperCase" 
BeginIndex="0" Count="1"/>
        <ChangeCase Name="UpperCaseAll" Type="UpperCase" 
BeginIndex="0"/>
        <ChangeCase Name="UpperCaseSixthLetter" Type="UpperCase" 
BeginIndex="6" Count="1"/>
        <ChangeCase Name="UpperCaseEigthLetter" Type="UpperCase" 
BeginIndex="8" Count="1"/>
        <Remove Name="RemoveNew" String="/jpetstore/shop/new"/>
        <Remove Name="RemoveSHTML" String=".shtml"/>
        <Replace Name="ReplaceNewWithConfirm" Old="/jpetstore/shop/new" 
New="Confirm"/>        
        <Alias Name="RelateLettersToCategory">
            <Pair Name="FI" Alias="Fish"/>
            <Pair Name="K9" Alias="Dogs"/>
            <Pair Name="RP" Alias="Reptiles"/>
            <Pair Name="FL" Alias="Cats"/>
            <Pair Name="AV" Alias="Birds"/>
        </Alias>
        <Alias Name="RelateProductIdToProductName">
            <Pair Name="FI-FW-01" Alias="'Koi'"/>
            <Pair Name="FI-FW-02" Alias="'Goldfish'"/>
            <Pair Name="FI-SW-01" Alias="'Angelfish'"/>
            <Pair Name="FI-SW-02" Alias="'Tiger Shark'"/>
            <Pair Name="K9-BD-01" Alias="'Bulldog'"/>
            <Pair Name="K9-CW-01" Alias="'Chihuahua'"/>
            <Pair Name="K9-DL-01" Alias="'Dalmation'"/>
            <Pair Name="K9-PO-02" Alias="'Poodle'"/>
            <Pair Name="K9-RT-01" Alias="'Golden Retriever'"/>
            <Pair Name="K9-RT-02" Alias="'Labrador Retriever'"/>
            <Pair Name="RP-LI-02" Alias="'Iguana'"/>
            <Pair Name="RP-SN-01" Alias="'Rattlesnake'"/>
            <Pair Name="FL-DLH-02" Alias="'Persian'"/>
            <Pair Name="FL-DSH-01" Alias="'Manx'"/>
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            <Pair Name="AV-CB-01" Alias="'Amazon Parrot'"/>
            <Pair Name="AV-SB-02" Alias="'Finch'"/>
        </Alias>
        <Alias Name="RelateItemNameToItemDesc">
            <Pair Name="EST-28" Alias="'Adult Female Golden Retriever'"/>
            <Pair Name="EST-27" Alias="'Adult Female Chihuahua'"/>
            <Pair Name="EST-26" Alias="'Adult Male Chihuahua'"/>
            <Pair Name="EST-25" Alias="'Adult Female Labrador Retriever'"/>
            <Pair Name="EST-24" Alias="'Adult Male Labrador Retriever'"/>
            <Pair Name="EST-23" Alias="'Adult Female Labrador Retriever'"/>
            <Pair Name="EST-22" Alias="'Adult Male Labrador Retriever'"/>
            <Pair Name="EST-21" Alias="'Adult Female Goldfish'"/>
            <Pair Name="EST-20" Alias="'Adult Male Goldfish'"/>
            <Pair Name="EST-19" Alias="'Adult Male Finch'"/>
            <Pair Name="EST-18" Alias="'Adult Male Amazon Parrot'"/>
            <Pair Name="EST-17" Alias="'Adult Male Persian'"/>
            <Pair Name="EST-16" Alias="'Adult Female Persian'"/>
            <Pair Name="EST-15" Alias="'With tail Manx'"/>
            <Pair Name="EST-14" Alias="'Tailless Manx'"/>
            <Pair Name="EST-13" Alias="'Green Adult Iguana'"/>
            <Pair Name="EST-12" Alias="'Rattleless Rattlesnake'"/>
            <Pair Name="EST-11" Alias="'Venomless Rattlesnake'"/>
            <Pair Name="EST-10" Alias="'Spotted Adult Female Dalmation'"/>
            <Pair Name="EST-9" Alias="'Spotless Male Puppy Dalmation'"/>
            <Pair Name="EST-8" Alias="'Male Puppy Poodle'"/>
            <Pair Name="EST-7" Alias="'Female Puppy Bulldog'"/>
            <Pair Name="EST-6" Alias="'Male Adult Bulldog'"/>
            <Pair Name="EST-5" Alias="'Spotless Koi'"/>
            <Pair Name="EST-4" Alias="'Spotted Koi'"/>
            <Pair Name="EST-3" Alias="'Toothless Tiger Shark'"/>
            <Pair Name="EST-2" Alias="'Small Angelfish'"/>
            <Pair Name="EST-1" Alias="'Large Angelfish'"/>
        </Alias>
    </Formating>
    <Rules DefaultDelimiter=" ">
        <Rule Priority="0" Name="Welcome">
            <Path Name="/jpetstore/">
                <Formatter Index="1">RenameToWelcome</Formatter>
            </Path>
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        </Rule>
        <Rule Priority="1" Name="Welcome">
            <Path Name="/jpetstore/index.html">
                <Formatter Index="1">RenameToWelcome</Formatter>
            </Path>
        </Rule>
        <Rule Priority="2" Name="Sign In">
            <Path Name="/jpetstore/shop/signonForm.shtml">
                <Formatter Index="1">RenameToSignIn</Formatter>
            </Path>
        </Rule>
        <Rule Priority="3" Name="Store Entrance">
            <Path Name="/jpetstore/shop/signon.shtml">
                <Formatter Index="1">RenameToStoreEntrance</Formatter>
            </Path>
        </Rule>
        <Rule Priority="4" Name="Category [any]">
            <Path Name="/jpetstore/shop/viewCategory.shtml"/>
            <Parameters>
                <Param Key="categoryId" Value="*" CompareMethod="WildCard">
                    <Formatter Index="1">UpperCaseAll AppendCategory</Formatter>
                </Param>
            </Parameters>
        </Rule>
        <Rule Priority="5" Name="Edit Account">
            <Path Name="/jpetstore/shop/editAccountForm.shtml">
                <Formatter Index="1">RenameToEditAccount</Formatter>
            </Path>
        </Rule>
        <Rule Priority="6" Name="Any Product [product]">
            <Path Name="/jpetstore/shop/v*Product.shtml" 
CompareMethod="WildCard"/>
            <Parameters>
                <Param Key="productId" Value="*" CompareMethod="WildCard">
                    <Formatter Index="1">ExtractTwoFirstLetters 
RelateLettersToCategory</Formatter>
                    <Formatter Index="2">RenameToProduct</Formatter>
                    <Formatter Index="3">RelateProductIdToProductName</Formatter>
                </Param>
            </Parameters>
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        </Rule>
        <Rule Priority="7" Name="Item [any]">
            <Path Name="/jpetstore/shop/viewItem.shtml">
                <Formatter Index="1">ExtractItem UpperCaseFirstChar</Formatter>
            </Path>
            <Parameters>
                <Param Key="itemId" Value="*" CompareMethod="WildCard">
                    <Formatter Index="2">RelateItemNameToItemDesc</Formatter>
                </Param>
            </Parameters>
        </Rule>
        <Rule Priority="8" Name="Add Item [any] To Cart">
            <Path Name="/jpetstore/shop/addItemToCart.shtml"/>
            <Parameters>
                <Param Key="workingItemId" Value="*" CompareMethod="WildCard">
                    <Formatter Index="1">RelateItemNameToItemDesc 
AppendAddItemPrefix AppendToCartSuffix</Formatter>
                </Param>
            </Parameters>
        </Rule>
        <Rule Priority="9" Name="Update Cart">
            <Path Name="/jpetstore/shop/updateCartQuantities.shtml">
                <Formatter Index="1">ExtractUpdate 
UpperCaseFirstChar</Formatter>
                <Formatter Index="2">ExtractCart UpperCaseFirstChar</Formatter>
                <Formatter Index="3">ExtractQuantities 
UpperCaseFirstChar</Formatter>
            </Path>
        </Rule>
        <Rule Priority="10" Name="Remove Item [any] From Cart">
            <Path Name="/jpetstore/shop/removeItemFromCart.shtml"/>
            <Parameters>
                <Param Key="workingItemId" Value="*" CompareMethod="WildCard">
                    <Formatter Index="1">RelateItemNameToItemDesc 
AppendRemoveItemPrefix AppendFromCartSuffix</Formatter>
                </Param>
            </Parameters>
        </Rule>
        <Rule Priority="11" Name="Check Out">
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            <Path Name="/jpetstore/shop/checkout.shtml">
                <Formatter Index="1">RenameToCheckOut</Formatter>
            </Path>
        </Rule>
        <Rule Priority="12" Name="Order Form">
            <Path Name="/jpetstore/shop/newOrderForm.shtml">
                <Formatter Index="1">RemoveNew InsertSpaceAfterOrder 
RemoveSHTML UpperCaseFirstChar UpperCaseSixthLetter</Formatter>
            </Path>
        </Rule>
        <Rule Priority="13" Name="Order Submitted">
            <Path Name="/jpetstore/shop/newOrder.shtml">
                <Formatter Index="1">RenameToOrderSubmitted</Formatter>
            </Path>
            <Parameters>
                <Param Key="confirmed" Value="true"/>
            </Parameters>
        </Rule>
        <Rule Priority="14" Name="Order Not Submitted">
            <Path Name="/jpetstore/shop/newOrder.shtml">
                <Formatter Index="1">RenameToOrderSubmitted 
InsertNotAfterOrder</Formatter>
            </Path>
            <Parameters>
                <Param Key="confirmed" Value="false"/>
            </Parameters>
        </Rule>
        <Rule Priority="15" Name="Confirm Order">
            <Path Name="/jpetstore/shop/newOrder.shtml">
                <Formatter Index="1">ReplaceNewWithConfirm 
InsertSpaceAfterConfirm RemoveSHTML UpperCaseEigthLetter</Formatter>
            </Path>
        </Rule>
        <Rule Priority="16" Name="Sign Out">
            <Path Name="/jpetstore/shop/signoff.shtml">
                <Formatter Index="1">RenameToSignOut</Formatter>
            </Path>
        </Rule>
    </Rules>
</Meaningful_Pages>
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Examples of Meangingful Names for URLs

URL Meaningful Name

http://pluto:8080/jpetstore/ Welcome

http://pluto:8080/jpetstore/index.html Welcome

http://pluto:8080/jpetstore/shop/
signonForm.shtml

Sign In

http://pluto:8080/jpetstore/shop/signon.shtml Store Entrance

http://pluto:8080/jpetstore/shop/viewCategory.shtml
?categoryId=CATS

Category CATS

http://pluto:8080/jpetstore/shop/
editAccountForm.shtml

Edit Account

http://pluto:8080/jpetstore/shop/
viewProduct.shtml?productId=FI-FW-01

Fish Product 'Koi'

(FI=Fish, K9=Dogs, 
RP=Reptiles, 
FL=Cats, AV=Birds)

http://pluto:8080/jpetstore/shop/
viewItem.shtml?itemId=EST-4

Item 'Spotted Koi'

http://pluto:8080/jpetstore/shop/
addItemToCart.shtml?workingItemId=EST-6

Add Item 'Male 
Adult Bulldog' to 
Cart

http://pluto:8080/jpetstore/shop/
updateCartQuantities.shtml

Update Cart 
Quantities

http://pluto:8080/jpetstore/shop/removeItem
FromCart.shtml?workingItemId=EST-6

Remove Item 'Male 
Adult Bulldog' from 
Cart

http://pluto:8080/jpetstore/shop/
checkout.shtml

Check Out

http://pluto:8080/jpetstore/shop/newOrderForm.sht
ml

Order Form

http://pluto:8080/jpetstore/shop/
newOrder.shtml

Confirm Order
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Validating Meaningful Name XML Files
You can validate a meaningful name XML file against a predefined XML 
schema to ensure that the structure and format of the file are valid. The 
validation is made using the xerces-j 2.8.0 XML parser.

The schema file against which the XML file is validated is:

\<HP Real User Monitor root directory>\conf\resolver\
meaningfulpages.xsd

To validate a meaningful XML file:

 1 Insert the following line at the beginning of the XML file:

<Meaningful_Pages xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xsi:noNamespaceSchemaLocation="./meaningfulpages.xsd"

Note: If this line is omitted from the XML file and the validation is run, a 
message that the validation was successful is displayed, but no validation is 
actually done.

 2 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

http://pluto:8080/jpetstore/shop/
newOrder.shtml?confirmed=true

Order Submitted

http://pluto:8080/jpetstore/shop/
newOrder.shtml?confirmed=false

Order Not 
Submitted

http://pluto:8080/jpetstore/shop/signoff.shtml Signed Out

URL Meaningful Name
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 3 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=ResolverMeaningfulPagesConfig.

 4 In the validateConfiguration option, enter the full name of the XML file you 
want to validate and click Invoke. The XML file is validated against the 
predefined schema file.

 5 Any errors encountered are displayed, or a message that the validation was 
successful is displayed.

Note: The Formatting tags must be included in the XML file in a specific 
order (for details, see “Formatting Tags” on page 176). If the Formatting tags 
are not in the correct order, a validation error message is displayed, but no 
indication of the order mismatch is given.

Adding and Deleting Meaningful Name XML Files
If you add or delete a meaningful name XML file in an application in End 
User Management Administration and would like to apply the change 
immediately, you can force HP Real User Monitor to reread the End User 
Management Administration configuration. For information on configuring 
applications for monitoring, see “New/Edit Web or SOAP Application Page” 
in Using End User Management.

To force HP Real User Monitor to reread the End User Management 
Administration configuration:

 1 Access the HP Real User Monitor Web console (for details, see “Accessing the 
HP Real User Monitor Engine Web Console” on page 79).

 2 From the Configuration menu, select Engine Configuration Per Data Type. 
The Engine Configuration Page opens.

 3 Click the Sync All Configuration button to force the HP Real User Monitor 
engine to reload the HP Real User Monitor configuration from HP Business 
Availability Center.
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Changing Meaningful Name XML Files
If you change the content of an existing meaningful page XML file that is 
used by an application, you must force HP Real User Monitor to reload the 
configuration for the specific application. For information on configuring 
applications for monitoring, see “New/Edit Web or SOAP Application Page” 
in Using End User Management.

To force HP Real User Monitor to reload the configuration for an 
application:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=ResolverMeaningfulPagesConfig.

 3 In the reloadConfiguration option, enter the application name (as defined 
in End User Management Administration) by which the XML file is being 
used and click Invoke. The application’s configuration is reloaded in HP Real 
User Monitor.

Note: To reload the configuration for all applications, click Invoke for the 
reloadCurrentConfigurations option.
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Viewing Meaningful Page Statistics
You can view a table showing statistical information for each application 
that uses a meaningful page XML file.

To view meaningful page statistics:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in your Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=ResolverMeaningfulPagesConfig.

 3 In the viewStatistics option, click Invoke. The Meaningful Pages Statistics 
table opens, showing the following data:

➤ Application name. The name of the application as defined in End User 
Management Administration. (For details on configuring applications in 
End User Management Administration, see “New/Edit Web or SOAP 
Application Page” in Using End User Management.)

➤ Configuration file name. The name of the meaningful page XML file used 
by the application.

➤ Handled pages. The total number of pages monitored in the application 
that were submitted to the meaningful pages module.

➤ Successful pages. The total number of pages that were successfully 
processed by the meaningful pages module.

➤ Unmatched pages. The total number of pages successfully processed by 
the meaningful pages module, but for which no meaningful name was 
assigned as no match was found.

➤ Failed pages. The total number of pages that were not successfully 
processed by the meaningful pages module.
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Unifying Frames

By default, the HP Real User Monitor probe reports each frame as a separate 
page for statistical purposes. However, when replaying a session in the 
Session Analyzer report, the pages of some frames are listed as sub 
components of other pages in the hierarchal tree and are displayed 
accordingly.

HP Real User Monitor uses a default configuration that contains the rules for 
determining if a page is considered as a parent or a child page. You can 
change the default settings and can also create new settings for specific 
pages.

You configure frames to be unified by HP Real User Monitor in the 
frame_unification.xml file on the HP Real User Monitor engine machine.

To change the default settings for frame unification:

 1 Edit the <HP Real User Monitor root directory>\conf\
configurationmanager\frame_unification.xml file on the HP Real User 
Monitor engine machine.

 2 Locate the DefaultPage entry, which is as follows:

 3 Change the settings for your system, where:

➤ TimeoutMS. The amount of time it takes a frame to load after the 
previous frame has finished loading. Within this time, if the frame 
matches the other parameters, such as the referring URL, it is considered 
as a child of the previous frame, otherwise it is considered as a parent 
frame.

➤ InnerFrames maxInnerFrame. The maximum number of children that a 
parent frame can contain. Use -1 for an unlimited number.
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➤ CanBeInnerFrame. Set to true to enable frames to be considered as 
children. Set to false to consider all frames as parents, unless specific page 
settings have been defined which are applicable to a frame.

➤ MatchInnerFramesReferrer. Set to true to allow child frames to be 
matched to parent frames by URLs (if specific page settings have been 
configured), or false to use only the TimeoutMS setting to create child 
pages.

 4 Save the file and exit.

Note: There can be only one DefaultPage entry.

To create frame unification settings for specific pages:

 1 Edit the<HP Real User Monitor root directory>\conf\
configurationmanager\frame_unification.xml file on the HP Real User 
Monitor engine machine.

 2 After the DefaultPage entry, create a new Page section in the following 
format:
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where:

➤ Pattern. A regular expression for the URL pattern to be matched when 
HP Real User Monitor determines if a frame is to be considered as a 
parent or child. The first Pattern setting at the top of the section 
determines if the rule is applicable for the frame being matched and is 
also used as the parent pattern for any matching children. Subsequent 
Pattern settings, within InnerFrames, are used to determine if the frame 
can be considered as a child.

➤ InnerFrames maxInnerFrame. The maximum number of children that 
the parent frame can contain. Use -1 for an unlimited number.

➤ TimeoutMS. The amount of time it takes a frame to load after the 
previous frame has finished loading. Within this time, the frame is 
considered as a child of the parent frame that matches the first Pattern 
setting, otherwise it is considered as a parent frame itself.

➤ CanBeInnerFrame. Set to true to enable a frame whose URL matches the 
first Pattern setting to be considered as a child, or false to consider all 
frames that match the first Pattern setting as parents.

➤ MatchInnerFramesReferrer. Set to true to allow child frames to be 
matched to the parent frame by the URLs configured in the Pattern 
settings, or false to use only the TimeoutMS setting to create child pages.

 3 Repeat step 2 to create additional page settings as required.

 4 Save the file and exit.

Note: 

➤ If a page’s URL matches the Pattern of more than one Page definition, the 
first matching Page definition in the file is applied.

➤ Missing parameters in a Page definition section inherit the DefaultPage 
setting for that parameter.
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HP Real User Monitor Logs

You use HP Real User Monitor logs to troubleshoot problems and to provide 
information about the system's operations. The log files are located in the 
<HP Real User Monitor root>\log directory on the Real User Monitor engine 
machine. For details on the HP Real User Monitor logs, see “Real User 
Monitor Logs” in Reference Information.
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Administering the MySQL Database

For HP Real User Monitor to work, it must be connected to a MySQL 
database that has been created and started.

This chapter includes:

 ➤  Overview of the MySQL Database on page 205

 ➤  Creating and Connecting to the MySQL Database on page 206

 ➤  Starting and Stopping the MySQL Database on page 207

 ➤  Maintaining the MySQL Database on page 208

Overview of the MySQL Database

The MySQL database is the HP Real User Monitor’s data repository. The data 
that is stored in the MySQL database is data that is either not forwarded at 
all to HP Business Availability Center, or that is only sent on request.

Data that is not forwarded at all to HP Business Availability Center is 
HP Real User Monitor configuration data. Data that is sent to HP Business 
Availability Center on request is open session data and session click-stream 
data (data and snapshots of pages included in sessions). Click-stream data 
accounts for the majority of the data stored in the MySQL database.

The MySQL database can be installed on the same machine as the HP Real 
User Monitor engine or on its own machine. For system requirements for 
the MySQL database, see “Reviewing System Requirements” on page 29.
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Creating and Connecting to the MySQL Database

The HP Real User Monitor engine MySQL database is created during the 
HP Real User Monitor engine installation process, if that option is selected. 
When the MySQL database is created during the installation process, the 
HP Real User Monitor engine is connected to it, and the MySQL database is 
started automatically. The MySQL database to which the HP Real User 
Monitor engine is connected must be started for the HP Real User Monitor 
engine to work.

You can create a new MySQL database schema and connect the HP Real User 
Monitor engine to it, or connect the HP Real User Monitor engine to a 
different, existing MySQL database completely, if required.

Note: The HP Real User Monitor engine can only be connected to one 
MySQL database.

To create schemas and connect to MySQL databases on an HP Real User 
Monitor Windows installation:

On the machine on which the HP Real User Monitor engine is installed, 
select Start > Programs > HP Real User Monitor > Administration > RUM 
Configuration Tool. The HP Real User Monitor Configuration tool starts. For 
details on working with the HP Real User Monitor Configuration tool, see 
step 15 on page 45 in “Installing the HP Real User Monitor Engine” on 
page 40.
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Starting and Stopping the MySQL Database

When the MySQL database is created during HP Real User Monitor 
installation, it is started automatically as part of the process. You can start 
and stop the MySQL database manually if required.

To start the MySQL database on an HP Real User Monitor Windows 
installation:

On the machine on which the HP Real User Monitor engine is installed, 
select Start > Programs > HP Real User Monitor > Administration > Database 
> Start Real User Monitor Database.

To stop the MySQL database on an HP Real User Monitor Windows 
installation:

On the machine on which the HP Real User Monitor engine is installed, 
select Start > Programs > HP Real User Monitor > Administration > Database 
> Stop Real User Monitor Database.
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Maintaining the MySQL Database

For details on maintaining the MySQL database, including strategies and 
procedures for backing up and restoring the database, refer to the Database 
Administration chapter in the MySQL Reference Manual on the MySQL Web 
site (http://dev.mysql.com/doc/refman/5.0/en/database-administration.html).

Purging MySQL Binary Log Files
The MySQL binary log contains all statements that updated data in the 
MySQL database.

The purpose of the binary log is to help update the database to the most 
current status during a restore operation, as it contains all updates made 
since the last backup. For details on MySQL binary log files and restoring 
databases, refer to the Database Administration chapter in the MySQL 
Reference Manual on the MySQL Web site (http://dev.mysql.com/doc
/refman/5.0/en/database-administration.html).

HP Real User Monitor purges the MySQL binary log files on a daily basis, by 
deleting all the log files older than five days. You can change the default 
number of days for which to keep the MySQL binary log files.

To change the default number of days for which to keep MySQL binary log 
files:

 1 Access the JMX console by choosing JMX Console from the Configuration 
drop-down menu in the HP Real User Monitor Web console, or by using the 
following URL in you Web browser:

http://<HP Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you 
do not have these credentials, contact your system administrator).

 2 In the JMX Agent View, scroll down to the RUM.modules section and click 
service=MaintenanceDBConfigurationJMX.

 3 In the MySQLBinaryLogsDaysCount parameter, change the setting to the 
required number of days.

 4 Click the Apply Changes button.
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Purging MySQL Real User Monitor Data
The data stored in the MySQL database is raw data used by Real User 
Monitor reports to present session clickstreams and snapshots, and to 
enable queries for various report filters. The data is sent to HP Business 
Availability Center on request.

Raw data is kept in the MySQL database for a default period of 14 days, after 
which it is automatically purged from the database. The amount of time raw 
data is stored in the MySQL database can be changed to any number of days 
between 7 and 100.

To change the period of time that raw data is stored in the database:

 1 Edit the \<HP Real User Monitor root directory>\conf\
partitionmanager\pm_tables_config.xml file on the HP Real User Monitor 
engine machine. 

 2 Change the setting <archiveDuration units="DAYS" qty="14"/> from 14 to 
the required number of days.

 3 Save the file.

Note: By increasing the number of days for which session click-stream data 
is stored, you might significantly increase the size of the database, which 
might necessitate additional disk capacity.
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Hardening HP Real User Monitor

You can harden the HP Real User Monitor platform so that it can be part of a 
secure architecture, and can therefore meet the challenge of dealing with 
security threats to which it could potentially be exposed.

This chapter includes:

 ➤  Hardening the HP Real User Monitor Probe on page 211

 ➤  Securing Connections to the HP Real User Monitor Engine on page 218

Note: For details on securing connections between HP Real User Monitor 
and HP Business Availability Center, see the HP Business Availability Center 
Hardening Guide PDF.

Hardening the HP Real User Monitor Probe

You can harden the HP Real User Monitor probe by changing users and 
creating passwords for them, disabling non-SSH access, limiting the SSH 
version that can be used, and by securing the HTTP connection to the 
probe.

This section includes the following topics:

➤ “Changing the Probe’s User and Password” on page 212

➤ “Disabling Non-SSH Access to the Probe” on page 213
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➤ “Limiting the SSH Version” on page 213

➤ “Securing the HTTP Connection to the Probe” on page 214

Changing the Probe’s User and Password

Note: This section applies to the HP Real User Monitor Probe only when it is 
installed on a Linux system. 

When the HP Real User Monitor probe is installed, a user called beatbox is 
automatically created, which has access to the probe channels only. This 
user does not have a password and you should configure one for it.

By default, the Real User Monitor probe is run under the root user. It is 
recommended to run the probe process under the beatbox user, or another 
specially created user, rather than the root user.

To change the user that runs the probe process:

 1 Log on to the probe as the root user.

 2 Change the user running the probe process by executing the command:

bb_user.pl <USER>

where <USER> is the name of the user with which you want to run the 
probe process.

To configure a password for a user:

 1 Log on to the probe as the root user.

 2 Define a password for the user by executing the command:

passwd <USER>

where <USER> is the name of the user for which you are defining the 
password. For example, to configure a password for the beatbox user, 
execute the command:

passwd beatbox

 3 Follow the on-screen prompts.
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Disabling Non-SSH Access to the Probe

Note: This section applies to the HP Real User Monitor Probe only when it is 
installed on a Linux system. 

The Real User Monitor probe uses the SSH server through xinetd, for 
stability reasons. During the probe installation, the xinetd service is 
activated automatically. Since the xinetd service allows different methods of 
access to the probe, you should disable all protocols apart from SSH.

To disable all non-SSH protocols in the xinetd service:

 1 On the Real User Monitor probe machine, execute the command:

ls /etc/xinetd.d/

 2 Edit each file in the displayed list, except for the ssh file, and change or add 
the following line:

Disable = yes

 3 Restart the xinetd service with the following command: 

/etc/init.d/xinetd restart

Limiting the SSH Version

Note: This section applies to the HP Real User Monitor Probe only when it is 
installed on a Linux system. 

By default, the probe accepts both SSH 1 and SSH 2 connections. To increase 
security, it is recommended to configure the probe to accepts SSH 2 
connections only.
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To configure the probe to accept SSH 2 connections only:

On the Real User Monitor probe machine, edit the /etc/ssh/sshd_config file 
and change the line:

#Protocol 2,1 

to

Protocol 2

Securing the HTTP Connection to the Probe
You can secure the HTTP connection to the probe by using HTTPS 
connections.

In HP Real User Monitor version 7.0 and later, the Real User Monitor engine 
by default connects to the probe via an HTTPS connection, using default 
sever and client certificates. In some instances (for example, after upgrading 
an earlier version of HP Real User Monitor) it might be necessary to 
manually configure HP Real User Monitor to use HTTPS.

This section describes how to manually set an HTTPS connection to the 
probe, as well as how to replace the default, generic, server and client 
certificates that are included in the probe.

Note: On Windows installations of the probe, the /etc/beatbox directory is 
located in the HP Real User Monitor probe root directory.

To manually set an HTTPS connection to the probe:

 1 Log on to the probe machine and edit the /etc/beatbox/bbsecurity.conf file.

 2 Uncomment, edit or add the following line:

use_ssl      true
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 3 Restart the probe:

➤ For Linux installations use the command /etc/init.d/beatbox-capture 
restart

➤ For Windows installations select Start > Programs > HP Real User 
Monitor > Administration > Probe > Start RUMProbe.

 4 On the engine machine, edit the \<HP Real User Monitor root 
directory>\conf\probes\probe.<PROBE IP>.properties file, where <PROBE 
IP> is the IP address of the probe machine for which you are configuring 
basic authentication. If this file does not exist, create it.

 5 Uncomment, edit or add the following line: 

connection.http.ssl=true

 6 Force an update of the probe configuration by accessing the HP Real User 
Monitor Web console and selecting Tools > Monitoring Configuration 
Information > Sync All Configuration. For details on working with the 
HP Real User Monitor Web console, see “Using the HP Real User Monitor 
Web Console” on page 78.

To replace the default server certificate:

 1 Convert the new server certificate and private key to PEM (base64) format, 
unencrypted (that is, without a password) and copy them to the probe 
machine.

 2 Log on to the probe machine and edit the /etc/beatbox/bbsecurity.conf file.

 3 Uncomment, edit or add the following lines: 

ssl_key <PRIVATE_KEY_FILE>

ssl_cert <SERVER_CERTIFICATE>

Note: The certificate and private key can be included in the same file. In 
such cases, both lines should refer to that file.
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 4 Restart the probe:

➤ For Linux installations use the command /etc/init.d/beatbox-capture 
restart

➤ For Windows installations select Start > Programs > HP Real User 
Monitor > Administration > Probe > Start RUMProbe.

 5 Copy the server certificate (without the private key) to the engine machine.

 6 Import the certificate into a new or existing keystore with the command: 

\<HP Real User Monitor root directory>\JRE\bin\keytool -import -alias 
rum_probe_cert -keystore <KEYSTORE_FILE> -file <CERTIFICATE_FILE>

Note: The Real User Monitor engine should be configured to trust the 
imported certificate.

 7 Edit the \<HP Real User Monitor root 
directory>\conf\probes\probe.<PROBE IP>.properties file. If this file does 
not exist, create it.

 8 Uncomment, edit or add the following lines:

connection.http.ssl.truststore.file=<KEYSTORE_FILE>

connection.http.ssl.truststore.password=<KEYSTORE_PASSWORD>

 9 Force an update of the probe configuration by accessing the HP Real User 
Monitor Web console and selecting Tools > Monitoring Configuration 
Information > Sync All Configuration. For details on working with the 
HP Real User Monitor Web console, see “Using the HP Real User Monitor 
Web Console” on page 78.

To replace the default client certificate:

 1 On the engine machine, generate a new private key and certificate into a 
new, or existing keystore with the command:

\<HP Real User Monitor root directory>\JRE\bin\keytool -genkey -alias 
rum_probe_client_cert -keyalg RSA -keystore <KEYSTORE_FILE>

 2 Enter the details of the certificate and when prompted, approve them.
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Note: If you choose a different password for the private key than the 
keystore password you must also specify this password when configuring 
the engine to use the keystore (see no. 3).

 3 Edit the \<HP Real User Monitor root 
directory>\conf\probes\probe.<PROBE IP>.properties file. If this file does 
not exist, create it.

 4 Uncomment, edit or add the following lines:

connection.http.ssl.keystore.file=<KEYSTORE_FILE >

connection.http.ssl.keystore.password=<KEYSTORE PASSWORD>

If you chose a different password for the private key in step 2 on page 216, 
edit or add the following line:

connection.http.ssl.keystore.PrivateKeypassword=<KEY PASSWORD>

 5 Export the client certificate with the command:

\<HP Real User Monitor root directory>\JRE\bin\keytool -export -rfc -alias 
rum_probe_client_cert -keystore <KEYSTORE_FILE> -file 
<CERTIFICATE_FILE>

 6 Copy the certificate file to the probe machine

 7 Log on to the probe and edit the /etc/beatbox/bbsecurity.conf file

 8 Uncomment, edit or add the following line: 

ssl_ca_file <CLIENT_CERTITIFICATE_FILE>

 9 Restart the probe:

➤ For Linux installations use the command /etc/init.d/beatbox-capture 
restart

➤ For Windows installations select Start > Programs > HP Real User 
Monitor > Administration > Probe > Start RUMProbe.
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 10 Force an update of the probe configuration by accessing the HP Real User 
Monitor Web console and selecting Tools > Monitoring Configuration 
Information > Sync All Configuration. For details on working with the 
HP Real User Monitor Web console, see “Using the HP Real User Monitor 
Web Console” on page 78.

Securing Connections to the HP Real User Monitor Engine

You can access HP Real User Monitor engine by different HTTP access 
points, for the following purposes:

➤ RUM Web console

➤ RUM JMX console

➤ RUM Gateway/Proxy Server (for HP Business Availability Center and the 
replay applet)

You can secure access to the HP Real User Monitor engine by using 
authentication and HTTPS connections.

This section includes the following topics:

➤ “Using Authentication” on page 218

➤ “Using HTTPS” on page 219

Using Authentication
All HTTP access points on the HP Real User Monitor engine are protected via 
authentication mechanisms. The two main authentication mechanisms 
used are:

➤ User and password protection. Used for access to the HP Real User Monitor 
engine Web and JMX consoles.

➤ Basic authentication. Used for all other access points to the HP Real User 
Monitor engine.
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You can add users for access to the Web console and change passwords for 
users to access both the Web and JMX consoles. For details on adding, 
changing, and deleting users to access the Web console, and changing their 
passwords, see “Using the HP Real User Monitor Web Console” on page 78.

To change the password for a user to access the JMX console:

 1 On the engine machine, edit the \<HP Real User Monitor root 
directory>\EJBContainer\server\mercury\conf\rumusers.properties file.

 2 In the following line (which is usually the first line in the file), change the 
value of <admin password> to the new password:

admin=<admin password>

 3 Save the file and restart the engine.

 4 Force an update of the probe configuration by accessing the HP Real User 
Monitor Web console and selecting Tools > Monitoring Configuration 
Information > Sync All Configuration. For details on working with the 
HP Real User Monitor Web console, see “Using the HP Real User Monitor 
Web Console” on page 78.

Using HTTPS
When you configure the HP Real User Monitor engine to work with HTTPS, 
all connections to the engine are affected. This means that HP Business 
Availability Center must also be configured to communicate with the 
HP Real User Monitor engine using HTTPS. For details on hardening 
HP Business Availability Center, including creating, configuring, and 
trusting client and server certificates, see the HP Business Availability Center 
Hardening Guide PDF. 
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In HP Business Availability Center, when viewing session details in Real User 
Monitor reports, you can view snapshots of pages and replay a session. By 
default, the Session Replay applet retrieves data from the Real User Monitor 
engine via the HP Business Availability Center Gateway Server, but can be 
configured to retrieve data directly from the Real User Monitor engine (for 
details, see “Customize Real User Monitor Reports” in Using End User 
Management). If the Session Replay applet is configured to retrieve data 
directly from the Real User Monitor engine and the Real User Monitor 
engine is configured to require a client certificate, you must copy and 
import the necessary certificate on the client machine running the Session 
Replay applet.

To copy and import a client certificate on a machine running the Session 
Replay applet:

 1 Export the certificate from the keystore on the Real User Monitor engine 
with the command:

\<HP Real User Monitor root directory>\JRE\bin\keytool -export -rfc -alias 
rum_client_cert -keystore <KEYSTORE_FILE> -file <CERTIFICATE_FILE>

 2 For each client machine on which the Session Replay applet is run:

 a Copy the certificate exported in step 1 to the client machine.

 b Import the certificate to the default HP Business Availability Center 
truststore with the command:

<Latest JRE home>\bin\keytool -import -alias rum_client_cert -keystore > -
keystore <Latest JRE home>\JRE\lib\security\cacerts" -file 
<CERTIFICATE_FILE>

 c Restart the browser.

Note: HP recommends to configure the Session Replay applet to retrieve 
data from the Real User Monitor engine via the HP Business Availability 
Center Gateway Server, when the Real User Monitor engine is configured to 
require a client certificate.
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